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Navigating the Application User Guide

Navigating the Application

This application consists of two sections. On the left is the Main Menu and on the right are Tabs. The Main Menu
displays the available reports, folders, and buttons. Tabs can contain the New Report Wizard, report outputs, design
windows, or help pages.

o | 5 ozsnooars Getting Started ‘\—E 1
[T Search Report Names. R [ Runpastooard | (2 A C i Y = ] L
=
= Reports + Add Folder Dashboard Style
> & ExpressViews
Ve Dashboard v cameeri
@ Chained Report Test Al @) wth None
© Crosstab Example: 190 o
All dashboard ties wil resize o it the wicth
# Express\iew Usabily T. © o thedispiey sutomaticaly
© Filters and Formulas Pr. . " Height
> Config 101 Practice A 900
> & Formuis 101
uping 101 Practice 7 2 PR v Backgrounds and Borders

1h Productiama °
> & NorthwindDashboard \

Frodustiieme 2 Canvas Color Tile Color Tile Header
> & NorthwindDashboard Fo. 1l ProductName 3
2 o
> & Northwind
2 2
Uniform Borger
ansices win
0 “ .
Cotcgorame 1 GategonNieme2 | Categonames | Cateconome & al hiomen re— re— Gomamesal

Radius
3

Item 1 Item 9

) / -
E 80%
2 60%

LastName 2

Dashboard Description

.

o -
- 2

Country3
Country 1
Country 4

Lasthame 3 al

Main Menu
Through the Main Menu, you can:

e Create new reports

e Search for reports

e Read report descriptions

e Run Reports

e Export reports to other types (Excel, PDF, RTF, and CSV)
e Duplicate reports to save time setting up similar reports
e Edit reports

e Schedule reports to be emailed or archived

e Manage folders and report storage

Click the splitter icon to hide the Main Menu. This is located in the top left corner of the application's interface between
the Main Menu and the Tabs.

af | B Dashboard f Getting Started
k Search Report Closethistab || it RNEAR il

== | Reports + Add Folder

The Main Menu can be broken down into two components: the Report Tree and the Report Descriptions Window.
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wf | # Getting Started

H Search Report Names...
Reports + Add Folder
> = Sales

I

C )

Report Tree

The Report Tree contains the individual user's view of their applicable Folders/Sub-Folders and the Reports contained
within them. Folders that are marked as "Read Only"(#) cannot be modified in any way (as designated by

the administrator), with the Reports and Sub-Folders within inheriting the same permissions (unless otherwise
specified).

A user can view a list of a folder's contents by double-clicking the folder name or by left-clicking the dropdown arrow
next to the folder name. Right-clicking the folder name will bring bring up an options menu.

Note: Right-Click options are location- and item-specific.

Right-Clicking on Folders

If a user right-clicks on a non-"Read Only"(#) folder within the Report Tree, a menu with the following options appears:

ofs | # Getting Started

E Search Report Names...

Reports + Add Folder

> = Sales

Add Root Folder

N

[

Add Child Folder

Mew... >

+

=] Rename

X Delete

Expand All

Collapse All

¢ ™% Add Root Folder: Allows the user to create a new folder in which to place the existing folder.

[
o ™ Add Child Folder: Allows the user to create a new folder within the existing folder.
. + New...: Allows a user to add a new report to the folder and specify the report type.
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w Add Root Folder
& Add Child Folder
+ New.. @ * | # Expressview
=] Rename Ph Brpress Reper
v Delete © Advanced Report
5= CrossTab Report
E d All
Xpan B: Dashboard
Collapse All

@ Chained Report

o "l Rename: Allows the user to rename the folder.

. X Delete: Allows the user to delete the folder.

User Guide

NOTE. A folder and all of its sub-folders must be empty in order to delete the folder.

e Expand All: Expand the contents of the relevant folder, including all of its sub-folders
e Collapse All: Collapses the contents of the relevant folder, including all of its sub-folders.

Right-Clicking on Reports

If a user right-clicks on a report, a prompt with the following options appears:

Reports + Add Folder
» = Sales
v im lest

@ Chained Report Test

o Crosstab Example

¥ ExpressView Usability T...
O Filters and For...

> = Config 101 Prd # Edit
» = Formulas 101
= » Run Report
> = Grouping 107 Pr;
» = NorthwindDashb
» = NorthwindDashb

> = NorthwindDAshb

|+ ExportAs »

=] Rename
@ Duplicate

¥ Delete

o 7 Edit: Opens the Report Designer screen for the selected report.
e Run Report: Executes the report and displays it in HTML format.
e Export As: Allows the user to execute a report in any of the following formats:

., Xxs

h_ PDF

o P

== RTE
o =

X: csv
o

Note: If one of these export types is unavailable, it may have been disabled by your administrator.

. L Schedule Report: Allows the user to schedule a report to run immediately, at a later time, or at regular
intervals. For more information on scheduling reports, please see Scheduling a Report.

o Email Report: This allows a user to Email a report immediately to a specified email address. Clicking the an
Export As option allows the user to specify the export format type.
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# Edit

» Run Report

|+ Export As 2
™ Schedule Report

Email Repori >

=] Rename

& Duplicate

»

Delete

more information, please see Scheduling a Report.

Note: If neither 'Schedule Report' or 'Email Report' show up as options, Report Scheduling may not be enabled. For

o "IRename: Allows the user to rename the report.

Note: If a user renames a Report that is used within a Dashboard, Chained Report, or a Scheduled Report, an error
message will appear when attempting to Execute or otherwise modify the aforementioned Report types

o @ Duplicate: This allows a user to duplicate a report and place it in a specified folder
o X Delete: This allows a user to Delete a selected report.

Report Descriptions Window

User Guide

This window displays the description of the selected report. If the report was never given a description, this window
remains blank when the report is selected in the Report Tree. For more info on Report Descriptions, please see Report

Types.

Tabs

v im lest
@ Chained Report Test
0 Crosstab Example
¥ ExpressView Usability T...
[0 Fites andor || =
> = Config 107 Practice
» = Formulas 107
> = Grouping 107 Practice
» = MorthwindDashboard
» = MorthwindDashboard Fo...

> = NorthwindDAshboard_fil...

An Advance Report detailing
how to use filters and
formulas.

Tabs make up the application's main interface. This is where users build, design, and view reports as well as access
dashboards and help pages. Tabs can be closed by clicking the () to the right of the tab name.
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Help for Designer Filters and Formulas Pra... 4 Getting Started

N[

Welcome to Exago

You can add static, interactive or embedded content to this
tab. Many Exago clients use this area to display custom
dashboards, Training and Help content and News and
Announcements.

Please refer to the Exago Technical Guide for additional
information.

See Examples

Tabs can be rearranged by clicking and dragging them left or right.

Help for Designer Filters and For ¢ Gatting

— bk

Right-clicking on a tab displays additional Tab options, such as closing the tab or closing all other tabs.

Help for Designer Filters and Formulas Pra.. # Getting Started

Close tab

Close all other tabs

Toolbar

Once a report has been created and opened in the report designer, the user may interact with it using the Toolbar.

s OB 8O

| = E- o @ Export PDF | ¥

A 3, anba v

wry B J U- A %8

#V

The Toolbar enables users to:

e Rename the report.

e Add, modify, or remove sorts and filters.

e Format cells’ font, font size, alignment, color, and borders.
e Use the Formula Editor to create complex functions.

e Insert charts, gauges, and images.

e Link reports, allowing users to drilldown for more detail.

e Save the report.

e Run the report in the Report Viewer.

e Export the report to Excel, CVS, RTF, or PDF.

e Add or remove Data Categories from the report.

e Add an Action Event. (If you do not see this option, your administrator may have disabled it.)
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User Preferences

In the User Preferences () window, the Startup Reports tab allows the user to manage which reports run upon
opening the application. The User Reports tab allows users to manage reports with user adjustments saved on top of

them. User Preferences are stored through cookies, server events, or an external interface per the Administrator's
settings.

User Preferences

Tutorials Startup Reports User Reports
Enable or disable report designer tutorials.
ExpressView Tutorial
ExpressView Hints

Reset All Hints

Help

Clicking on the custom help tool (9) walks the user through specific portions of the application. This context-sensitive
help menu is indexed and completely searchable, granting the user easy access to all information.

@ Help for Designer Getting Started

Contents Index Search CRE

(Home )
> ExpressView
Report Viewer Home
» Report Wizard
» Report Designer
Dashboard Viewer

Welcome to the Contextual Help System!

» Dashboard Designer This application is a full-featured business intelligence solution that runs in your browser. Technical and non-technical users can build interactive tabular reports, visualizations, and dashboards using intuitive, specialized designers.
Chained Reports .
Scheduler Getting started
Parameters

Troubleshosting If you are new here, welcome! You can get started immediately by clicking the Create New Report T icon and selecting 7 Expressview.

If you are a veteran reporter looking to take advantage of our advanced features, click the Create New Report T icon and select © Advanced Report.
Once you have made one or more reports, you can organize them orito a workspace by clicking the Create New Report P icon and selecting 82 Dashboard.
o= Dpiscover
B 7 BV
Build
@© O AdvancedReport

Assemble

K Dashboard
New Report menu
Managing reports

To see the reports that you and others have made, dick the Browse Reports i icon. To locate a specific report, type the name of the report into the Search field.

B Q Scorch Report Names
= reports + Add Folder
v Clent

8 Marketing Dashboard
> Examples
& My Reports

© Daily Numbers

Browse existing reports

Select a report and dick the Run [ icon to Run it. If there is no Run icon click the Menu Bl icon and select » Run Report.

To learn more about getting started, continue with Report Types.
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Report Types

There are six different report types available in the reporting application. Four are standalone types, and two are
composite types which combine reports together. By default, ExpressViews, Advanced Reports, and Dashboards are
enabled in the end-user interface.

ExpressViews

ExpressViews are simple reports which comprise vertically expanding data records and groups, and an optional
visualization.

Shepard
O OrderiD O UnitPrice
1076842 196.75
1093812 2167.55
1126831 49.30
1128492 21.05
1369138 1967.85
Count: 5 Sum: 4402.50
Vakarian
O OrderlD
1098213

1203918

Built with an intuitive drag-and-drop interface, ExpressViews are intended to be a way to get started quickly and begin
viewing data with as little friction as possible. There are no separate designer and viewer; instead, when executed,
data populates the report inline. ExpressViews can be converted to Advanced Reports in order to gain the additional
capabilities of that format.

ExpressViews can be scheduled, added to Chained Reports and Dashboards, embedded into web pages, and exported to
multiple formats.

Visit the ExpressViews documentation.

Advanced Reports

Advanced Reports are the flagship report type of the application.

Jon Snow, Sales Representative

01/2016 - 08/2016

Month Orders Revenue
January 3 §7,331.60
February 2 $2,504.60

March 5 $5493.90

April 1 $240.00

May 6 $9,168.20

June 4 $6,112.60

July 7 $14,197.80
August 3 $5,119.10
Employee Total: 239 $480,742.60
15k O
O
75k Q o 5 \
O

0
Jan Feb Mar Apr May Jun Jul Aug

The most powerful reporting tools are available with Advanced Reports, including geographic maps, crosstabs, repeating
groups, complex join, filter, and sort logic, linked child reports, and more. Advanced Reports are made using an Excel-
like grid-based interface. The Advanced Report Designer allows users to build reports without requiring knowledge of
SQL or the underlying data model. Advanced Reports can be executed to a browser-based Report Viewer interface,
which allows for interactivity, additional changes to be made without re-running the report, and for saving user-specific
customizations.

Advanced Reports can be scheduled, added to Chained Reports and Dashboards, embedded into web pages, used to
populate document templates, and exported to multiple formats.

Visit the Advanced Reports documentation.
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Crosstab Reports

Crosstab Reports are a special type of Advanced Report.

Category Product | Year 2015

Drinks

Produce Lembas Bread

Also known as pivot tables, Crosstab Reports display and summarize data in a way that expands dynamically both

vertically and horizontally.

Visit the Crosstab Reports documentation.

Express Reports

Glengoolie
Soma

Butterbeer

Ivalice Eggs

Produce Total

49
$705.60
103
$1,483.20
105
$1,260.00

Drinks Total $3,44sz, ;g

Varren Skewers

151
$302.00
169
$2,906.80
320
$3,208.80
557
$6,657.60

Express Reports are a simpler version of Advanced Reports.

OrderDate OrderlD Quantity UnitPrice Revenue

03/10/76
03/10/16
03/11/16
03/12/16
03/12/16
03/12/16
03/13/16
03/14/16
03/14/16

Express Reports are built using a "Wizard" interface instead of a grid. This is meant to streamline the report design
process. Most of the features of Express Reports are available in ExpressViews, which have a more modern interface.

Visit the Express Reports documentation.

Dashboards

Dashboards combine one or more reports onto a design canvas, providing a way to create a personalized arrangement

and display of related reports.

9278
9279
9284
9285
9288
9289
9291
9293
9294

764

Total Korok Seeds

3,821

Shrines Cleared

1M

&M

oM

All standalone report types can be added to a dashboard, and visualizations can be created directly on the canvas
without needing to make a separate report. Dashboards can also have text, borders, images, visual filters, and

embedded web pages.

Dashboards run in the browser, can have interactivity such as dynamic filtering and drilldowns, and can refresh on a

timed interval.

Visit the Dashboards documentation.

12
10
5
9
40
10
35
16
6

Region Sales

2016

255
$4,590.00
146
$2,628.00
179
$2,685.00
580
$9,903.00
61
$1,952.00

$3,117.00

$5,437.00

933
$15,340.00

$14.00

$9.80
$34.80
$18.60
$42.40

$7.70
$32.70
$18.60
$26.10

1510
$21,997.60

$168.00
$98.30
$174.90
$167.40
$980.20
$77.0
$470.60
$860.60
$133.70

Hyrule Q4 Revenue

2017 Gross Sales

User Guide
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Chained Reports

Chained Reports combine multiple reports into a single multi-page document.

= I OV

This can simplify running and distributing a group of related reports at once. They also support collating reports along a
common sort field, to create a super-grouping of common report data.

Chained Reports can be scheduled and exported to multiple formats.

Visit the Chained Reports documentation.

Building Your First Report

This article will walk users through the New Report wizard and demonstrate how to create a new report.

e Click the Create a New Report + button.
e There are several types of reports, the most common being an Advanced Report.

Note: This article will focus on building an Advanced Report. For information on the other types of reports, see
Report Types.

The New Report wizard will come up. The New Report wizard has five sub tabs. The Name and Categories tabs must be
completed while the other tabs are optional.

Name Tab
In the Name tab, enter a report name and click on the folder where the report will be saved.
The report name can be up to 255 characters long. The following special characters may not be used: ? : /\ * " <>

The report’s description appears at the bottom of the Main Menu when it is selected. The description text may also be
used to search for a report.

Note: You cannot create a report inside a folder that is read-only ( ).

Complete the steps in the wizard below to create a new report

Mame Categories Sorts Filters Layout
Enter the report name
New Report

Select folder for the report
» & Sales Reports

> & Customer Reports
> ETL

> @ Report Examples

Enter a description for the report

An example report.

Categories Tab
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In the Categories Tab, select the Data Categories that you would like to have access to on the report. It is important
to understand two terms: Data Category and Data Field.

Data Category — A Data Category is a data object that has several attributes. For example, Students is a category;
each student has an ID, a major, an advisor, etc.

Data Field — A Data Field is a single attribute within a category. For example, Students.ID is the numeric value that
identifies a specific student.

Complete the steps in the wizard below to create a new report

Mame Sorts Filters Layout
Select categories to include on report
Suppress
Search... Duplicates Category Name
Categories xX
Categories Products *

CustomerCustomerDemo

> ETL

Previous Next Cancel

e To add a Data Category, either drag and drop it to the Category Name column, use the + Add button, or
double-click the category.

Note: When one Data Category is added, other Data Categories that are not joined to it become unavailable by
default.

e To search for a specific Data Category or folder, type its name into the Search box.

e To see what Data Fields are in a Data Category, click on a Data Category and then click the information i ]
button.

e Check the Suppress Duplicates box to suppress any repeated records from that category.
e To remove a Data Category, click the delete * button.

For this report, we've selected Categories and Products.

Note: For each category selected, a user can Suppress Duplicates within the data by ticking the check box that
appears next to the category name. This will suppress repeated items in the given category for the final report.

Sorts Tab

In the Sorts tab, specify which Data Fields will be used to determine the order of data on the report.
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Complete the steps in the wizard below to create a new report

Mame Categories Sorts Filters Layout

Select sort fields

Sort By Sort Order
Categories & Categories.CategoryName fx Ascending w A W ¥
CategorylD
m—
Description
Picture
o= Add == Add Formula

Previous Next Cancel

e To sort by a Data Field either drag and drop it to the ‘Sort By’ Column, use the + Add button, or double-click
the field.

e You can sort each Data Field in Ascending (A-Z, 0-9) or Descending (Z-A, 9-0) order.

e Use the up (“*) and down (™) arrows to indicate the sort priority.

e To remove a sort, click the delete button (*).

For this report we have Sorted on Categories.CategoryName in descending order.

Note: Sorts are not mandatory in order to create a report. Sorts allow for more complex organization of a report but
do not bar the report wizard from continuing if left blank.

Filters Tab

In the Filters tab, create statements that will be used to filter the data when you run a report.

Complete the steps in the wizard below to create a new report

Mame Categories Sorts Filters Layout

Select filer fields to include on report

Filter By Title
Categories % Categories.CategoryName f_r v XK
CategorylD
Description
Picture
Egual To ¥ | & Grains/Cereals L
AMD With Mext Filter v
) Group With Mext Filter
o Add o Add Formula | Prompt For Value
SUMMARY

Categories CategoryName = ‘Graing/Cereals’

Previous Next Cancel
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There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimal places) or
alphanumeric.

e To filter a Data Field, either drag and drop it to the ‘Filter By’ column, use the button or double-click it.
e Use the up (“*) and down (™) arrows to indicate the filter priority.
e To remove a filter, click the delete button ().
e Set the operator (equal to, less than, one of, etc.) by selecting it from the operator drop-down.
e Set the filter value by either entering it manually or selecting a value from the drop-down. If the Data Field is a
date, the calendar and function buttons can be used to select a value.
e Select 'AND With Next Filter’ to require that the selected filter and the one below it both evaluate to true.
Choose ‘OR With Next Filter’ to require that either be true.
e Check ‘Group With Next Filter’ to of the filters. Filters can be nested indefinitely by using the following keyboard
shortcuts while a filter is selected:
o Ctrl + [ adds an open-parenthesis before the selected filter.
o Ctrl + ] adds a close-parenthesis after the selected filter.
o Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
o Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.
e Check ‘Prompt for Value’ to allow the filter to be modified at the time the report is executed.

For this report, an Equal To filter on Category Name has been created in order to limit the data on the final report.

Note: Like Sorts, Filters add complexity to a report but, but their completion is not mandatory.

Important: If a filter is chosen, the above fields must be completed or the report will not execute.

The Layout Tab

In the Layout tab, select the Data Fields that will appear on the report. For each Data Field chosen, the report will
automatically create a column header and place the Data Field in the detail section. Additionally, subtotals, grand
totals, and a page header/footer can be created.

Complete the steps in the wizard below to create a new report

Mame Categories Sorts Filters Layout

Select fields 1o include on report

Data Field Summary Function
Categories M % Categeries.CategoryName fx Mone Y oAV X
CategorylD % Products.ProductName fx Mone v oAV X
Cat N % Products.UnitPrice fx MNone Y ANV X
3 e
alegoryName % Products.UnitsinStock fx Mone v ANV Y
Description
Picture Summarize By
Categories
o Add # Page Header Page Footer Grand Tota
New Report
CategoryName ProductMame UnitPrice UnitsinStock
CategoryName 1 ProductMame 1 UnitPrice 1 UnitsInStock 1
CategoryName 1 ProductMame 2 UnitPrica 2 UnitsinStock 2
CategoryName 2 ProductName 3 UnitPrice 3 UnitsinStock 3
CategoryMName 2 ProductName 4 UnitPrice 4 UnifsinStock 4

Previous Cancel

Display Data

e To place a Data Field on the report, either drag and drop it to the ‘Data Field’ column, use the Add + button, or
double-click the field.

e Use the up (“*) and down (™) arrows to indicate the order the Data Fields should appear on the report. The
Data Field at the top will appear on the report as the left-most column.

e The Summary Function column is used to make subtotals and grand totals. See Subtotals and Grand Totals for
more information.

e To remove a Data Field, click the delete button ().

Using the ‘Summarize By’ box, you can display subtotals, grand totals, or headers for the values of a Data Field.
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Subtotals and Grand Totals

e To display subtotals, check the box of the category you want subtotals for in the Summarize By box. Then, for
each Data Field you want totaled, select a Summary Function (see below).

e To display grand totals, check the Grand Total box. Then for each Data Field you want totaled, select a Summary
Function (see below).

Summarize By
¥ Categories
Summarize by each unigue:
Categories v
Space

¥ prdd space before each unigue item

Header

#| Include Header at the beginning
Header Text:

Categories.CategorylD v fx

Total

¥ Include Total at the end

Summary Functions:

e Sum: Totals the all of the data in the Data Field.

e Count: Returns the number of rows in the Data Field.

e Average: Takes the mean of the data in the Data Field.
e Minimum: Displays the lowest value in the Data Field.
e Maximum: Displays the highest value in the Data Field.

Data Headers

A checkbox will appear in the Summarize By box for each Data Category in the Sorts tab. To display a header for each
value of a Data Field, click on the associated Data Category in the Summarize By box. Click the Data Category name
next to the checkbox, and the will appear.

e To include a Header, check the box ‘Include Header at the beginning’. In order to select the text that will appear
as the header value, use the Header dropdown to select a Data Field or use the Formula Editor Button (f“) to
create a formula.

e Use the ‘Summarize by each unique’ dropdown to specify if the header should repeat based on a specific field or
fields within a Category.

e Check the box ‘Include Total at the end’ to have a subtotal created for this Category.

For this report, the Data Fields Products.ProductName, Products.ProductID, Products.UnitPrice,
and Products.QuantityPerUnit have been selected.

e To see the report in the Report Designer, click Finish.
e The Report Designer will display the report like this.

5. A @/ me - fun eport
- .
v x| B J U- A & 8 Export PDF | ¥
Section A (CategoryName) B (ProductMame) C (UnitPrice) D (UnitsinStock)
1 New Report
Page Header 2
3 CategoryName ProductName UnitPrice UnitglnStock
Detail 4 'Categories Categor 'Prmum'PrUdUﬂNa'Pruducts.Un'rtPrit:e 'E’}Euducts.Un'rtslnSIo

yHName me

Note: For information on the Toolbar and all its features, see Maneuvering the Toolbar.

e Executing the report to one of the 5 export types is as simple as selecting it from the drop down located in the
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top right of the designer, or executing it from the main menu.

To add the next layer of intricacy to your articles you'll want to create grouping within the present data. To read more,

continue to this article.

Grouping Basics

Understanding Groups

Groups break up a data set into sections of related information, allowing for aggregation and/or the removal of repeated
values from the tabular detail. We see grouping in lots of settings, but restaurant menus provide a useful example. We

never see menus like this:

Type
Entrée
Appetizer
Entrée
Appetizer
Dessert
Appetizer
Entrée
Appetizer
Dessert
Entrée
Appetizer
Entrée
Entrée
Dessert
Entrée

Or like this:

Type
Appetizer
Appetizer
Appetizer
Appetizer
Appetizer
Dessert
Dessert
Dessert
Entrée
Entrée
Entrée
Entrée
Entrée
Entrée
Entrée

In the above example, the menu is stored by dish type, but there are repeated values in the "Type" column, which
makes the menu difficult to read at a glance. For this reason, menus typically group on dish type:

Dish

Duck Confit
Cheese Board
Monkfish

Garden Salad
Creme Brulee
Potato Croquettes
Rack of Lamb
French Onion Sou)
Chocolate Mousse
Chickpea Tagine
Escargot

Quiche Lorraine
Cheese Souffle
Ice Cream

Crab Cakes

Dish

Cheese Board
Garden Salad
Potato Croquettes
French Onion Sou)
Escargot

Creme Brulee
Chocolate Mousse
Ice Cream

Duck Confit
Monkfish

Rack of Lamb
Chickpea Tagine
Quiche Lorraine
Cheese Souffle
Crab Cakes

$30.00
$12.00
$25.00
B7.00
58.00
58.00
527.00
57.00
58.00
$16.00
$15.00
17.00
$20.00
56.00
$25.00

$12.00
57.00
58.00
57.00
$15.00
58.00
58.00
56.00
$30.00
$25.00
527.00
$16.00
$17.00
$20.00
$25.00

User Guide
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Grouping works a bit differently in the application, but its function is the same. In either case, the first step in creating

Appetizers
Garden Salad
French Onion Soup
Potato Croquettes
Cheese Board
Escargot

Entrées
Chickpea Tagine
Quiche Lorraine
Cheese Souffle
Monkfish

Crab Cakes
Rack of Lamb
Duck Confit

Desserts

lce Cream

Creme Brulee
Chocolate Mousse

a group is sorting on the appropriate data field.

Creating Sorts

Users may either build sorts from the report Wizard or from the report Designer.

$7.00
57.00
$8.00
512.00
$15.00

516.00
$17.00
£20.00
$25.00
£25.00
527.00
£30.00

$6.00
$8.00
$6.00

The Sorts Tab is the third tab in the report Wizard. To create a sort, drag and drop a data field into the sorts pane.
Select "Ascending" or "Descending" from the Sort Order drop-down menu. Add as many sorts as you like, and change
sort priority by using the up (*) and down () arrows.

New Standard Report

Complete the steps in the wizard below to create a new report

Name Categories

Select sort figlds

Categories

CategorylD

Description

= Add

X Cancel

Once in the report Designer, users may adjust their Sorts from the settings menu (‘n’“).

Filters Layout

% Categories. CategoryName

< Previous

Sort By

Next >

Sort Order

Ascending v A W X
Descending

F# Finish

User Guide
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T Rename

L I D

= Description A (ProductMame) B (ProductlD) C (UnitPrice) {QuantityPerlnit)
= Categories Test

A [

2l Sors ProductiD | _ UnitPrice | QuantityPerUnit

Ld r .

¥ Filters ?;r:d”“spmd”“”a Products ProductiD Products. UnitPrice 'Errfﬁ';tmﬂ”a”wp

» Options ¥

B Template

ooe  Advanced *

The Designer Sorts menu functions much the same as the Wizard Sorts menu does.

Report Sorts

Select sort fields
Sort By
Categorles o Categories.CategoryMame

CategorylD
CategoryMame
Description
Picture

= Add

oK X Cancel

Once you've sorted on a field, you're ready to group on that field.

Sort Order

Descending » A s X
Ascending E
Descending

User Guide

NOTE. Nested groups should reflect the sort order. The outermost group header should be the highest priority sort,
and the footer order should be reversed. Find more information on this Understanding Header/Footer Grouping.

Sorting By Formula

To sort and group by information that may not be contained within an individual data field, you can use Formulas. See

Formulas for additional help.

Pressing the = Add Formula button or the Formula Editor ( fx ) button opens the Formula Editor window:

f

e Add a Data Field by dragging and dropping it into the 'Formula' box or double-clicking it. Or enter it manually using

the following format: {DataCategory.DataField}.

e Add a Parameter by entering it manually using the following format: @ParameterName@.

e Add a function by dragging and dropping it into the 'Formula' box or double-clicking it. Or enter it manually.
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For example, say I had a data field containing a full date and time, and I wanted to analyze my sales by each month of
the year over a multi-year period.

I could use the formula Month({Orders.OrderDate}) to return only the Month component of each date. Then I could
sort my sales by Month.

Adding Group Sections

In order to add the group sections, click anywhere in the sections tab in the report designer. From here, select Add
Section and then add Group Header.

-ﬁ = [+ & #  Anal v
Y e~ B I UAW®[ =

IO E = B A ) +
EEE O DG)

=

Section A (ProductMame) B (ProductlD) C (UnitPrice)

Test

D
(QuantityPerUnit)

Page Header

1

2

B Procucthame | ProductiD | UnitPrice | QuantityPerunit
r

4

L4 "
Detail "Products.ProductNa’p oy ctc productip Products Unitrice | 1oducts-QuanityP
me erlnit
== Add Section ' A
X Delete Section D Report Header
. Report Footer
b

Page Footer

W

Section Shading Group Header I

Group Footer

mOlolo 0 @

Repeating Group
In the Group Header Menu, use the drop down to select the proper sort field. For this report, Categories.Category
Name has been selected.

Group Header X

Show this group for each change of the following:

Data Categories i
Categories atd
Sort Fields

Categuﬁes.Gateganame 3

roup Headers are used as leading or title areas for more detaifed
information that follows. For example, lets say the data you're interested
in viewing are countries and cities. Since there are many cities for each
country, you may want to see each country only once, followed by all
cities for that country. In this case you would create a group header for
the country data, then a detail area below for the city data. A report can
have multiple group headers for varying levels of data.

o OK X Ccancel

NOTE. Groups can be sorted by formula instead of a Category or Field by adding a formula to the report Sorts, then
selecting it in the group dropdown menu.

After adding the Group Header, repeat the same steps above to create a group footer by selecting Group Footer from
the menu.

Group Header and Footer Content

Headers and Footers are designed to display content that will appear once per unique value in the group. Group

Headers appear above the group detail, and Group Footers appear below the group detail. Unlike Group Headers, Group
Footers may be used to perform aggregate functions on the group detail.

In this example, there is a group header on Categories.CategoryName, and there are three rows in that header. The
first row is to create space between groups. The second contains the Categories.CategoryName field, which will
repeat once for each unique Category Name in the Categories object. The third contains column titles for the details
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section. They will also appear once for each unique Category Name in the Categories object.

o E [+ 3 | e ~ EEZZI0E A Ko rj@
hd = f— =
v | B I U A& =+ E 1= E- B O
Section A (ProductName) B (ProductlD) C (UnitPrice) [QuantitﬂPerUnit:l
1
Page Header Te St
2
3
eader: 4
Categories.CategoryMame Categories.CategoryName — . ;
5 ProductName ProductlD UnitPrice CQuantityPerlnit
r r -
Detail 6 "Products ProductNa's o 1s proguctn Products.Unitprice  Froducts QuantiyP
Footer: 7 =Aggavg({Products.
Categories.CategoryName UnitPrice} )

In the footer section, we are taking the average of the products' unit prices in each category. This function, like the
values in the Group Header, will appear once for each Category Name in the Categories data object.

User Guide

NOTE. Because headers are not designed for content that will produce many different results for each group, it is best
to select content that will only change with each group. For example, if OrderDetails.Quantity is placed in a group
header, it will only display the first record for each group break. Additionally, placing this field in a group footer will
display only the last record in the group.

Upon execution, the report now shows breaks for each food category name and displays aggregate information for the
unit prices in each category.

Test

ProductMame ProductlD UnitPrice QuantityPerlnit
lkura 10 53 12 - 200 ml jars
Konbu 13 56 2 kg box
Carnarvon Tigers 18 563 16 kg pka.
Mord-Ost Matjeshering 30 226 10 - 200 g glasses
Inlagd Sil 16 519 24-250q jars
Gravad lax w 326 12 - 500 g pkos.
Eoston Crab Meat 40 518 24 -4 oz ting
Jack's New England Clam Chowder 41 510 12 - 12 oz cans
Rogede sild 45 510 1k pkyg.
Spegesild 46 512 4 - 450 g gl
Escargets de Bourgogne 58 513 24 pieces
Rid Kaviar 73 315 24 - 150 g jars

Average Unit Price: 521

ProductMame ProductlD UnitPrice GuantityPerlInit
Lenglife Tofu 74 210 5 kg pkg.
Manjimup Dried Apples 31 553 50 - 300 g pkags.
Rissle Saverkraut 28 546 25 - 825 g cans
Tofu 14 823 40 - 100 g pkos.
Uncle Bob's Crganic Dried Pears T 230 12 - 1 |b pkgs.

Average Unit Price: 332

Meat/Poult

s

ProductName ProductlD UnitPrice CGuantityPerlnit
Thiringer Rostbratwurst 29 5124 50 bags x 30 sausgs.
Mishi Kobe Miku 9 97 18 - 500 g pkgs.
Alice Mutton 17 539 20 - 1 kg tins
Perth Pasties 53 $33 48 pieces
Tourtiére 54 ST 16 pies
Pété chinois 55 24 boxes x 2 pies

524
Average Unit Price: 354

Grains/Cereals

ProductName ProductlD UnitPrice GuantityPerlnit

Gnocchi di nenna Alice 56 538 24 - 250 g pkgs.

Ravioli &ngelo 57 520 24 - 250 g pkgs.

File Mix 52 57 16 - 2 kg boxes

Singaporean Hokkien Fried Mee 42 314 32 - 1 kg pkgs.

Wimmers gute Semmelknddel G4 533 20 bags x 4 pieces

Gustafs Knackebrod 22 521 24 - 500 g pkgs.

Tunnbrid 23 59 12 - 250 g pkgs.

Average Unit Price: 520

Dairy Products

ProductMame ProductlD UnitPrice QuantityPerlnit
Gorgenzela Teline 31 513 12 - 100 g pkgs
Mascarpone Fabioli 32 5§32 24 - 200 g pkas.
Geitost 33 53 500 g
Queso Cabrales 1 521 1 kg pkg.
Cueso Manchego La Pastora 12 538 10 - 500 g pkgs.
Raclette Courdavault 59 855 5 kg pkg.
Camembert Pigrrot G0 534 15 - 300 g rounds
Gudbrandsdalsost &9 236 10 kg phg.
Flotemysost 71 522 10 - 500 g pkgs.
Mozzarella di Giovanni T2 835 24 - 200 g pkgs.

Average Unit Price: 529
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The next step in understanding the basics of report building is to gain an understanding of Formulas. See Formula Basics
next.

Reprinting Group Headers

Beginning in version 2018.2, you have the option to reprint Group Header rows at the top of the page if the detalil
section of any given group spans multiple pages. This option is only available on Group and Repeating Group Header
sections. To reprint a Group Header row when its detail section continues onto another page, click the row number in
the Report Designer and select Repeat Row. If the Header has been set to repeat, two blue lines will display next to the
row number.

Repeat group for each
Header " £ ==
Detail £ Insert Rows Before
Footer £

+ Insert Rows After

X Delete Rows

Set Auto Height

Row Height...

Suppress Rows
Collapse Rows
Repeat Row

Page Break

Formula Basics

Formulas allow users to create complex calculations, parse strings, and insert images within the application. Formulas
can be comprised of functions, parameters, strings, data fields, and cell references. All formulas begin with an equal

sign (=).

In the Report Designer, users can either key their desired formulas directly into a cell or enter them with the assistance
of the built-in Formula Editor.

NOTE. This application comes with a standard set of functions, but the number of available functions may differ based
on the environment as set by the Administrator.

Adding Mathematical Calculations

Totals for each data field are not automatically calculated in an Advanced Report, so we must add calculations to the

report in order to display totals. A great way to do this is through the use of footers, which are designed to aggregate
the data contained in the section above them. Group Footers allow the totaling or counting of data contained in the

group, and Report Footers allow the totaling of the full contents of a report.

In the example below, there is a group footer on Products.ProductName, and the Detail section of the report has
been suppressed. Suppressed rows do not display on the executed report. The end goal is to have this report display
one row for each confection product, each row containing the product name, total order quantity, unit price, and
revenue generated by each product, with a grand revenue total at the end.

Section A (ProductName) B (Quantity) C (UnitPrice)

1 Confections Orders
Page Header 7

B Productame | Guantity | UnitPrice

Detail 4

Footer:

Proeducts. ProductMa Crrder Crrder
Products.Prod... me Details. Quantity Dretails. UnitPrice

(53]

Looking more closely at the footer, we can expect the cells to display as follows:
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e Cell A5 will display the product name for each unique product in the group.

e Cell B5 will display just the last order quantity value for each product in the group because there is a one-to-
many relationship between products and order quantities.

e Cell C5 will display the unit price for each unique product in the group.

If our goal is to calculate the revenue generated by each confection product, the first step would be to calculate the
total quantity of orders for each product in cell B5.

Entering a Formula

To enter a formula into B5, we click on the cell and either enter =aggsum({Order Details.Quantity}) or select
AggSum and the data field from the Formula Editor. To access the Formula Editor, select the cell and press the formula
editor (ff) button in the toolbar.

Formula Editor b
Select Fields
. w Aggregate
Order Details v AdgAvg
Discount Agngu_nt
AggDistinctCount
OrderlD AggMax
ProductlD AggMin
m’_umme
RunningSum
» Operators
» Logical
» Date
» Financial
» Database and Data Type
» Arithmetic and Geometric
» String
» Formatting
» Other
+ Add Returns the sum of the values of the data field
&= Add
aggsum( {Order Details.Quantity})
Formula

 OK ¥ Cancel

Now we can add a column to the right-hand edge of the table and calculate the product revenue in D5.

Calculating with Cell References

Revenue is the product of all order quantities (B5) and unit price (C5). Instead of completely rewriting the aggsum
formula we just created in B5, we can use a cell reference to quickly and easily allow this inclusion.

Cell references are formulas, so they will have to start with an equal sign (=). To reference a cell, enclose the
coordinates in square brackets ([ ]). We'll enter =[B5]*[C5] in D5 to calculate the revenue for each product.

User Guide
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Section

Page Header

Detail

Footer:
Products.Prod...

A (ProductName) B (Quantity) C (UnitPrice) D

Confections Orders

| ProductName | Quantity | Unitrice | = Revenue

Products Preductia =aggsumi{Order

me  Details Quantity}) Details. UnitPrice

Calculating in the Report Footer

To calculate a grand total of the Revenue column, we will add a new group to the report, this time a Report Footer.
The Report Footer aggregates values contained in the whole report, as opposed to a particular group within it. Again,

we will use cell references for simplicity.

Section

Page Header

Detail

Footer:

Products.Prod...

Report Footer

Order =[B5]C5)

A [F‘rogﬁ‘cﬂlame:l B (Quantity) C (UnitPrice) D

Confections Orders

Products. PreductMa =aggsumi{Crder
me  Details.Quantity}) Details. UnitPrice

Upon execution, the above report displays the following:

Confections Orders

ProductName Quanti UnitPrice
Chocolade 3138 313
Gumbar
Gummibarchen 753 33
Mazilaku 5520 520
MuMuCa Mul-
Mougat-Creme 3318 314
Pavlova 51,158 37
Scheggi Schekelade 3365 244
Scottish Longbreads 5799 313
Sir Rodney's
Marmalade 3313 361
Sir Rodney's
Scones 51,016 g10
Tarte au sucre 51,083 345
Teatime Chocolate
Biscuits 5723 59
Valkeinen suklaa 3235 316
Zaanse keeken 3483 310

Order =[BSJICS)

=aggsum([D5])

Revenue

51,760
523,516
310,400

54,452
520,207
516,024

59,988
525,353
310,160
553,392

56,652

53,819

54,608
$190,320

User Guide

depressed.)

NOTE. Instead of using the Formula Editor, it is possible to aggregate using the AutoSum button (£ ) on
the toolbar. Just select the target cell, enter an equal sign followed by the value(s) you wish to aggregate, and click
the AutoSum button. (In the above example, the grand total formula would read =[D5] with the AutoSum button
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Concatenating Strings

Concatenation is the act of combining multiple fields or strings into a single string. For more on concatenation see the
full list of formulas and descriptions.

In this report, we can use concatenation to create a label for our revenue grand total and specify what food category

it pertains to.

Concatenation can be done by using an ampersand (&) between each string or by using the concatenate function in
the Formula Editor.

Select Fields

Categories

CategorylD

Formula Editor b

» Aggregate
» Operators
» Logical

W

CategoryName » Date

Description
Picture

= Add

» Financial
» Database and Data Type
» Arithmetic and Geometric
w String

Leit

Len

Lower

Mid

MewLine

Replace

Right

Trim

Upper

Value
» Formatting
» Other

+ Add Returns the concatenation of its string arguments

Concatenate( "Grand Total of ',{Categories.CategoryName}, 'Revenus:')

Formula

0K X Cancel

In the example below, the concatenate function has been entered into the cell manually. Note the ampersands.

Section

Page Header

Detail

Footer:
Products.Prod...

Report Footer

A (ProductName) B (Quantity) C (UnitPrice) D
Confections Orders

[ Producthame | Quantiy | UnitPrice | Revenue |

Products. ProductMa =aggsum{{Crder - I _
me Details. Quantity} ) _ Crder Details.UnitPrice =[BS]*[C5]
='Grand Total of &
{Categories.CategoryMame}& =([D5])
Revenue

strings.

Note: To add space between elements in your concatenation, insert spaces at the beginnings and/or ends of your

With a little added formatting, the executed report now looks like this. The "Confections" has replaced
Categories.CategoryName in our concatenation formula.
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Confections Orders

ProductName Quanti UnitPrice Revenue
Chocolade 5138 513 51,760
Gumbar
Gummibarchen 3753 531 523 516
Mazilaku 5520 520 510,400
MulNuCa Muf-
Nougat-Creme 5318 514 54,452
Paviova 51,158 517 520,207
Schoggi Schokolade 5365 544 516,024
Scottish Longbreads 5799 513 59 988
Sir Rodney's
Sy 5313 581 £25,353
Sir Rodney's
Scones 51,016 210 510,160
Tarte au sucre 51,083 549 553 392
Teatime Checolate
Biscuits 5723 59 56,652
Valkoinen suklaa 5235 516 53819
Zaanse keeken 485 10 34,608

Grand Total of Confections

Revenue: §190,329

Now that the report has become more intricate, it may help to have a better way to see the data presented. This can
best be done through visualizations. Click here for more information.

Adding Visualizations to a Report

About This Guide

This guide is designed to walk users through adding a visualization to the example report. For this example, we'll create
a chart visualization, keeping in mind that GeoCharts, Google Maps and gauges are other possible visualization types.

More info on GeoCharts, Google Maps, and gauges can be found in their respective articles.

Adding a Chart

To add a chart, first select a cell in in the Report Footer and press the Chart Button () in the toolbar above the
Design Grid.

Or, right-click a cell in the Report Footer, hover over 'Insert' in the drop-down menu, and select 'Chart' from the second
drop-down menu.

|NOTE. Charts rely on aggregating data and are therefore best placed in a group or report footer.

The Chart Wizard

Appearance Tab

The Chart Wizard opens on the Type tab, where users may select the type of chart they wish to create. The charts
are broken up into four groups: Line; Bar and Column; Pie and Other Single-Series; and Scatter and Bubble charts.

e Line: Line charts show trends in one or multiple data sets over time. These can be single- or multi-series.
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e Bar and Column: Bar and Column charts compare values, aggregate values, and percentages to each other. They
can be either single-series or multi-series.
e Pie and Other Single-Series: These display the parts of a whole in percentage point terms and only display one

series at a time.
e Scatter and Bubble: Scatter and Bubble charts show the relationship between distinct data points in one or more

series.

For this report, the desire is to show a chart that allows direct visual comparison of total revenue generated by each
product. This is best accomplished with a bar or column chart.

Data Tab

The Data Tab is where data is refined for the selected chart and where the interaction of the data is determined.
A data value and a data label for the chart must be set before proceeding.

For this chart, set the X-Axis Labels to Products.ProductName, and set the Series Values to the formula for product
revenue, =[B5]*[C5], using the dropdown menus. Under Other Options, we will set the data values to sort in
ascending order for quick comparison.

Type Data Appearance  Size and Preview

Setup the data to show in the chart

Data for Chart Other Options
X-Axis Labels Sort data by
Products Productt ame v Data Values ~ | Ascending ~
Series Values Exclude values less than  Exclude values greater than
=[BS][C5] - = =
+ Add Series Data Layout... Data Axis Minimum Value Maximum Value
s s
- -

|NOTE. Data Values must be numeric values.

Appearance Tab

In this tab, we can customize the chart's appearance by applying a theme, labels, number formatting, benchmark lines,
and other features.

Type Data Appearance  Size and Preview

Style the chart

Colors Other Features
Crayola ¥ Title alignment Centers
Use 3D Style : :

Font color w i + Add Attribute

Labels

Chart Title X-ods Title Y-fods Title Advanced Features

Confections Revenue Product Revenue (3)
Element Mame + Add Attribute

Point Labels

Series Values ~

Label Font

Calibri w

[ Mumber Format... | Benchmark Lines...
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|NOTE. The values set in the Appearance Tab are optional.

Size and Preview Tab

After the chart has been formatted, we can either press the Finish button to dismiss the chart wizard or move on to
the Size and Preview Tab. The preview displays dummy data formatted according to the user's specifications and gives

users the option to resize the chart.

Type Data Appearance  Size and Preview

Confections Revenue

Item 1

Item 2

Product

Item 3

| Irem 4

Revenue (5}

® Fitto Cell (O Set specific size  Height 208 Width |625

Reading The Chart

Click Finish and execute the report to HTML. Below is the visualization we've just constructed:

Confections Revenue

Ravenue (5]

Chooolade welkoinem MNuNuCa  Zsanse  Testime  Scomsh Sir kiavilzku  Schoggi
suklzz MufE- kosken Chocolste Longbrez  Rodnsy's schokolad
Mougat- Biscuits ds SCONES =l
Creme
Product

520,000

32 of 168



Scheduling Reports

After execution, it is clear that Tarte au Sucre has generated the most revenue and that Chocolade has generated the

least.

Interactive HTML

In the HTML viewer, users are able to make adjustments to the chart without having to re-execute the report. Right

clicking on the chart will bring up a series of menus.

Confections Revenue

BOLONM v e
LN v TR T TR LT T E T E T PPN
LT, T PP PP

=

-4

£

]

=
BRALDOMD e enr e Tvne

Theme
GAZ UMD o voere e -
Sort By

) Use 3D Style

chocoolade welkoinen MuNucCa  Zsamse  Testime  Scomish Sir miaxilzky  Schogsi Paviova  GumbEr Sir Tarte au
suklzz Nui- kosken Chocolate Longbrez Rodney's schokolad Gummibd Rodney's  sucre
Mougst- Biscuits ds Scones B rchen  Marmalad
Creme e
Product

These menus include:

Type - This allows users to change the chart type within the HTML viewer

e Theme- This allows users to change the theme of the chart within the HTML viewer
e Legend Location - This allows users to add, remove, or change the location of a chart legend.
e Sort By - This allows users to adjust chart sorts within the HTML viewer.

Now that the report is near complete, it is possible that users may need to schedule this report for use. For information

on this process, continue to Scheduling a Report.

Scheduling Reports

The scheduler allows you to run reports and dashboards regularly at specified times. This can be useful for reports and
dashboards which are based on periods of time, such as weekly sales reports or quarterly earnings reports.

Reports + Add Folder
» & Customer Reports

» & ETL

v i Management Reports

o tomess ————b]=)

0 Google Maps Hyperlink

ra
0 Products Ordered per Month
I Sales Dashboard
» & Report Examples =+
> = Sales Reports L]
u
r
x

Edit

Run Report

Export As >
Schedule Report

Email Report >

Rename
Duplicate

Delete
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Making a Schedule

Schedules are created and edited with the Schedule Report wizard, which is a tool designed to streamline schedule
creation.

Recurrence Filters

Schedule Name
Expenses - Daily

Export Type PDF ¥ Password (optional) =ssesees- Confirm Password |=sesee==s

Execute Immediately

Schedule Time

Schedule Time 12:00pm @ # Repeat Every...
2 hour(s) 0 minute(s), until 08:00 pm @

Recurrence Pattern

Once
& Daily

® Every 1 day(s)
Weekly

Monthly Every weekday

Yearly

Range of Recurrence

Start | 04/22/2019 No end date

® End by 06/18/2020

Next Cancel m

To schedule a report:

1. Click the Menu E icon and select ~ Schedule Report.

2.

3.

Enter a Name for the schedule.

Choose which file type to save the report as.

Optional: For PDF or Excel, enter a Password to secure the report.

Select a date and time for the schedule, and choose how often it should run:

1.

2.

In the Schedule Time field, enter a time for when the schedule should run.

Optional: To run the schedule as soon as it is created, select the Execute Immediately check box. This
schedule cannot be given a recurrence pattern. Go to step 6.

Optional: To run the schedule multiple times per day, select the Repeat Every check box and enter a time
for how often it should repeat.

. Optional: To run the schedule on more than one day, choose a Recurrence Pattern from the available

options:
Daily

The schedule will repeat every day, every weekday, or every number of days. Enter a number of days for
how often the schedule should repeat, or select Every weekday to run it every Mon, Tues, Wed, Thurs,
and Fri.

Weekly

The schedule will repeat every week, or every number of weeks, on one or more days. Enter a number of
weeks for how often the schedule should repeat, and select one or more days when it should run.

Monthly

User Guide
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The schedule will repeat every month, or every number of months, on a certain day. Enter a day for when
the schedule should run, and a number of months for how often it should repeat.

Yearly
The schedule will repeat every year on a certain day. Enter a day for when the schedule should run.

5. Optional: If you have entered a recurrence pattern, enter a date for when the schedule should Start.

6. Optional: To add filters to the report click the Filters tab. If the report already has filters you can set their

10.

values here. See Filters for instructions.

User Guide

Note: In versions prior to v2018.2, Chained Reports do not support scheduled filters.

Optional: To email this schedule to addresses from a database, see Emailing personalized reports.

Click the Recipients tab. To send the report to a list of email addresses, select the Email Reports check box
and fill out the following fields:

1. Enter the recipients' email addresses in the To, Cc, and Bcc fields.
2. Optional: Enter an email subject in the Subject field.
3. Optional: Enter an email message in the large text field.

If you do not want to email the report, clear the Email Reports check box. The report will be saved to disk
instead. You may have to ask your administrator for the file location.

Optional: If this is a batch schedule, an Attach Report Output to Email check box is available. Clear this check
box if you want to use this report to send alerts, and you do not want to email the report itself.

Click Finish to save the schedule.

Schedules can be edited after they are created. See Viewing schedules for more information.

Viewing Schedules

To see the schedules that have been created click the Schedule Manager o icon. Each schedule is on a row with its
most recent and forthcoming run times and a status indicating its condition.

arch schedules (C*Refresh [ Flush

Schedule Name Type Report Name Last Execute Date Mext Execute Date Status  Run Count
Sales per Category per Customer Once  Sales per Category per Customer 04/16/20719 107421 Completed 1 f“ xX
Google Maps Hyperlink Once  Google Maps Hyperlink 04/23/2019 00:00:00  Ready ] F x
Expenses - Daily Daily  Expenses 04/16/2019 11:00:00  Ready o Pl
Products Ordered per BMonth - Weekly  Weekly Products Ordered per Month 04/22/201901:00:00  Ready 0 F

Ready

The schedule will run on its next run time.

Running

The schedule is currently running.

Transmitting

The scheduled event has finished running, and the report is being sent to the user.

Completed

The schedule has completed its final event, and will not run again. It will be removed from the list when the cache is
flushed.

Deleted

The schedule has been deleted, and will be removed from the list when the cache is flushed.

Abended

The last run failed due to an error. The schedule will not run again.

User Aborted
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The schedule is running, but it was requested to be canceled. It will be marked as Deleted.

Scheduled events which have passed are copied to an archive row, so that there is a log of previous run times. Such
events are labeled (archive). Deleting these rows will not affect the main schedule.

Schedules which are associated with a cached report are labeled (cache). See Execution Caching for more
information.

Completed and canceled schedules and archives may be periodically removed from the list. Click LI Flush to remove
them immediately.

Managing schedules

"J
To edit an existing schedule click the Edit Z icon. Changes to the recurrence pattern will affect all forthcoming run
times. You can reuse or reset deleted or completed schedules by editing them. This will set their status to Ready.

To delete a schedule click the Delete * icon. This sets its status to Deleted. If the schedule is already marked as
Deleted, this removes the schedule from the list.

Emailing a Report Immediately

In addition to creating a recurring schedule, the application provides the option to email a report execution immediately.
To do this, simply select the desired report to email and select the Email Report option from the dropdown menu.
Users are then prompted to fill out the email address and select the output format for the report.

# Edit

Run Report
I+ ExportAs »
O Schedule Report

Email Report >

= Rename Export As.. | Exce % RTF | | CSV
W Duplicate

X Delete

Batch Emailing Personalized Reports

Batch scheduling allows you to send personalized versions of reports to a list of email addresses. The addresses must
be defined in a data category, the unique key of which is used as a blanket filter for the report. Each recipient receives
a customized version, filtered by their unique key.

For example, if you wanted to send out a customized sales review, or a pre-filled tax form, or even a set of customized
forms for each employee, batch scheduling allows you use one report for every person. This also has the benefit of only
needing to run the report once. So you are not making repeated calls to the database, which could be slow and
system-intensive.

Warning: Batch emailing should only be used as instructed by your administrator. If you are unsure about how to
proceed, do not create a batch schedule. Ask your administrator for assistance.

In order for batch scheduling to work properly, it requires access to a data category with a column of email addresses
that must be either located within or joinable to the underlying table. This data category can be added in the
Categories menu of the report. If this column does not exist, the report will abend with the following error:

System.Exception: Batch email column has n join logic to attach to report.

Note: The category containing the email addresses for batch scheduling does not need to be added to the report
itself.

To make a batch schedule:
1. In the Schedule Report Wizard, click the Batch tab.

2. Select the Run as Batch Report check box.
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3. Optional: In the To and Cc fields, enter addresses to send a summary email for each completed execution.

4. From the Batch Email Field list, select the data field containing the email addresses for this schedule. Fields can
contain a list of email addresses, separated by semicolons (;), as of v2017.3.8+.

5. Optional: Click the Recipients tab to enter a subject and message for the batch email.

You can reference data values from the email address data row in the message body. Type the parameter
@batch_column@, where column is the name of a data field in the address category (in lowercase text). The value of
the field replaces the parameter text in the message output.

report.

Tip: The To, Cc, and Bcc fields are unavailable when using Batch. Dashboards can not be scheduled as a Batch

ExpressView

The ExpressView designer is a data discovery and reporting tool that simplifies grouping, sorting, filtering, and
aggregating data with a drag-and-drop interface. A chart can be added with a single click, and ExpressViews can be

styled and saved as PDF, RTF, CSV, or Excel files.

Aux joyeux ecclésiastiques

O ProductName al

Charlrause verta

Cite de Blaye

A CsEal « <

22 Q UnitsOnOrder

=
]

O UmnitsinStock

69
]

Count: 2 Count: 2

Count: 2

Bigioot Breweries

O ProductName ~1 © UnitsinStock

Laughing Lumberjack 5

Fa

Lager i
Sasquatch Ale -.-,;I
Steeleye Stout 20
Count: 3 Count: 3
Cooperativa de Quesos 'Las Cabrag

o Unitsin&iock

o produciName ~ :
= 22

Queso Cabrales

Queso Mant hago La 6

The ExpressView Designer

Making an ExpressView

© UnitsOnCvder

Count: 2

e UnatsOnOaoer
10

ExpressViews allow you to quickly see data and make reports without concern for the minutiae of old-fashioned report

building.
To make an ExpressView:

1. Click the New Report+ icon and select * ExpressView.

Info. The ExpressView designer is divided into the Data pane on the left, and the Design pane in the middle. The
Data pane comprises all of your accessible data categories, containing groups of related data fields. Click the

-
Choose Data = icon to expand or collapse the Data pane.

2. Expand a category by clicking the arrow ¥ icon. This shows the fields in that category.

3. Drag a field onto the Design pane to add it to the ExpressView. This expands the field into a data column. It will

only show placeholder data initially.

Id

Nofes
Photo [

LastMame

DhnfnBath

.

Dragging a field onto the Design pane
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4. Continue to add fields as desired. Fields can be added or removed at any time.

Note. As you add fields, unrelated fields will become unavailable. To learn about how fields relate to each other,
see Joins.

5. When you are satisfied with your data selection, click Live Data to populate the ExpressView with data. You can
now page through your data using the navigation icons < < » »» in the toolbar.

© Truncated results displayed

This icon and message indicates that the report has only returned a partial data set. There are fewer detail rows
than the full set, and aggregate formulas and visualizations apply only to the data that was returned to the
report.

To get more data, click the icon and select either:

o Generate +number to get the next number of data rows and add them to the existing report.
o Generate All to get the full data set.

6. Click the Save Ficon to save the ExpressView. In the Settings window, enter a Name and select a folder where
it should live. Then click Save Report Info.

These steps illustrate how quick it is to make a tabular report from scratch using ExpressView. But ExpressViews can be
more than just basic reports. You can make groups, charts, calculations, and customize the look of the report. And it is
all designed to be easy to use. The articles in this section will describe how to use these powerful features.

About the radial menu

Throughout this topic you will see references to a menu called the radial menu. The radial menu is a menu of options for
each data column and group, which is accessed by clicking the colored Radial @ icon on the top left of the column or
group.

CategoryNs poryNs goryMNs
%tegor’,-‘l\lame AMame @ yMame
CategoryMame S eeory N ame ategory N ame
CategoryMame CategoryMame CategoryMame
CategorvMName CategorvMName CateaorvMName

Using the radial menu

Each radial menu has four options, arranged in a circle around the center. When you are prompted to select a radial
menu option, you will be asked to "use © radial>direction". Direction is one of the four cardinal directions corresponding
with one of the four options: left, right, up, down.

For example, "use © radial>left" means to open the radial menu and select the left option. To do this, you have two
options:

e Click the radial icon, move your cursor left, then click again.
e Click-and-hold the radial icon, drag your cursor left, then release.

To close the radial menu without selecting an option, click in the center.
Interactive Editing

With the introduction of interactive editing to ExpressViews in v2018.2, you can customize your report by simply right-
clicking on the desired section while in design or live mode.
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Apply to all L
© BirthDate
08-12-1964 Aial v | A w0
19-02-1968 —
30-08-1979 Norma v u_a Aa
19-09-1953 -
04-03-1971 EE = = === =2
02-07-1979 .
29-05-1976 fx Convert to Formula
09-01-1974 )
27-01-1982 T Fiter

gl Sort by this Column

Group

Count: 9 *  Remove

Right-click options include all of the capabilities of the radial menu, conditional filters, and formatting options such as
text alignment, font type, and font color.

ExpressView: Managing data

You can exercise some fine grained control over the actual data that appears in the ExpressView. You can choose how

the data appears, you can filter down the rows to appear, and you can change the order of rows in their respective
sections.

Formatting data

Formatting allows you to specify a data type for specific data fields, and choose how that data displays.

To change the data type for a field:

1. Click the Formatting and Style icon to open the Formatting page.

2. Click the data rows to format. They will highlight in blue.

© ProductName ~2

Laughing Lumberjack

Lager
Sasquatch Ale{b

Steeleye Stout

Selecting data to format

3. Click the Data Format tab.
4. From the Format Type list, select a data type from the following options:

General

Format the data using the default settings for your environment. The application will assume the data type.
Number

Format the data as a number. Continue to step 5.

Date

Format the data as a date, time, or date and time. Skip to step 6.

Date/Time Format

MM/dd/yyyy v

MM/dd/yy
M/d/yy

M/d/yyyy
wwy-MM-dd

Choosing a date/time format

Text

Do not apply any formatting to the data, and show it exactly as it appears in the database
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5. Optional: If you selected Number you can choose how the number displays. You can customize the following
options:
1. In the Decimal Places field, enter a number for how many decimal places to display. In the field to the
right, enter a symbol to use as the decimal mark.
2. To show a delimiter every three digits, select Use 1000 Separator. Then, in the field to the right, enter a
symbol to use as the delimiter.
3. To show a symbol before the number, indicating that this is currency, select Use Currency Symbol. Then,
in the field to the right, enter the symbol to show.
4. To show a percent sign after the number, indicating that this is a percentage, select Append Percent
Sign.
To show no value if the number is 0, select Blank When Zero.
To show the negative symbol in front of negative numbers, select Show Negative Symbol.
To show parentheses around negative numbers, select Show Parenthesis.
To show negative numbers in a different color, select Color, then enter a hex value or use the color picker
to choose a color.
6. Optional: If you selected Date, you can choose which date and time components to display, and how to show
them.

© N w;

If the data field cannot be formatted as a number or date, then selecting one of those options will have no effect on
the appearance of the data.

Reordering data rows

Sorting allows you to set the order that the data rows appear in each section. Click the Sorts Sticonto open the list
of sorts. Every data column in the ExpressView that is not a group column is automatically sorted.

You can choose which columns take precedence for sorting. The order of fields on the Sorts page is their order of
precedence, from highest to lowest. Their order is also indicated by a number on the right of the column headers: The
lower the number, the higher the precedence.

To set the sort precedence of data fields, either:

e On th_e Sorts page, drag fields up or down.
e Use '® radial>down to give a field the highest precedence.

r==a [=]
Lk d =1 Y £
Sorts
UnitsOnOrder age dagr
ProductName asc | desc
UnitsinStock asc | desc

Dragging a sort to change its precedence

You can choose which direction to sort the data for each data field: ascending or descending. A field's sort direction is
indicated by an arrow on the right of the column header: Up ~ for ascending, down « for descending.

To change a field's sort direction, either:

e On the Sorts page, select asc for ascending, or desc for descending.
e Click the column header to swap to the opposite direction.

Narrowing your data

Filtering allows you to narrow the scope of your ExpressViews by restricting the amount of data shown. You can filter

data by only showing rows whose values satisfy certain conditions. These are Standard filters. You can also filter data
to only the rows with the top or bottom values, for either data fields or data summaries, per group iteration. These are
Top N filters.

Click the Filters T icon to open the list of filters. The filters page has two tabs: Standard and Top/Bottom.
To show only the data that satisfies several conditions:

1. On the Filters page, click the Standard tab.

2. To add a data field to filter, either:

o Use '® radial>right on a data column or group.

40 of 168



ExpressView: Managing data User Guide

o Drag a data field from the Data pane to the Meet all of the following conditions pane.

Note: This allows you to filter any accessible data field, not just those on the ExpressView.

3. Choose a filter operator from the list. See Filters for details.
4. Enter a filter value or values, or select them from the list.
5. Repeat steps 2-4 for every filter condition that the data must satisfy in order to show.

6. If you are viewing live data, click Apply Changes to apply the filters.

To show only the data that satisfies at least one of several conditions:
1. On the Filters page, click the Standard tab.

2. To add a data field to filter, either:

o Use ® radial>right on a data column or group. Then drag the filter to the meet any of the following
conditions pane.

o Drag a data field from the Data pane to the meet any of the following conditions pane.

Note: This allows you to filter any accessible data field, not just those on the ExpressView.

3. Choose a filter operator from the list. See Filters for details.
4. Enter a filter value or values, or select them from the list.
5. Repeat steps 2-4 for every filter condition, of which the data must satisfy at least one in order to show.

6. If you are viewing live data, click Apply Changes to apply the filters.

w6 S+ Y o @ 060 347 o
Filters Filters
Meet all of the following conditions: Meet all of the following conditions:

. w Products.ProductName is null

ProductName - Equal To v

nd meet any of the following conditions: & v

Guarana Fantdstica

Gudbrandzdalsost %

8N Gula Malacea

o [ |
Adding a field as a Standard filter
To show only the top or bottom values, for either data fields or data summaries:
1. On the Filters page, click the Top/Bottom tab.
2. Select the Limit the report to the top/bottom values check box.
3. Select either Top or Bottom, for whether you want to show the top or bottom values.
4. Enter a number for how many values you want to show.
5. Choose how you want to limit your data:

o If you want to show the rows with the top or bottom data values for a field or group, select Values from
the list.

o If you want to show the groups with the top or bottom summary values for a parent group or the
ExpressView, select one of the summary calculations, Sum, Avg, Min, Max, Count, or Distinct Count,
from the list. See the article on aggregation for more information.

Note: Only numeric data fields support Sum and Avg calculations.

6. Select the data field or group field to filter from the Of list.
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7. Optional: To show the top or bottom values for each iteration of a group:

1. Click + Add Group.

2. Select a group field from the For Each list.

w060 St Y o

Filters

Standard Top/Bottom

Limit the report to the top/bottom values

Display...
Top v 10 v
of...
Fu (type here fo search) L4

Other Existing Report Columns
Products.ProductMame
Products.UnitsinStock
Products.UnitsOnOrder l/\\s
Products.ProductiD

Adding a Top/Bottom filter

ExpressView: Formula columns

Note: Formula columns are available beginning with version 2018.1.

Formulas can be used to create custom data columns in ExpressViews. Formulas are calculated once per each row,
based on the other data values in that row. For each row calculation, a formula value is returned for that row, which
populate a new column of data. You can use these columns just like any others - format the data, add to a
visualization, or group based on formula columns. They are treated the same as data columns.

-
To add a formula column to an ExpressView, click the Choose Data = jcon to open the Data Pane, then click + Add

Formula. A blank column will be added to the ExpressView, and the Formula Builder will open.

In the right pane, the Formula tab of the Selected Cell b page shows the available built-in functions and
parameters. Hover over a function to see its description and an example of how to use it. To add a function or
parameter to the formula, drag it from the Formula page to the Formula Builder window, type its name into the Formula
Builder, or double-click the name of the function while the formula editor dialog is open. You can use the Search field in
the to filter the functions by name.

DateDiffi( !

BirthDate 7 EmployeelD 7
BirthDate 8 EmployeelD 8
BirthDate 9 EmployeelD 9
BirthDate 10 EmployeelD 10

Formula editor dialog

To add a data field to the formula, drag it from the Data Pane to the Formula Builder window, type its name into the
Formula Builder, or double-click the field nhame while the formula editor dialog is open.

Note: Double-clicking the field names will place the fields wherever the cursor is in the formula editor at that time.
Double-clicking enabled in v2018.2 and later.

Tip
To use a data field, function, or parameter as a function argument, drag it to the argument placeholder until the
placeholder turns blue. Or click the placeholder and type the name of the desired argument.
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Formula Builder

LIIMGUEVEI  inputDateOrNumber |

OrderDate ]

Dragging a field to a function argument

Typing in the Formula Builder shows a list of functions, parameters, and data fields that match the text. Click on an

item, or use the up and down arrow keys, to highlight an item and see its description. To add the selected item to the
formula, press the Enter key.

When you are finished, click the Apply Changes icon to save the formula.

To edit an existing formula column, click Selected Cell EH , open the Formula tab, then click the column to reopen the
Formula Builder.

See Formulas for more details on building formulas.

ExpressView: Customizing Appearance

ExpressViews can be styled in a variety of ways:

e Click the Formatting and Style o icon in the right pane to make universal report styling changes such as

Theme.
® 060 S+ Y &
Style
» Theme
Theme Selector
Emerald Forest v

» Row Shading
» Group Colors

o Click the Selected Section - icon and choose a section of the report to make formatting changes.

e Right-click a section of the report for interactive editing that includes formatting options and data structuring
options such as sorting, grouping, and filtering. Learn more about interactive editing in ExpressViews here.

Apply to all L J
© BirthDate
08-12-1964 Arial v A
19-02-1968 —
30-08-1979 Normal v m Aa Aa
19-09-1953 -
04-03-1971 EE == === =
02-07-1979 .
29-05-1976 fx Convert to Formula
09-01-1974
27-01-1982 T Fiter
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Group

Count: 9 *  Remove

43 of 168



ExpressView: Customizing Appearance

Using a premade theme

If there are any available, you can select a premade theme to use for the ExpressView, or to use as a baseline for
further customization. On the Formatting page, click the Theme tab. Then select a theme from the Theme Selector

list:

Legacy

This is the default theme.

Custom

This option indicates that you are not currently using a premade theme.

User Guide

Selecting a premade theme overrides any custom styling you have. Be sure to save the ExpressView first, so that you
can retrieve your styling if you accidentally override it.

Style
Theme

Theme Selector

Custom v

Custom

Amethyst Cavern
Ashen Metropolis
Crimson Mountain
Emerald Forest s
Legacy

Samnhire Move

Selecting a premade theme

Styling data cells

Cells, columns, group headers, and group footers can be styled using the Report Formatting and Style pane, the
Selected Section pane, or by right-clicking sections of the report. Each of the three options is used for different
purposes:

¢ Universal report styling changes such as theme, row shading, and group colors are made using the

Report Formatting and Style pane. See the following two sections for more details on row and group colors.

e The Selected Section ™ pane is used to make data format changes such as Date or Number format or to

create formulas in a column. It can also be used to style multiple cells or sections at one time when used
r==a

with the CTRL key. To use the multi-select feature, click the Selected Section HH icon, hold the CTRL key while
clicking all of the desired sections, and then make changes in the right pane.

o To make styling changes to independent sections, you can right-click specific areas and use interactive

editing or you can click the Selected Section HH icon, click the appropriate section, and make changes in the

right pane.

Changing data row colors

The background colors for the data rows can be customized, and you can set the pattern by which the colors
alternate. This affects every data section in the ExpressView.

To set the background colors:

1.

On the Formatting page, click the Row Shading tab. By default there are two colors which alternate every
other row.
Choose the number of colors that you want to alternate between:
o To make all rows the same color, click * to delete all the colors except one.
o To make rows alternate between more than two colors, click + to add more colors.
Enter a hex value or use the color picker to set each color.
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v Row Shading

Alternate Shading Colors
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Choosing data row colors

Changing group colors

The headers and footers for group columns are prefixed by a different color depending on the level of grouping. These
colors can be customized, and you can set the pattern by which the colors alternate. This affects every group header

and footer in the ExpressView.

To set the group level colors:

1. On the Formatting page, click the Group Colors tab. By default, nested groups alternate between four colors.
2. Choose the number of colors that you want to alternate between:

o To make all group levels the same color, click = to delete all the colors except one.

o To make group levels alternate between more than four colors, click + to add more colors.
3. Enter a hex value or use the color picker to set each color.

v Group Colors

Radial Menu Group Colors

L

#G896ED 104 150 237
Hex R G B

Choosing radial menu colors

ExpressView: Making visualizations

Charts allow you to showcase your data in a visual format. They allow you to quickly scan your data for patterns and
trends. Charts can be easily made and customized in ExpressViews, in as little as one click.
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An ExpressView Visualization

To add a chart to an ExpressView:

1. Click the Show Visualization '|I+ icon. A bar chart is added and populated with the data from your ExpressView.

2. In the Visualizations pane, select the type of chart you want to use. The chart immediately swaps to that type.

Click on a chart series to drill down into the data for that series. This filters the data columns to only the series you
select.

You can add many more personal touches, small or large, to the visualizations you create. See the following sections
for details on how to customize your visualizations.

Choosing chart data

When a visualization is first added, the application presets the chart fields to try to match the ExpressView data as
closely as possible. This may not always match the data that you want the chart to use.

To see the chart data fields, click the Visualizations ol icon, then click the Data tab. There are two fields: Labels
and Values.

Labels

The Labels field is a group of data values, each iteration of the group represented as a series on the chart. For
example, using an Employees group field as the label field represents each employee as a series.

Several charts allow an additional labels field. This is useful if you have a nested group, which represents common
series to be measured across several groupings. For example, to compare the number of sales per product per
employee, you could add a nested Product field as a second label to the aforementioned employees chart.

To add a chart label, either:

e Drag a data field onto the chart and release on the Add Label area.
e In the Visualizations pane, click the Data tab. Either:

o Drag a data field to the Labels area.

o Click + Add Label, then select a field from the Field list.

User Guide
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Visualizations
Products on Order

by Unit Quantity Type Data Appearance

Drag items from the report into the ‘Labels’ and Values’

: fields below
Add Label
Labels
CategoryName : Suppliers.CompanyName v
44 66 88 110
Mumber of Units Categu-ryNime et

Drag a field onto the visualization or onto the Data tab to add it as a label

Values

The Values field is the data values to plot on the chart for each iteration of each labels group. For example, the
number of sales per employee.

Several charts allow for multiple values fields. This is useful if you have common series to be measured across several
groupings, and the values fields are in the same data row. For example, the number of sales and number of lost sales
per employee.

To add a chart value, either:

e Drag a data field onto the chart and release on the Add Value area.
e In the Visualizations pane, click the Data tab. Either:

o Drag a data field to the Values area.

o Click + Add Value, then select a field from the Field list.

Suppliers.CompanyMame v
Specialty Biscuits, Lid.
Add va'ue B ——— VE'UQ‘S
Plutzer LebensmittelgroRmarkte AG Enter Series Name..
[ UnitsInStock Productz Units0OnOrder v
[ N UnitsinStock
‘ [,\f [ T iy = i el

Drag a field onto the visualization or onto the Data tab to add it as a value

Interactive Editing of ExpressView Visualizations

You can invert the data, change the Type, Theme, Legend Location, or Sort of ExpressView visualizations by simply
right-clicking with the introduction of interactive HTML to ExpressViews in 2018.2.

Alice Mutton

Aniseed Syrup

Chef Anton's Gumbeo Mix
Gorgonzola Telino

Gravad lax
Maxilaku ]
Mozzarella di Giovanni ' Type L
Maord-0st Matjeshering ! [ ]
Perth Pasties Theme > j\j = III
Thiringer Rostbratwurst
0 Legend Location » B
Use 30 Style
Sort By L InStock  F= On Order

Invert Data

You can learn more about interacting with reports here and more about visualization types here.
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ExpressView: Grouping and summarizing data

Grouping a column of data breaks up the rows into sections which share a common trait. Each iteration of a group is a
unique row in a data column. Grouping data allows you to easily identify rows with common factors. You can perform
calculations on groups, such as counting the rows, or adding up the data in each iteration.

Group 1

© Column 1 ~1 © Column 2 Ly
Column 11 Column 2 1

Column 12 Column 2 2

Count: Group 1 Column 1 Count: Group 1 Column 2

Group 2

Grouping data in an ExpressView

Making a group

To create a group from a column, use @ radial>up or right-click the column and select Group in the dropdown menu.
This turns the data column into a group column, and organizes the other columns by each unique row in the group.
Each row in the data column becomes a group section, or iteration, and the rows in other columns are grouped by the
section which they are related. The group is also given a new color to distinguish it from the data rows. Remember to
turn Live Data on to see your actual data and verify that this is the grouping you want.

To ungroup a column, use © radial>left or right-click and select Ungroup from the dropdown menu. This turns the group
column back into a data column.

Groups can be created inside other groups. These are called nested groups. To make a nested group, simply add
another group to an ExpressView which already has one. This creates another grouping inside the existing group.
Additional levels of nesting can be made as needed.

Note: Right-click interactions added in v2018.2.

Changing group level

If you have two or more levels of grouping, you may decide that they are nested improperly. For example, if you had
Products grouped by Orders, then you add another grouping on Employees, you may end up with Products grouped by
Employees grouped by Orders.
Orderld 1
LastName 1

© ProductName ~

Improper grouping of data fields

However, it makes more sense to have Orders grouped by Employees instead, since Employees have multiple Orders,
but Orders does not have multiple Employees. To move the Employees group up one level, use © radial>up on the group
column or right-click the group header and select Move Group Up One Level.

LastName 1
Orderld 1

© ProductName A

Proper grouping of data fields
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Summarizing group data

Each iteration has a footer, which contains summary calculations, also known as aggregates, for each column. The
ExpressView also has a report footer, which calculates the aggregate across all the groups. You can choose between
several options for which calculation you want to appear in the footer for each column.

To change the calculation for a column, click a footer and select one of the following options:
Sum

Totals the data values in the iteration. Only available for numeric fields.

Min

Shows the smallest data value, or first value alphabetically, or earliest date in the iteration.
Max

Shows the largest data value, or last value alphabetically, or latest date in the iteration.
Count

Counts the number of values in the iteration.

Distinct Count

Counts the number of distinct values in the iteration.

Avg

Takes the average, or arithmetic mean, of the values in the iteration. Only available for numeric fields.
None (v2017.3+)

Show no summary calculation.

© UnitsinStock a3
Sum: 86 @ v
Sum 86

Min 17

Max 69

Count 2

Distinct Count 2

Avg 43

Nene

Choosing an aggregate

For more information on aggregation, see this article.

Hiding data rows

If you only want to see the summary calculations, you can hide the data rows, either per-iteration, or for every group
in the ExpressView. This does not remove the data or alter the summaries. It only hides the rows from view.

To hide the rows for one iteration or several iterations, click the group header for each iteration to toggle whether its

User Guide
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rows are shown or hidden.
To hide or show all the rows in the ExpressView:

1. Click the Expand/Collapse = icon.
2. Click t= Hide All Group Content to hide all the rows, or = Show All Group Content to show all the rows.

If you have nested groups, this hides all but the top level groups.

(v2017.34+) To remove all data rows from the report and only show summary data, deselect Include Detail Rows. This
may improve the performance for reports that do not depend on the detail values.

ExpressView: Data categories and fields

The data pane is organized into data categories, which you can expand to see their fields. Click the
Choose Data icon to expand or collapse the data pane.

A H* &= "
Fields + Add Formula

v Qrder Information
> Categoeries
v Customers
Address
City

ContactName

Viewing the available data fields

To locate a specific data field, type the name of the field into the Search field and press Enter. To see all the data
fields, click = to clear the search field.

You can show only data fields of a certain type by clicking one of the type icons under the Search field:

° text

° numeric

e = date/time
e . other

All available data categories are usable on an ExpressView. You do not have to worry about adding categories manually
or thinking about join structure. Adding a data field is as simple as dragging it onto the Design pane. This turns it into a
data column. Use © radial>left to remove a data column.

ExpressView: Exporting to other types

ExpressViews can be used as a starting point to quickly add fields to a report, before delving into some of the more
advanced reporting capabilities. The ExpressView format is not compatible with the report designer, but you can export
it to an Advanced Report and edit the copy.

To export an ExpressView to an Advanced Report:

Click the Settings =2 icon.

Click the Create Advanced Report tab.

Enter a name for the report and select a folder where it should live.
Click Create Advanced Report.

A\

Note: Beginning in v2018.2, Advanced Reports converted from ExpressViews will retain reprinting of group headers by
default if detail section spills to the next page.
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If you to save an ExpressView as a file, it be exported as PDF, RTF, CSV, or Excel. Each format has some advantages
and disadvantages.

e PDF is closest to the look of the ExpressView, and is suitable for printing and emailing. But if there is a large
amount of data, you may have too many pages, or too large a file size.

e RTF retains the basic look of the ExpressView, and can be opened in a word processor for any additional editing.
But it may look different depending on the program it is viewed with, and it is not suitable for viewing large
amounts of data.

e CSV retains only the data, and none of the look of the ExpressView. It is best used if you need to process a large
amount of data in an accounting or analysis program.

e Excel retains the data, visualization, and optionally, some styling. It is a good hybrid format if you have a lot of
data, but you still need it in a visually presentable form.

Export settings

You can make some customizations to the appearance that the exported files will take. With the Settings page open,
click the Export Settings tab to see the available options:

e Page Options affect the size which PDF, RTF, and Excel exports will show on a screen and on print.
o General Options allow you to restrict available export types, and choose a default type.
o Other Options:

o Include Setup Info: Choose whether to include some information about the fields, sorts, and filters in the
body of the file.

o Use Group Color Styling: Choose whether to include the group header colorings in the output file.

o 'No Data Qualified' Mode: If the ExpressView returns no data, choose whether to render an empty file, or
show a user message instead.

o Flatten Groups in Excel and CSV: For Excel or CSV files, choose whether to automatically ungroup, or
"flatten" all group columns into data columns. This may make the output more suitable for data analysis.

o Keep Cell Styling in Excel: For Excel files, choose whether to show styling, such as font and row shading,
or to show only the bare data.

Report Viewer

When you run an Advanced Report, Express Report, or Crosstab Report, the output is shown in a paged, interactive
format called the Report Viewer. The viewer shows you the report populated by all of its data. You can page through
the data and search for specific items. You can also make some additional adjustments to the report, such as styling
cells or changing column sorts.

User Guide
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To run a report in the Report Viewer:

The interactive Report Viewer

e If you are in the Report Designer, click Run Report.

Tip: The Run Report button also saves the report.

$125.00

$1,525.00

$380.00
$125.00
$380.00

e If you are in the folder tree, click the Run D icon, or click the Menu E icon and select ':E:' Run Report.

The Report Viewer opens in a new tab, indicated by the viewer ® icon. This tab represents an instance of the report
output as you have just run it. If you go back and edit the report, you need to run it again to see the changes. This

will open another viewer tab, and you can go back and close the old one.

User Guide

Page through the report by using the navigation icons “ < » ' Search through the report output by typing into the

Find field.

If you want to save the output, you can export from the Report Viewer to a PDF, RTF, CSV, or Excel file.

0 Truncated results displayed

This icon and message indicates that the report has only returned a partial data set. There are fewer detail rows than

the full set, and aggregate formulas and visualizations apply only to the data that was returned to the report.

To get more data, click the icon and select either:

e Generate +number to get the next number of data rows and add them to the existing report.

o Generate All to get the full data set.

Report Viewer: Interacting with reports

There are a number of ways to interact with reports in the Report Viewer. Your available options depend on how the

report was designed and the type of content in it.

section.

Tip: If your environment has Action Events, you may have access to more interactive features than are listed in this

Drilling into data

Some reports allow you to drill down into cells or charts to see some additional data related to the field you selected. If

a cell or chart has a drilldown, you can click on one of the values to drill down into the related data.

Drilldowns are actually other reports that you can interact with or even export to a file. Drilldowns may even have

drilldowns of their own!
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Drilling down into a data cell and a chart
Expanding hidden data

Some reports have hidden data that can be seen by expanding certain rows. Expandable rows are indicated by an
arrow icon ¥. Click on the icon to expand the row. Click the icon again to collapse it. Right-click the icon to open a
menu to do the following:

Expand / Collapse

Expand or collapse the outer group

Expand / Collapse Group

Expand or collapse the group and any inner groups
Expand / Collapse All

Expand or collapse all outer and inner groups on the report

r Antonio Vioreno lagqueria r Antonio Vioreno lagqueria

Eastern Connection Eastern Connection

» Eamilic Arcouwiboldo » Eamilic Arcouwiboldo

Expanding a data row
Chart features

Charts have a number of interactive features depending on the type of chart. For example, line charts and bar charts
allow you to hide series, multi-axis charts allow you to turn axes on or off, and pie charts allow you to rotate the chart
and pull out slices. Charts can also show some additional information if you hover over a point or series.

5:]:] ........................................................................................................................................................ 33:]:]33:]
400 $240,000
300 $180,000
2 $120000 < Order Count
Total Revenue
100 $60,000 {lj
g ! ) ) 30
Buchanan Callahan Dawvolio  Dodsworth Fuller King Leverding Peacock  Suyama

Toggling a chart series on or off
Drilling into maps

On a Google Map, use the mouse wheel or click the Zoom in + and Zoom out = icons to change your view level. Drag
the map to move the view in that direction. Double-click on a highlighted region to drill down into the location data.

On a geochart, click on a highlighted region to drill down into the region. Click [Back] to return to the previous view.
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Report Viewer: Customizing report output

In the Report Viewer you can make changes to the style, formatting, and data of the report. These changes can be
saved to the original report, to a new copy of the report, or as a user report, by clicking the Save changes icon.

Caution: If you make any changes, you must save them before closing the Report Viewer or you will lose them.
What is a user report?

A user report is a customized version of a report that is specific to you. User report changes are saved separately from
the report design, and will only show when you run the report yourself. These can be useful if you want to make
changes to a locked report.

Note about cookies: User reports may be stored as browser cookies. Ask your administrator whether this is the case.
If so, then user report changes will only apply to your current computer and web browser. Clearing your browser
cookies will remove any user report customizations that you have made.

Styling data cells

Right-click a cell to open the style menu. Using this menu you can set custom styling for the following: Font, Size,
Color, Background color, Text decoration, Alignment, Word wrap. Styling applies to all cells of the same type in the
group; affected cells are outlined by a yellow band.

Apply to all x
B T U A®|q
Arial
L |
Seafood [:
ProductName

rotrn Prah Wlaot

n

Right-clicking a cell to change its styling

For group cells with dynamic data from fields or formulas, use the Conditional Filter list to apply styling to only the cells
that meet a certain condition. For each of the following options, styling applies to the cells of the same type in the
group that meet the specified condition:

Apply to all

All cells

Apply to equal values

All cells with the same value as the selected cell

Apply to unequal values

All cells with different values than the selected cell

Apply to greater values

All cells with values greater than the selected cell (larger number, later date, or alphabetically subsequent)
Apply to greater than or equal values

All cells with values greater than or equal to the selected cell

Apply to lesser values

All cells with values less than the selected cell (smaller number, earlier date, or alphabetically preceding)
Apply to less than or equal values

All cells with values less than or equal to the selected cell

Tip: Select a condition before selecting the styling.

Styling charts

Right-click a chart to open the chart menu. Using this menu you can swap to a different Type of chart, change the
color Theme, change the location of the Legend, and change the Sort order of the data series.
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Right-clicking a chart to change its type
Managing data columns

Each column on the report has a light gray control box at the top of the page. Change the width of the columns by
dragging the control left or right. Sort by a column by clicking the control. To hide a column, right-click the control and
select * Hide Column from the list.

Order Date Customer

X Hide Column

Customer

Drder Date Customer

Resizing a column and right clicking a column to hide it

Setting interactive sorts and filters

Reports can have some additional filters and sorts saved on top of the base report. Click the splitter * icon to open the

sidebar to manage interactive sorts and filters.

Filterable fields can be narrowed down to select values or to a range of values. If a data field is not available to filter,
click the Add Ttem ¥ icon to add a filter for that field. To remove a filter, click the Delete Item * icon.

The order of sorted fields can be swapped between ascending 2l and descending 21,

You can also add conditional filters to hide rows where the cells do not meet a certain condition. To do so, right-click a
cell to open the style menu, select a condition from the list, then click the Filter Values 7 jcon. Conditional filters are
shown in the sidebar.

- b

| Apply to greater values

B I A%
Open Sans

u

1

Adding a conditional filter

Report Wizard

The New Report Wizard opens at the start of each new Express Report, Advanced Report, or Crosstab Report. The
wizard lets you add and configure data, and lets you quickly set a layout for your report before you dive into the full
designer.
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The Express Report Wizard Layout page
What are Express Reports?

This report type is made entirely using the Report Wizard. If you do not need the additional capabilities of the advanced
Report Designer, Express Reports are an easy way to design tabular reports. To open an Express Report in the
Advanced Designer, you need to convert it to an Advanced Report.

Using the Report Wizard

The Report Wizard has several pages, which you should progress through from left to right. The following articles detail
how to use each page in the wizard.

Name e Categories e Sorts e Filters e Layout e Options

Tip: Only Express Reports have an Options page. Crosstab Reports do not have a Sorts page. The Layout page differs
slightly for each report type. The Name and Categories pages are mandatory. If a page is not available, your
administrator may have disabled it.

Report Wizard: Name

Enter a name for the report and select a folder where it should live. Choose a unique, descriptive name that is easy to
remember. If you are in a shared environment, you may want to put your name in the name of the report.

Caution
You cannot save a report in a locked # folder. A report name cannot contain the following characters:
\/:*?2"<>|

This page must be completed before moving on, but you can always go back later and rename or relocate the report.
Description

This is an optional field, which allows you to give some additional information about the report.

Filter description

You may see an additional field for entering a description for the report filters. If you intend to add user prompting
filters to this report, then you can enter some information in this field that a user will be able to see when entering filter
values.

Report Wizard: Categories

Select which data to use on the report. The left pane shows the data categories you can access. To see the fields in a
category, select it, then click the View Category Fields 'ﬂ icon.
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What are data categories?

Data categories are tables of data, which are organized by rows and columns. Columns are also known as data fields. A
row of data has entries for one or more columns in the category. When you add a data field onto a report you are
seeing the information in one column of data for every row in the category.

For example, a data category for Employees could have columns for the first and last names of each employee, an
identification number, and a home phone number. Each row represents a person, and each column contains a specific
type of information such as Last Name or Phone Number.

Employees

LastName FirstName Id HomePhone
Davolio Mancy 1 (206) 555-9857
Fuller Andrew 2 (206) 555-9482
Leverling Janet 3 (206) 555-3412
Peacock Margaret 4 (206) 555-8122
Buchanan Steven 5 (71) 555-4848
Suyama Michael 6 (71) 555-7773
King Reobert 7 (71) 555-5598
Callahan Laura ] (206} 555-1189
Dodsworth Anne 9 (71) 555-4444

Example of a data category for employee records

You add entire categories at a time to a report, but in the report view you select only the columns you want to see.
When you add a data field to the report design, even though you only see one column, the rest of the table is still
present behind the scenes. You will never lose the connections between items in each row, and you can always add
more fields.

Adding categories

On the Categories page, add data categories to the report. Later on, you can select which fields you actually want to
see in the report layout.

cimployeses

Orders .
Products ’ OrderDetails . l
Chinmnare L&

Dragging a category to the Category Name pane

|Tip: As you add categories, unrelated categories will become unavailable.

SQL Categories (Advanced Users)

‘Note: This feature is available in versions 2018.1 and above.

You may have the ability to define a custom data model for the report without needing to use the predefined data
categories. For databases which support unique or unusual behaviors that are not supported in the main interface, you
can use custom SQL to supplement or bypass the standard Categories, Sorts, Filters, and Joins. Only new reports,
created with the Report Wizard, can have a custom SQL category. You cannot add a custom SQL category to an
existing report.

Caution: Writing custom SQL requires knowledge of the underlying databases and their relevant SQL query language.
It is only recommended for advanced users.

To add a custom SQL data category, click + Add SQL. From the Custom SQL Object window, add the following:

1. Object Name - Unique name for the custom category. It cannot be the same as an existing category. It cannot
contain white space or the following characters:

[1{}., @
2. Data Source - Select the data source to retrieve the data from.
Not every data source you can access may support custom SQL categories.

3. Enter the full SQL statement in the code window. Note that this will be inserted into a subquery when it is sent
to the database for processing.

Optional: Parameters are system variables that contain different values depending on factors such as the
person running the report. To include parameters in the SQL statement, select them from the Parameters list then
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click Add. Or enter the parameter name surrounded by At Signs (@).

User Guide

Tip: A custom SQL category can only be the sole category on a report. A report cannot contain multiple custom
SQL categories, or a mix of custom SQL and standard categories. Therefore, to include multiple tables on a
report with custom SQL, you must retrieve multiple tables and join them in the SQL statement. If field names
conflict, you can alias them in the SQL statement, or else the application will append a number to the end to
preserve uniqueness.

Click the Test

4. When you have finished writing the SQL, click the Unique Key Fields list and select the unique keys for the
category.

5. Click Okay when done. If you have already sorted and filtered in the SQL statement, you can skip these menus.

Once added, you can edit the SQL category by clicking the SQL icon =t next to its name in the Categories window.

Report Wizard: Sorts

Sorting is the process of ordering your data rows by a certain sequence. For each available data category, you can

icon to check if the SQL is valid.

choose which data field should be used to sort the rows. Fields can be sorted in ascending or descending direction. The
way in which rows are sorted depends on the type of value in the field:

Numeric

-+ Asc Lower values

Date

=+ Asc Past

Text

-+ Asc A Z Desc +

A report can have multiple sorts. This can be useful when you want your highest precedence sort to affect a data field

Future Desc *+

Employee Name
Steven Buchanan

Margaret Peacock

Higher values Desc *+

Department
Client Services
Human Resources
Development
Client Services
Executive
Development
Client Services
Support
Executive

where the values for multiple rows may be the same.

For example, imagine a large company with many employees. There could be multiple people with the last name
Buchanan. With only a sort on LastName, you do not know how all the people with the last name Buchanan will be
ordered amongst themselves. If this matters, then you can add a second sort on, say, the FirstName field, so that

Employee Name
Steven Buchanan
Anne Dodsworth
Janet Leverling
Mancy Davolic
Robert King
Andrew Fuller
Michael Suyama
Laura Callahan
Margaret Peacock

people with the same last names will be ordered by their first names.

Adding sorts

On the Sorts page, add data fields to sort. The precedence of the sorts starts with the highest row and moves down

the list. Drag the rows up or down to change the precedence.

Productld [
Quantity

Department
Client Services
Client Services
Client Services
Development
Develepment
Executive
Executive
Human Resources
Support

Sorting Employees by the Department field, ascending

Orderld [

Tip: Sorts are not applicable for Crosstab Reports.

Report Wizard: Filters

Sometimes you may only want to see a portion of rows in a data category, rather than its entirety. Filters allow you to

Loy

Dragging a field to the Sort By pane
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narrow the scope of your reports by restricting the amount of data by specified criteria.

For example, imagine a category containing a row for every single sale your company has ever made. You can use a
filter to limit the report to only sales from the past month. This also has the benefit of speeding up your reports.

Filters in the Report Wizard, called standard filters, limit data by only showing rows where the values for a field meet a
certain condition.

Adding Filters

On the Filters page, add data fields to filter.

uraendad

Quantity [
UnitPrice

Productid

v

Dragging a field to the Filter By pane

For each data field, select a condition. When the report is run, the field value for each row is checked against the
condition for that field. Only the rows where the field satisfies the condition will show on the report.

For each data field, select a condition. When the report is run, the field value for each row is checked against the
condition for that field. Only the rows where the field satisfies the condition will show on the report.

To create a filter condition:

1. Select an operator from one of the following options. This is the condition used to match the data values to your

specified filter value or values. Some operators are only available for some data types.

The following table describes the filter operators and their applicable data types:

Condition Type Filter Value |Matching Values \I\’IgfuI::tching
July 4, 2016 July 4

Equal To (=)  [Any July 4, 2016 |51 4 2016 12:00 |July 4, 2016 2:00
AM PM

Less Than (<) g;gt}e;m July 4, 2016 |July 3, 2016 July 5, 2016
July 5, 2016

(G:)eater Than g:?:ﬁ':me July 4, 2016 |5, 4, 2016 5:00 [IUIY 3, 2016
PM

Starts With | Text, Number | 203 2035550224 8458081120

Ends With Text, Number  |224 2035550224 7188044606

Contains Text, Number [ 555 2035550224 2038081120

Between Any 1, 4 1, 1.5, 3,4 0.999, 5

One Of Any 1,2,3, 4 1,2,3, 4 1.1,9

2. Enter a filter value or values, or select them from the list of existing values.

Equal To -
Lakkalikgr -
Laughing Lumberjack Lager

Lenglife Tofu

Prompt For Value l,\\s

AMND With Next Filter

Group With Next Filter

Choosing a filter value
3. Optional: If you have multiple filters, you can choose how they should be grouped.

4. Optional: If you want the report to prompt the user to enter a filter value when the report is run, select
the Prompt For Value checkbox.

Report Wizard: Options

The Options page is available for Express Reports. For information about the available options, see General Options.
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Converting to an Advanced Report

Express Reports can be used as a starting point to quickly design a report, before delving into some of the more
Advanced Reporting capabilities. To edit an Express Report in the Report Designer you need to convert it to an
Advanced Report. The data and design of the report are preserved and it gains some additional capabilities, but it can
no longer be edited in the Report Wizard.

To convert an Express Report to an Advanced Report:

1. In the Options page, click the Advanced tab.
2. Click Convert Express Report to an Advanced Report.

Report Designer

The Report Designer is the main editor for Advanced Reports. At your fingertips is a full suite of reporting and design
tools with an interface that is familiar and easy to understand.

B [+ 3 7 | cam v =L [ R e
ol [ oo - ==m|[f FB o | [opmrer B
Section A (OrderiD) B {Quamtity) C (UnitPrice) [ (Revenue)
Pagatieader | | |"WWew0 Orders per Customer
age
2
3
Header: 4 stomer ni
Cusiomers p— ' e
— prp——— --\aﬁ;;.g;z :,.q:wrc:|
e m""‘“’”.&:. gt~
Orders.OrderiD

il uant
e ’ I
CusStOMETS

The Advanced Report Designer

Cells

The Report Designer interface is based on cells, like a spreadsheet. Cells can contain text, images, charts, widgets, and
formulas. More importantly, cells can contain multiple rows of data. A cell in a Detail section will expand into as many
rows as are needed to show all the data. A cell in a Group section will repeat for every group. And a cell in a Page
section will repeat for every page on the report.

List of Employees
Davelio
Fuller
Leverling
Peacock
Buchanan
Section A Suyama

Page Header 1 List of Employees E:ngahan

Detail 2 'Employees.La.slName Dodsworth

A Detail cell repeats for every row in the "Employees" data category

All of this is dynamic, meaning that the report will adapt its look based on the data that is returned. For more
information on the different types of report cells, see Sections.

Toolbar

You can add a variety of content and styling to your report. Most of the features can be accessed by clicking the
relevant icon in the toolbar. See Advanced Reports for all of the available features.

Categories

Use the Categories window to select which data to use on the report. The left pane shows the data categories you
can access. To see the fields in a category, select it and click the View Category Fields © icon.

If the report has a custom SQL category then it cannot have any other categories. You can click the SQL = icon to
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edit the SQL statement. See SQL Categories for more information.

What are Data Categories?

Data categories are tables of data, which are organized by rows and columns. Columns are also known as data fields. A
row of data has entries for one or more columns in the category. When you add a data field onto a report you are
seeing the information in one column of data for every row in the category.

For example, a data category for Employees could have columns for the first and last names of each employee, an
identification number, and a home phone number. Each row represents a person, and each column contains a specific
type of information such as last name or phone number.

Employees

LastName FirstName Id HomePhone
Davolio Mancy 1 (206) 555-9857
Fuller Andrew 2 (206) 555-9482
Leverling Janet 3 (206) 555-3412
Peacock Margaret 4 (206) 555-8122
Buchanan Steven 5 (71) 555-4348
Suyama Michael -] (71) 555-7773
King Raobert 7 (71) 535-5598
Callahan Laura ] (206} 555-1189
Dodsworth Anne 9 (71) 555-4444

Example of a data category for employee records

You add entire categories at a time to a report, but in the report view you select only the columns you want to see.
When you add a data field to the report design, even though you only see one column, the rest of the table is still
present behind the scenes. You will never lose the connections between items in each row, and you can always add
more fields.

Cimployeses

Orders :
Products l OrderDetails . l
i LE

Dragging a category to the Category Name pane

Relationships Between Categories

|Note: This information is intended for advanced users.

In the data source, data categories are joined to other categories by associating uniquely identifying data fields from
one category to matching data fields in another. This means that if a row's identifying field matches one or more rows
in a joined category, then those rows connect to an entire row or group of rows, which have their own separate data
fields.

Only joined data categories, which are described as having a relation, can be added to the same report. This is why
some categories may become unavailable as you add others. But data categories, even if they are not related to each
other, may both be related to another category. If you add that category, then you can add both those categories,
because there is now a join path between them.

For more information on how categories are related to each other, see Joins.

Suppressing Duplicates

‘Note: This information is intended for advanced users.

Be judicious when adding data categories. If you find that your report has unexpected duplicate values or empty rows,
the cause is most likely that you have a one-to-many join to a category that you are not using.

For example, this report has Employees and Orders categories. There is a one-to-many join from Employees to Orders,
indicating that each Employee row is joined to one or more Order rows. Even though we are not using Orders on the
report design, there are duplicate Employees because our join setup causes us to have a row for each Order, instead
of each Employee.
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Section

Page Header
Detail

A

1 List of Employees
2 I'Erﬂplo;re-es.LasIName

User Guide

List of Employees
Davelio
Leverling
Leverling
Leverling
Peacock
Peacock
Peacock
Peacock
Buchanan
Buchanan
Suyama

Unexpected duplicate Employee values

There are several ways to eliminate these duplicates. You can suppress duplicates for the Employees category, which
will show blank rows for consecutive duplicates. In the Categories window, select the Suppress Duplicates check

box for the Employees category.

List of Employees

Davolio
Leverling

Peacock

Buchamnan

Suyama

Duplicate-suppressed category

You can also suppress duplicates for the cell, which will hide unnecessary duplicate rows. Select the cell and click the
=- Suppress Duplicates icon. If a field from Orders is on the report, the behavior will be the same as suppressing

duplicates for the category.

List of Employees

Davolio
Fuller
Leverling
Peacock
Buchamnan
Suyama
King
Callahan
Diodswarth

Duplicate-suppressed cell

Or, if you do not think you will need the Orders category, remove it from the report. In the Categories window, click
the * Delete Category icon next to Orders to remove the category. You can always add it again later if needed.

Sorts

Sorting is the process of ordering your data rows by a certain sequence. For each available data category, you can
choose which data field should be used to sort the rows. Fields can be sorted in ascending or descending direction. The
way in which rows are sorted depends on the type of value in the field:

Numeric

Asc =+ Lower values

Date

Asc —* Past Future *+ Desc
Text

Asc * A Z *+ Desc

Employee Name

Steven Buchanan
Laura Callahan
Mancy Davolio
Anne Doedsworth
Andrew Fuller
Robert King
Janet Leverling
Margaret Peacoc
Michael Suyama

Higher values *+ Desc

Department
Client Services
Human Resources
Development
Client Services

Employee Name
Steven Buchanan
Anne Dodsworth
Janet Leverling
Mancy Davolio

Department
Client Services
Client Services
Client Services
Develepment

Executive Robert King Development
Development Andrew Fuller Executive
Client Services Michael Suyama Executive

k  Support Laura Callahan Human Resources
Executive Margaret Peacock  Support
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Sorting a category by Department

A report can have multiple sorts. This can be useful when you want your highest precedence sort to affect a data field
where the values for multiple rows may be the same.

For example, imagine a large company with many employees. There could be multiple people with the last name
Buchanan. With only a sort on LastName, you do not know how all the people with the last name Buchanan will be
ordered amongst themselves. If this matters, then you can add a second sort on, say, the FirstName field, so that
people with the same last names will be ordered by their first names.

Adding Sorts

In the Sorts window, add data fields to sort. The precedence of the sorts starts with the highest row and moves down
the list. Drag the rows up or down to change the precedence.

Productld [
Quantity

Orderld [
L

Dragging a field to the Sort By pane

Relationship Between Sorts and Groups

Sorts are a prerequisite for making groups. Sorting puts data in order so that data rows which share common values for
the sort field are next to each other. This is essentially what grouping does as well. Grouping simply takes those
common values, pulls them out of the rows, and makes sections for each group of rows which share that value. Sorts
tell the report how you want to your data to be grouped.

Department Employee Name

Employee Name Department
Steven Buchanan  Client Services
Anne Doedsworth Client Services

Steven Buchanan
Client Services Anne Dodsworth
Janet Leverling

Janet Leverling Client Services _

) Devel 1 Mancy Davolio
Mancy Davolio Development evelopmen Robert King
Robert King Development And Ful
Andrew Fuller Executive Executive Hr_' rew Fuler
Michael Suyama Executive Michael Suyama
Laura Callahan Human Resources ~ Human Resources Laura Callahan
Margaret Peacock  Support Support Margaret Peacock

Grouping a category by the Department sort

Tip: Set the sort precedence so that nested groups are in order of their grouping level. The outermost group should
have the highest precedence, with the next levels following in order. If the precedence is set incorrectly, it could
result in inconsistent data groups.

Sort Formulas

Note: This information is intended for advanced users.

You can sort by a formula instead of a data field. This allows you to have finer and more specific control over your
groups.

If you do not have a single data field as a unique key, you can use a sort formula to sort on a concatenation of two
fields instead. For example, Employeeld plus TerritoryId fields:

={EmployeeTerritories.Employeeld} & {EmployeeTerritories.TerritoryId}

Or if your sort field would generate too many groups, you can sort on a piece of the field instead. For example, you
could group on only the month and year component of a date field.

=Date (Year ({Employees.HireDate}) ,Month ({Employees.HireDate}), 1)

To add a sort formula, click + Add Formula, then use the Formula Editor to make a composite field to sort on.
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Filters

Sometimes you may only want to see a portion of the rows in a data category, rather than its entirety. Filters allow
you to narrow the scope of your reports by restricting the amount of data by specified criteria.

For example, imagine a category containing a row for every single sale your company has ever made. You can use a
filter to limit the report to only sales from the past month. This also has the benefit of speeding up your reports.

There are three types of filters available in the Filters window:

e Standard
e Group Min/Max
e Top/Bottom

Standard Filters

Standard filters limit data by only showing rows where the values for a field meet a certain condition.

Adding Standard Filters

In the Filters window, add data fields to filter.

uraendad

Quantity [
UnitPrice

Productid

v

Dragging a field to the Filter By pane

For each data field, select a condition. When the report is run, the field value for each row is checked against the
condition for that field. Only the rows where the field satisfies the condition will show on the report.

To create a filter condition:

1. Select an operator from one of the following options. This is the condition used to match the data values to your

specified filter value or values. Some operators are only available for some data types.

The following table describes the filter operators and their applicable data types:

Condition Type Filter Values | Matching Values Not Matching Values
July 4, 2016 July 4
Equal To (=) Any July 4, 2016
July 4, 2016 12:00 AM | July 4, 2016 2:00 PM
Less Than (<) Number, Date/Time |July 4, 2016 |July 3, 2016 July 5, 2016
July 5, 2016
Greater Than (>) | Number, Date/Time | July 4, 2016 July 3, 2016
July 4, 2016 5:00 PM
Starts With Text, Number 203 2035550224 8458081120
Ends With Text, Number 224 2035550224 7188044606
Contains Text, Number 555 2035550224 2038081120
Between Any 1,4 1, 15,3, 4 0.999, 5
One Of Any 1, 2,34 1,2,3, 4 1.1, 9

2. Enter a filter value or values, or select them from the list of existing values. Type into the filter field to search for
data values to filter.

Click the Settings o icon to select whether to search for values that either Start With or Contain the typed
text (v2017.3+).

Equal To 2] -
Lakkalikgr -
Laughing Lumberjack Lager

Lenglife Tofu

Prompt For Value l,\\s

AMND With Next Filter

Group With Next Filter

Choosing a filter value

User Guide
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3. Optional: If you have multiple filters, you can choose how they should be grouped. See Grouping Filters
Together for more information.

4. Optional: If you want the report to prompt the user to enter a filter value when the report is run, select Prompt
For Value. See Prompting for Values below for details.

Prompting for Values

If you want to let users select their own filter values when they run the report, you can set filters to Prompt For
Value. In the Report Options, you can choose whether to let users change the operators and delete filters.

You do not need to enter a value for prompting filters. But if you do, it is entered as the default value for the filter in
the prompt dialog.

Formula Filters

As of v2018.2+, the application supports using formulas in the string of a filter, allowing for much more powerful filter
statements.

As an example using Northwind data catagories, previously filter statements would be limited to statements such as:
{Orders.OrderDate} > 01/01/2015

Where here, only one object in the filter string is being compared to a value, in the following example filter string that
makes use of data objects in a formula could be the following:

{OrderDetails.Quantity}*{OrderDetails.UnitPrice} > 300

Here, the formula {OrderDetails.Quantity}*{OrderDetails.UnitPrice}, which would represent the revenue of the
order, is being compared using a filter condition to a numeric value.

As shown in this example, formula filters allow you to make filtering decisions not just based on data objects, but any
quantity and value that can be created based on your data objects in a formula, including any possibilities enabled by
the formula builder.

Advanced Report Designer

In the Advanced Report designer, formula filters are available in the Filters window of the Report Options. Clicking
the Add Formula 9= button in the lower left will open a Formula Editor window, which will allow for the creation of a
formula to use within the filter.

Report Filters
Standard Top/Bottom Group Min/Max

Select filter fields to include on report

Filter By Title
Employees v
Address I
BirthDate
City
Country

o= Add =f= Add Formula
SUMMARY

Report Filters window in Advanced Report designer with the Add Formula button

Any appropriate custom functions will also be available to use in the Formula Editor window for the formula filter.
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ExpressView designer

In the ExpressView designer, adding a formula filter requires that the formula exist as a column on the report.

User Guide

Note: Any objects needed for a formula in an ExpressView must also exist as their own column on the report as well.

+ % New ExpressView
B Q scoronre = al,
= A # =

Fields + Add Formula

> Categories
» CustomerCustomerDemo
» CustomerDemographics

Customers

W

w

Employees

w

EmployeesCustomFields

w

EmployeeTerritories

OrderDetails

w

» Orders

Add Formula button in the ExpressView designer

Once the formula is created as a column, select the Filters pane and drag the formula column over to the Filters pane
to begin creating a filter on the formula. For more information about building formulas in an ExpressView, see the
Support Site article on Formulas in ExpressViews.

Note: Certain function are available in the Formula Editor that are not compatible with the context of formula filters,
such as CellValue(), FilterValue(), Hyperlink, LoadImage(), PageNumber().

Grouping Filters Together

When a data row is checked against the report filters, the values for each of its data fields are checked against all of
the filters for the data fields. By default, it must satisfy every filter condition to show on the report. The combined
statement used to filter the data rows is shown in the Summary field.

SUMMARY
(Employees HomePhone Starts With 203 Or Employees HomePhone Starts With {203))

-

And (Employees.City = "Shelton’ Or Employees.City = 'Waterbury’)

Example of a combined filter statement

You can specify that a data row needs only to satisfy one filter, or a selection of filters, to show on the report.
To specify that a data row needs to satisfy any one of several filters:

1. On the Filters page, drag the filter rows next to each other.

2. Select the first filter.

3. Select OR With Next Filter.

You should notice that in the Summary field, the And between this filter and the next has changed to Or.
4. Repeat steps 2-3 for every filter except the last.

You can group filters together, to specify that a data row can match either one group of filters, or another group of
filters, to show on the report.

To specify that a data row needs to satisfy any one of several groups of filters:
1. On the Filters page, drag the filter rows such that the filters are nearest to their group mates.
2. Select the first filter in the first group.

3. Select Group With Next Filter.
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You should notice that in the Summary field, there are now parentheses around this filter and the next.
4. Repeat steps 2-3 for every filter except the last in the first group.
5. Select the last filter in the first group.
6. Select OR With Next Filter.

You should notice that in the Summary field, the And between this filter and the next has changed to Or.

7. Repeat steps 2-6 for every group of filters. Skip step 6 for the last filter in the last group.

Nesting Filter Groups

‘Note: This information is intended for advanced users.

Filter groups can be nested arbitrarily. This allows for more detailed control over grouping. The Summary field shows
the actual statement used to filter the data. You can make arbitrary groupings by inserting parentheses manually at
locations in the statement. Use the following keyboard shortcuts:

e Ctrl + [ to add an opening parenthesis before the selected filter

e Ctrl + ] to add a closing parenthesis after the selected filter

e Ctrl + Shift + [ to remove an opening parenthesis from before the selected filter
e Ctrl + Shift + ] to remove a closing parenthesis from after the selected filter

Group Min/Max Filters

When assigning filters to an Advanced Report from the report designer, users have the option of assigning Group
Min/Max filters to the report. Group Min/Max filters will cause the report output to display detail containing either the
highest or lowest values in a field for either one group, multiple groups, or an entire data set.

Note: These operate differently from the Min() and Max() functions, which are used to manipulate specific data fields
as part of formulas.

This tool is especially useful if you are only interested in viewing the highest or lowest values, such as the most recent
hire date or highest revenue figure, in a given set. Group Min/Max filters are compatible with standard filters, and there
is no limit to the number of group filters you may define.

To access Group Min/Max filters, navigate to the filters menu from the Report Designer and click the Group Min/Max
tab in the upper right-hand corner of the menu.

=] Rename
= Description
= (Categories
+ Sorts
Y Filters
& Template
Options 3

Advanced »
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Report Filters

Standard Top/Bottom Group Min/Max
Select filter fields to include on report
Filter By

OrderDetails v % OrderDetails Quantity

Discount

OrderlD

ProductlD

Quantity

UnitPrice Minimurn w | OrderDetails.Quantity

For Each Products

+ Add [ lgnare other groupings on report

SUMMARY

Minimum OrderDetails.Quantity For Each Products

Add button, or double-click the field.
Specify Minimum or Maximum from the operator dropdown.

Use the up () and down () arrows to indicate the filter priority.
e To remove a filter, click the delete button (*).

Applying Group Min/Max Filters

To filter a Data Field’s minimum or maximum value, either drag and drop the field to the Filter By panel, use the

We will explore the several ways of applying this type of filter using the below sample report.

Section A (ProductlD)

Page Header

Header: Orders.EmployeelD

r
Header: Orders.CustomerlD Orders. CustomerlD

Product
Detail 10 "Products. ProductMame

Quantity
"Order Details. Quantity

With no Group Min/Max filtering, this report executes to the following:

B (Quantity)

1
2
3
4
N Fmployees LasiName
]
T
g
9

C (UnitPrice)

Max Sales By Employee and Customer

Unit Price
"Order Details.UnitPrice

User Guide
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Max Sales By Employee and Customer

BERGS
Product Quantity Unit Price
Chef Anton’s Cajun Seasoning 12 52200
Chartreuse verte 20 518.00
Tourtiére G 5745
Chang 21 519.00
Guarana Fantastica G 5450
Mord-Ost Matjeshering 40 52589
BLONP
Product Quantity Unit Price
Chartreuse verte G0 314.40
Mozzarella di Giovanni 20 527.80
BONAP
Product Quantity Unit Price
Paviova 15 517.45
Gorgenzola Teline 3 $12.50
Louisiana Fiery Hot Pepper
Sauce 10 521.05
BONAP
Product Quantity Unit Price
Spegesild 21 512.00
Wimmers gute Semmelknddel 20 53325
BOTTM
Product Quantity Unit Price
Scottish Lengbreads 42 $12.50
BSBEV
Product Quantity Unit Price
Aniseed Syrup 30 53.00
Wimmers gute Semmelknddel 9 526.60

User Guide

‘ Note: The following features are available only in v2016.2+.

Ignoring Other Groupings

To apply the filter to one group only, select a group from the dropdown menu and check the Ignore other groupings
on report checkbox.

To best utilize this option, it is important to understand the difference between an inner group and an outer group. In
the report designer, the topmost group (in this case, Orders.EmployeelD) is the outermost group and has first priority.
The second group (in this case, Orders.CustomerID) is within the first and has second priority. Each subsequent group
is nested into the previous one and grouped after the others.

If applying a Group Min/Max filter to an outer group, then checking the Ignore other groupings checkbox has no effect
on the report output because the outermost group takes precedence anyway. If applying a Group Min/Max filter to an
inner group, however, the button takes effect.

In our example, both Buchanan and King have sold to customer BONAP. If we apply a maximum filter on order quantity
for each Customer ID and leave the Ignore other groupings checkbox unchecked, the output shows the detail
containing each customer's max quantity sale per employee.
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Max Sales By Employee and Customer

Buchanan
BERGS

Product
Mord-Ost Matjeshering
BLONP

Product
Chartreuse verte
BONAP

Product
Paviova

Quantity
40

Quantity
B0

Quantity
15

Unit Price
525.89

Unit Price
514.40

Unit Price
817.45

BONAP

Product
Spegesild
BOTTM

Product
Scottish Longbreads
BSBEV

Product
Aniseed Syrup

Quantity
21

Quantity
42

Quantity
30

Unit Price
g12.00

Unit Price
$12.50

Unit Price
58.00

Checking the Ignore other groupings checkbox, however, returns the customer's max quantity sale for the whole

report, ignoring the grouping on Employee.

Max Sales By Employee and Customer

Buchanan

BERGS

Product

Mord-Cst Matjeshering

BLONP

Product
Chartreuse verte

Quantity
40

Quantity
B0

Unit Price
525.89

Unit Price
514.40

BOMNAP

Product
Spegesild

BOTTM

Product
Scottish Longbreads

BSBEV

Product
Aniseed Syrup

Quantity
21

Quantity
42

Quantity
30

Unit Price
512.00

Unit Price
512.50

Unit Price
58.00

Due to the fact that BONAP's order of Spegesild from King is greater than its order of Pavolova from Buchanan, BONAP
appears only once on the report. If BONAP had ordered the same quantity from both Buchanan and King, it would
appear under both names, even with the Ignore other groupings checkbox checked.
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Filtering the Entire Data Set

Selecting Entire Data Set from the group dropdown menu will disable the Ignore other groupings option and return
the records containing the single maximum value for the selected field in the entire report.

For Each [Entire Data Set |

In our example, selecting this option displays only BLONP's order from Buchanan because its quantity is the highest in
the set.

Max Sales By Employee and Customer

BLONP

Product CQuantity Unit Price
Chartreuse verte 50 314.40

Top/Bottom Filters

As of v2017.1+, you can add Top/Bottom filters, also known as Top N filters, to a report. Top N filters allow you to
filter data to only the rows with the top or bottom values, for either data fields or data summaries, per group iteration.

To show only the top or bottom values, for either data fields or data summaries:
1. On the Filters page, click the Top/Bottom tab.
2. Select the Limit the report to the top or bottom values of a data set checkbox.
3. Select either Top or Bottom, for whether you want to show the top or bottom values.
4. Enter a number for how many values you want to show.
5. Choose how you want to limit your data:

o If you want to show the rows with the top or bottom data values for a field or group, select Values from
the list.

o If you want to show the groups with the top or bottom summary values for a parent group or the report,
select one of the summary calculations, Sum, Avg, Min, Max, Count, or Distinct Count, from the list.

Note: Only numeric data fields support Sum and Avg calculations.
6. Select the data field or group field to filter from the Of list.

7. Optional: To show the top or bottom values for each iteration of a group:

1. Click +Add Group.

2. Select a group field from the For Each list.

Report Options

The following options are available in the General Options window:

General Options
e Allow Execution in Viewer: Allow or prevent the report from being run in the Report Viewer.

e Include Setup Info: Select Top or Bottom to display the data categories, sorts, and filters at either the
beginning or end of the report.

o Allowed Export Types: Enable or disable output types for the report.
o Default Export Type: Specify the default output type for the report.

o Report Tree Shortcut: Specify whether the Run icon for the report in the report tree runs the report in the
Report Viewer or exports it in the default output type.
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¢ Filter Execution Window: Select which type of Filter menu displays when running the report with prompting
filters:

o Default — Display the default type of filter execution window.
o Standard - Display the standard filter execution window.

o Simple with Operator - Display a simplified filter execution window that only allows the operator and value
to be changed.

o Simple without Operator - Display a simplified filter window that only allows the filter value to be changed.

e Always Show Filters in Report Viewer: Show the filter menu and allow changes to be made every time the
report is run.

o No Data Qualify Display Mode: Select what to display if no data qualifies for the report.
o Show Message - Display the standard no data qualified message.

o Show Report - Display the Page Header, Page Footer, Report Header, and Report Footer sections of the
report. Any cells containing Data Fields will not be displayed.

Excel Options
o Suppress Formatting: Export only the report data to Excel, without the formatting.
e Show Grid: Show grid lines between cells in Excel output.

o Freeze Rows: Freeze the top number of rows when exporting to Excel, so that the rows stay anchored to the
screen when scrolling through the report.

o Freeze Columns: Freeze the left number of columns when exporting to Excel, so that the columns stay
anchored to the screen when scrolling through the report.

Page Options
e Page Size: Select the page size of the report output. The following page sizes are available:
Letter, Legal, Executive, Ledger, Tabloid, A0O-5, BO-5
o Page Orientation: Specify whether the report runs in Portrait or Landscape orientation.

o Fit to Page Width: Fit the width of the report to the width of the page.

Report Viewer Options

The following options are available in the Report Viewer Options window:

General
e Show Grid: Show or hide grid lines.
o Simulate PDF: Have the report appear as if it was on a page.

e Allow Hide/Show Columns in Report Viewer: Enable or disable the ability to hide columns.

Note: Setting the Enable Paging in Report Viewer setting in the Admin Console to False restricts the
interactive HTML hide/show column option.

e Show Toolbar in Report Viewer: Select whether to show or hide the interactive toolbar in the Report Viewer.

e Report Row Step Limit: Override the default step size for incremental loading (with a smaller value). This option
is only available if incremental loading is enabled in your environment.

Filters

To allow users to select interactive filters in the Report Viewer, add data fields as filters. For each filter you can select
the following options:

e Title: Enter text to appear in place of the data field name.
o Type: Specify the type of ability the user has to choose filter values:

o Single Choice - A drop down menu with all possible filter values. Users can choose one value.
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o Multiple Choice - A check list with all possible filter values. Users can choose multiple values.
o Single Slider - Users can choose one value by sliding a point along a scale.
o Range Slider - Users can choose multiple values between two points on a scale.

e Value Sort Direction: Whether the filter values should display in ascending or descending order.

¢ Filter Value Format: Select how the filter values should display.

o Initially Display Filter on Panel: Display the filter choice automatically when the report is run.

Sorts

Display Sorts in Report Viewer: Select whether the user can see and modify sorts in the Report Viewer.

In the Title column, you can enter text to appear in place of the data field names.

Templates

You can use reports to dynamically fill out fields in templates and forms.

Form w-g

(Rev. Decembear 2011) I
Department of the Treasury
Internal Revenue Senice

MName (as shown on your income tax retu

MNancy Davolio
Business namefdisregarded entity name

Check appropriate box for federal tax cls
[ individualiscle proprietor ] ©

Section A

Mancy Davolio § o
507 - 20th Ave E. Apt 24 5 D Limited liability company. Enter the
Seattle. 88122 €

&

] Other (see instructions) =
Address (number, street, and apt. or suit

Andrew Fuller
1 ={Employees FirstName]}&' '& 908 W. Capital Way

See Specific Instructions on page 2.

{Employees L asiName} Tacama, 83401
Detail 2 "Employees Address Janet Levering 5‘?? - 20th Ave. E. Apt. 2A
. City, state, and ZIF code
5 =[Employees Cily}&' '& 722 Moss Bay Blvd.
{Employees. PostalCodel Seattle, 98122

Template report with repeating data fills a set of form templates

To use a report to fill out a template:
1. Enter field data in cells on the report. For repeating data:
o Repeating cells mapped to static template fields make a new instance of the template for each repeat.

o Repeating cells mapped to limited-repeating template fields make a new instance of the template each time
the number of values exceeds the limit.

Note: This is often undesirable. Ensure that there are appropriate constraints on your data and enough fields to
fit it all.

o Repeating cells mapped to unlimited-repeating template fields never make a new instance of the template.
Overflowing data is cut off.

2. Fromthe & Report Options > U Template window, select an existing template or click the Upload Template t
icon and add a new one.

3. For each template field:
o Select a report cell containing text or data. Images, visualizations, and other widgets are not supported.
o Leave it blank. Any bookmarked text shows as-is in the output.

o Select whether or not to allow editing of that field in the exported PDF file using the Allow Edit checkbox.
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Report Templates

Select a template from the list below, or upload a new one

Order History.pdf v ar

Template Field Report Field Allow Edit =
CategoryMame Detail: Categories. CategoryMame v b
OrderDate Detail: Orders. OrderDate v
OrderlD Detail: Orders.OrderlD v
ProductMame Detail: Products ProductName v I
UnitPrice Detail: OrderDetails.UnitPrice v

m Caﬂcgl‘

Editing of fields in exported PDF templates
1. Click OK.
To remove a template from a report:
1. From the Template window, select the blank option from the template list.

2. Click OK.

Tip: Template reports must be exported in the same file type as the template. You may want to limit the export types
to only that type using the 104 Report Options > General Options window.

Making Templates

The process for making templates differs between the three supported types: PDF, Word, and Excel; as do the
available features.

|Caution: Close the template file before running or saving a report that uses it, or you may get an error.

PDF Templates

PDF templates support static fields and limited-repeating fields. PDFs are convenient for preexisting and standardized
forms, such as for government or businesses.

To make a PDF template:
1. Open a PDF in a PDF editor program, such as Adobe Acrobat or PDFescape.

2. Add form fields where you will insert report data. For fields where text may span multiple lines, select the multi-
line property.

3. Give each form field a unique name, as follows:

o For static fields, which appear only once per template instance, use any name, with the exception of the
format reserved for repeating fields.

o For repeating fields, which are mapped to consecutive values in a repeating cell, use the following naming
format:

Name.0, Name.l,...

Where Name is shared by the repeating fields, and 0 maps to the first value, 1 maps to the next value, and
so on.

4. Save the PDF. Then upload it to the report.

Microsoft Word Templates

Word templates support static fields, limited and unlimited-repeating fields, and conditional suppression.

Tip: Supported file types are .doc, .docx, and .rtf. Report templates exported as "RTF" will save to the original file
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To make a Word template:
1. Open a document in Microsoft Word or a compatible document editor.
2. Add text where you want to insert report data.

3. Select the text—or in the case of repeating fields, a region of text—and insert a bookmark.

Employee Information

Personal Information

Full Name: [LastNamg [FirstNamg
Last First

Address: [Addresg
Streef Address

[City [Region] [PostalCodg

City State ZIP Code

. Sales
L
| OrderD [ [OrderDatd [[ProductNamd [ [Quanitity [ [UnitPricg [[Revenud |
]

Bookmarks in Word display as grey brackets surrounding text
4. Give each bookmark a unique name, as follows:

o For static fields, which appear only once per template instance, use any name, with the exception of the
formats reserved for repeating and conditional fields.

o For limited-repeating fields, which are mapped to consecutive values in a repeating cell, use the following
naming format:

FieldName 0, FieldName 1,

Where Name is shared by the repeating fields, and 0 maps to the first value, 1 maps to the next value, and
So on.

o For unlimited-repeating fields, which are mapped to all the values in a repeating cell, use the following
naming format:

RepeatForEach FieldName

Where FieldName is a unique name. A RepeatForEach section in templating follows similar structure and
purpose to grouping within Exago. It is used to organize information under repeating groups within
templates, arranging related information on the same page and separating groups with page breaks.

Bookmark ? *

Eookmark name:
RepeatForEach_OrderlD Add
City ~
Firsthame Delete
LastName

OrderlD —
PastalCade

ProductName
Cuantity

Region
RepeatForEach QOrderlD

Revenue
UnitPrice v

Sort by: (@) Name
OI_.ocation

[] Hidden bookmarks

Cancel

Important: Bookmark formatting for unlimited-repeating fields must follow specific spacing requirements. The
opening bookmark bracket should be placed one line before the repeating field section begins, and the closing
bookmark bracket should be placed one line after the repeating field sections ends. Please refer to the
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Employee Information example above for a visual reference. If this formatting is not followed, an "itemStart and
itemEnd must be contained in one text body" error may be thrown.

5. Optional: To conditionally show or hide text:

1. Select the text and add a bookmark with the following naming format:

KeepIF FieldName

Where FieldName is a unique name.

. In the report, map this field to a cell with a formula that returns 1 if the text should be shown, and 0 if the

text should be hidden.

Example: =If ({Products.ProductName} = "Chai", 1, 0)

6. Save and close the file. Then upload it to the report.

Microsoft Excel Templates

Excel templates work differently than other types. Templates are used to fill Excel columns with report data. This is
useful for passing data to Excel charts, pivot tables, and macros.

To make an Excel template:

1.

2.

Open an Excel file in Microsoft Excel or a compatible spreadsheet editor.

The first worksheet is used for dynamic report data. Repeating cells are mapped to columns in the worksheet. For
each column where you will add report data, enter a unique name to the topmost cell in the column. All following
cells must be empty.

A E =
1 |OrderID Quantity Total

Formatting an Excel file to be used as a template

3. Save the file. Then upload it to the report.

Joins

‘Caution: The Joins window is recommended for advanced users only.

Joins describe how the categories on a report are related to each other. When two categories are joined, a field in the
first category is associated with a field in the second category. Wherever a value in the first category's field matches a
value in the second category's field, that value's rows from each category come together to form a composite row. The
table produced by all the composite rows is the resulting data that appears on the report.

For example, take the following categories, Orders and Products. The Orders.Productld field corresponds with the
Products.Id field. When the categories are joined from Orders.Productld to Products.Id, the rows are connected
wherever those two fields have matching values.

Crders Products
Crders Id Crders Productld Products.1d Products. Productlame
16702 iﬁ} — 12 Blanton's Original
16703 (3) — 3 Henry McKenna
16704 I‘I*:II 14 Russell's Reserve
16705 Af—0 N | Hillrock Estate
16706 as——— | 115 Buffalo Trace

Categories joined on Orders.ProductId >> Products.Id

The result of this join is the following composite rows. These categories have a one-to-one relationship, because each
row in the "left" category joins at most one row in the "right" category.

Crders.Id Crders Productid Preducts. PreductName
16702 13 Henry McKenna

16703 13 Henry McKenna

16704 14 Russell's Reserve
16705 16 Buffalo Trace

16706 15 Hillrock Estate
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Joined categories. Products.Id is omitted.

Tip: Categories could be joined along more than one set of fields; composite rows are formed only when all sets have
matching values.

For two categories to be co-present on a report, there must be a join path between them. They are either directly
joined, or there is a path through one or more intermediate categories. You do not have to configure joins manually as
they already exist in the environment. However, if you want to learn how to add or adjust joins on a per-report basis,
the following sections explain the options that are available.

Join Types

The join that was previously described is the most common type of join, an inner join. When an inner join is applied,
rows in either category that have no matching row in the other are excluded from the resulting table. However, you
may not want to exclude these rows. To do so, you can change the type of join to an outer join.

For example, the row in the Products category with Products.Id = 12 has no matching row in the Orders category. With
an inner join, this row is excluded from the output. If you want to see the Products rows that have no matching Orders
row, you can change the join type.

To do so, from the 104 Report Options > “** Advanced > -~ Joins window, select the Products data that does not
have Orders data checkbox.

In addition to Orders data that has matching Products data, include;
Orders data that does not have Products data
¥| Products data that does not have Orders data

This changes the join between these categories to a left outer join, because all rows from the /eft category are
included. The following rows result:

Crders.Id Crders Productid Preducts. PreductName
Blanton's Original

16702 13 Henry McKenna

16703 13 Henry McKenna

16704 14 Russell's Reserve

16705 16 Buffalo Trace

16708 15 Hillrock Estate

Joined categories with all Products rows. Products.Id is omitted.

Similarly, selecting the Orders data that does not have Products data checkbox changes the join to a right outer join,
which includes all rows from the right category. Selecting both checkboxes includes all rows from both categories; this
is a full outer join.

Relationship Types
There are two types of join relationships: one-to-one and one-to-many.

In the previous example, the relationship between the categories is one-to-one, because each row in the left category
joins at most one row in the right category. Some categories have a one-to-many relationship, where each row in the
left category joins zero or more rows in the right category.

A one-to-many relationship from categories X to Y is represented in the following diagram:

One 1-to-Many
X ¥

= e e e e e

Each X is joined to one or more Y

Reports with a single one-to-many join are well suited to grouping by the left category. The data in these reports is
generally well-formed and understandable.

However, when a report has multiple categories with one-to-many joins, data can appear more disorganized and
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confusing. For example, the following diagram represents data from three categories, X, Y, and Z, where the
relationships between X to Y and X to Z are both one-to-many:

Two 1-to-Many
X ¥ z
¥ z
z
z
¥
G z
¥ z
z
z
¥
X ¥
¥ z
¥

¥
Each X has 1 or more Y, and 1 or more Z

Because Y and Z are not directly related to each other, there are many rows with only Y or only Z. This can cause the
report to be significantly larger, and to be difficult to read and interpret. This occurs even with inner joins, the most
restrictive type, because by default there is no logic that deals with the relationship between Y and Z.

Read on for different ways of improving the structure of a report with multiple one-to-many joins.

Cartesian Processing

You could fill the blank spaces with supplementary data by disabling Special Cartesian Processing from the Joins
window. Blank cells are filled in with data that is repeated directly from the previous row. The following diagram
demonstrates how this works:

Two 1-to-Many, No Cartesian
z

X

3

L L L
LS I I T I SR S I S I R

Disabling Special Cartesian Processing

The shaded cells represent data that has been repeated from the previous row. This can make the report more
readable. However, this approach poses a problem: Blank cells indicate a lack of a relationship between two fields, so
filling in these spaces with artificial data can obfuscate any relationship between Y and Z. This can decrease the
accuracy of the report.

There are better ways to improve the readability of such a report without sacrificing accuracy:

e Use repeating groups to show the X to Y and X to Z relationships in entirely separate sections. This is suitable if
any relationship between Y and Z is irrelevant or nonexistent. See Sections for more information.

e Hide some or all of the rows which do not have data for both Y and Z. This is suitable if you want to highlight an
implicit or indirect relationship between Y and Z.

Modifying Joins

The Joins window shows all direct and implicit joins on the report. Direct joins can be added, modified, or removed from
the report.

To add a new join:

User Guide
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1. Select From and To categories.
2. Click # Add.

3. Click * Add Condition then select From (left column) and To (right column) fields.

Tip: If there are multiple conditions, only the rows that satisfy all the conditions are joined.

4. Click Okay.
To remove conditions, click the Delete * icon next to the condition to delete.
To modify a join's fields:
1. Click the Edit [/ icon next to the join to edit.
2. Add, remove, or modify conditions.
3. Click Okay.
To remove a join, click the Delete * icon next to the join to delete, then click Okay.

To restore the default joins, click c Recreate, then click Okay.

Advanced Joins

You may be able to specify join conditions that are more complex than column equality.

’Note: Advanced Joins cannot be applied across different data sources.

Type

Instead of joining between two columns, one or both sides of the join may instead be an arbitrary expression, constant,
or SQL sub-query that you specify.

To change the expression type for one side of a join condition, select one of the following from the Type list:
e Value: One or more constant values separated by commas
o Expression: Formula or calculation
e SubQuery: SQL query

Then enter the value in the Value field.

Operator

As opposed to the default equality (=) operator, which joins fields from the left expression to matching fields from the
right expression, a join condition can use one of several alternative operators instead. For example, the inequality (!=)
operator joins fields on the left to non-matching fields on the right. To do so, select one of the alternative

operators from the Operator list:

e !'= | not equal

°« > | greater than

e >= | greater than or equal

e < | less than

e <= | less than or equal

e IN | match one or more values, either specified or calculated from a subquery
Grouping

When a join has two or more conditions, you can specify how the conditions should be met as a group in order for the
join to take effect.

To specify that either one of two conditions will satisfy part of the clause, select OR from the Conjunction list for the
first condition of the two.
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To add parentheses around two conditions, select the Group checkbox for the first condition of the two.

You can preview the full join clause in the Summary field.

Cell Formatting

The cell formatting menu allows you to customize how data values will show, add custom borders, and add formatting
that will only show if a condition is met.

Number

If a cell has a numeric, date, or time value, then you can use Number formatting to choose how the value should
appear on the report. For example, you could add a dollar sign ($) to monetary values and separate each three digits to
make values easier to read.

52,770,955.00
$3.685.471.00
$1.145,701.00

Numeric values with currency styled formatting

The following options for Number formatting are available:

General

Format the data using the default settings for your environment. This is the default option. The application will assume
the data type based on the value.

Number
Format the data as a number, currency, or percentage.
Optional: Choose how the number displays:

o In the Decimal Places field, enter a number for how many decimal places to display. Then, in the field to the
right, enter a symbol to use as the decimal mark.

e To show a delimiter every three digits, select Use 1000 Separator. Then, in the field to the right, enter a symbol
to use as the delimiter.

e To show a currency symbol before the number, select Use Currency Symbol. Then, in the field to the right, enter
the symbol to show.

e To show a percent sign (%) after the number, select Append Percent Sign.

e To show no value if the number is 0, select Blank When Zero.

e To show a minus sign (-) in front of negative numbers, select Show Negative Symbol.
e To show parentheses ( ) around negative numbers, select Show Parenthesis.

e To show negative numbers in a different color, enter a color code in the Color field or use the color picker to
choose a color.

Date

Format the data as a date, time, or date and time.

Optional: Choose which date and time components to display, and how to show them. Either select one of the patterns
from the Date/Time Format list, or enter a custom pattern using the following variables:

Variable | Description "Sept-2-1907 5:08:04 PM"

d dav of the month. from 1 to 31 2
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dd day of the month, from 01 to 31 02
ddd day of the week, abbreviated name Mon
dddd day of the week, full name Monday
M month, from 1 to 12 9
MM month, from 01 to 12 09
MMM month, abbreviated name Sept
MMMM month, full name September
y year of the century, from 0 to 99 7

vy year of the century, from 00 to 99 07
YYYY year, from 0001 to 9999 1907
h hour using a 12 hour clock, from1to 12 |5

hh hour using a 12 hour clock, from 01 to 12 | 05

H hour using a 24 hour clock, from0 to 23 |17
HH hour using a 24 hour clock, from 00 to 23|17
m minute, from 0 to 59 8
mm minute, from 00 to 59 08

s second, from 0 to 59 4

Ss second, from 00 to 59 04

t A/P P

tt AM/PM PM
Text

Do not apply any formatting to the data, and show it exactly as it appears in the database.

Border

Alter the width and color of the cell borders. To set a color for a cell border, enter a color code or select a color from
the picker. To set the width of the border, enter a pixel value, or use the arrows to make the border thicker or thinner.

To set all the cell borders to the same color and width, select Make Borders Uniform.

Tip: If gridlines are enabled for the Report Viewer, then cell borders will show in addition to the gridlines.

#3688A3
i c
| E EEEEE
HE "EEEEEEEE
_ EEEEEEEEEEEE
#3688A3 il EEEEEEEEEEEN
i c
EEEEEEE

Choosing border colors and widths

Conditional

A conditional format allows you to format a cell according to its output data. The cell and text styles can depend on its
data value, and you can even conditionally hide rows or entire sections. This can be useful for highlighting certain
values in a data set, such as outliers from a trend.

Conditional formatting uses a formula to set the condition. The formula must evaluate to True or False. If True, the
formatting will be applied, and otherwise it will not. Conditional formulas are often based on data in the cell, but they
can also be based on other cells, data fields, or other information about the report.
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Formula Cellvalue() < l@eesa
Example of a formula that evaluates to True or False
To set or modify the format of a cell based on a conditional formula:
1. Click ¥ Add to create a new condition.
2. From the Action list, select an action to occur if the condition is met.
Optional: If applicable, select an attribute for the action from the Attribute list.

£

3. Click the formula /* icon and enter a formula for the condition. The formula must evaluate to True or False.

To use the value of the current cell in the formula, use the function CellValue (). Click + Cell Value to insert
CellValue () into the formula.

A cell can have multiple conditional formats, each of which is a separate row in the Conditional page. If two or more
overlap, the lower condition takes precedence. Click the Move Row Up “* and Move Row Down * icons to reorder
the precedence of the conditions.

NMumber Border Conditional
Action Attribute
Foreground Color #FF0O000 ! fr A %

Fareground Color #0000FF fr AW X

Bold

A cell with multiple conditional formats

Sections

The sections of an Advance Report define the appearance and pattern of the report. Specifically, sections determine
how frequently their cell contents are repeated.

The appearance of a report is based on data that is not necessarily known at the time it is made. The data, and the
relationships it describes, are dynamic and mutable. So tabular reports are usually not fixed designs. Instead, you are
essentially describing how the report structures itself around a set of unpredictable data. Knowing which sections are
suitable for different types of content is crucial for designing the best possible report.

Types of Sections
There are two general types of sections: Static and Dynamic. The difference is in the repetition of their cells.

The cells in a dynamic section repeat according to the data that is returned to the report. Dynamic sections are
suitable for showing content related to that data. For example, cells in a Detail section repeat for every composite data
row in the report. Therefore, it is most suitable for data fields, of which you will want to see each entry per row.

The cells in a static section do not repeat according to the report data. Static sections are best used for information
that is not related to data rows. For example, you could use a Page Header to define column headers that describe the
type of data in each field.

See the following topics, Static and Dynamic, for more information.

Manipulating Sections

A report can contain any variety of sections. To add, remove, or change sections, click a section title, to the left of
the row numbers in the report grid.
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Section A B
Page Header 1 Inventory Report

Header: Products 2 Product "Products. Preductiame
ﬂeﬂd&r: Categories 3 I'Cahegories ld I'Categories.Descri plicn

= Add Section ’ D Page Header

¥ Delete Section Report Header

[# Modify Section Detail

~

Mave Section Up Repart Footer

<

Mave Section Down Page Footer

&¥

Group Header

Section Shading

Group Foaoter

m ] O 0 I m

Repeating Group
The section menu

To add a section, hover over + Add Section, then choose the section to add. If you add a group section, choose
which data category or field to group by.

To change the category or field for an existing group section, click U Modify Section.
To change the order of sections, click “* Move Section Up or ¥ Move Section Down.
To delete a section, click * Delete Section. This will delete every row in the section.

To add alternating background colors for each row in a section, click " section Shading. See Section Shading for
details.

Static Sections

Sections categorized as static do not repeat according to the data in the report; although they may repeat by other
means. These sections are best used for information about the report and about the data in the report. They can also
be useful for boilerplate elements, such as logos or disclaimers.

A typical report may have a report header with the title of the report, a page header with labels for each column, a

page footer that uses the PageNumber() function to number the pages, and a report footer with summary
information.

Page Header/Footer

Position of page sections

Page sections repeat for each page. Page breaks are usually caused when the data in dynamic sections overflows the
length of a page. The length of pages is determined by the Page Size and Orientation lists in the Report General
Options window. The data on each page is consistent between the paged output types.

You can add page breaks manually by clicking the row number to add a break, then selecting ~ Page Break from the
menu. Page breaks added for a row in a dynamic section will make a new page every time the data changes.

Tip: Excel and CSV output types have no pages. Page sections function the same as Report sections for these output
types.

Use these sections for information to repeat on every page, such as the title of the report, column headers, and
company logos. You can also use the PageNumber() function to number each page of the report.

User Guide
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Even though page sections repeat, they are not considered dynamic sections because their repetition does not directly
depend on the data. Thus they are not suitable for displaying data fields. Since there is no way of knowing ahead of
time which data will appear on which page, these sections are not suitable for summarizing data with aggregates or
visualizations.

Report Header/Footer

Position of Report Header and Footer sections
Report header and footer sections appear once each. Use these sections for introductory and concluding information.

The report footer is where you would summarize all of the report data with aggregate formulas and visualizations.

Dynamic

Sections categorized as dynamic repeat according to the data in the report. These sections are best used for
displaying and grouping data from data fields. Dynamic sections comprise the bulk of most tabular reports. Charts,
maps, and gauges must reference data fields in dynamic sections.

The key for knowing how to use dynamic sections is knowing how the data will repeat in relation to the rest of the
report.

Detail

Position of Detail section

The rows in the Detail section repeat for each data row retrieved from the database. By default, there are exactly
enough Detail rows to show all the data fields in all the categories on the report.

Detail sections are typically used for showing the actual data values. This is the main area of display for the bare report
data. Aggregate formulas usually reference cells in the Detail section.

You can use duplicate suppression to limit the number of rows to only visible data fields. You can also use report
filters to limit the rows by certain criteria.

Users with advanced knowledge of the data relationships can also use advanced join logic to limit the Detail rows to
only the relevant relationships.

Group Header/Footer
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Position of Group sections

Group sections are the primary way in which data is grouped into "buckets" that each share a unique attribute. Detail
rows are arranged into the groups they belong to. The common attribute is defined by a preexisting sort. In order to
make a group, first add a sort in the Sort window.

For example, if you wanted to group a set of rows by each Product, first add a sort on the Products.ProductName field.

Report Sorts x

Sort By Sort Order
% Products.ProductName f\- Ascending v A W X

A sort is required for a group

The main difference between the header and footer is that the data comes after the header, but before the footer.

This means that you can only use aggregate formulas in the group footer, since the header is not aware of the data in
its group.

When you add a group section, you are asked which sort to base the group on. For each sort, you can choose to group
on either the sort field or the sort category.

e If you group on a field, the group breaks at each new value of the field.

e If you group on a category, the group breaks at each new instance of the category's unique identifier.

Group Header *

Show this group for each change of the following:

Data Categories

Sort Fields u

Products. ProductName

The group window appears when adding a group section

For example, instead of grouping by each Product, you may want to instead group by product quantity, so that
products that are low or out of stock are grouped together. First add a sort on the Products.Quantity field, then group
by that field.

You can have multiple group sections, if you wanted to add additional levels of stratification to the report. Each group
requires a corresponding sort.

Tip: The order of the sorts has an effect on the way the data is arranged. Data is sorted by the first field, then any
ambiguities are sorted by the second field, then any remaining ambiguities are sorted by the third, and so on. In
general, you should order group headers by their associated sorts, and group footers in inverse order.

Repeating Group
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Position of Repeating Group sections

Repeating groups are a way to organize and display data that contain multiple one-to-many relationships. Each
repeating group has data from a "many" category, grouped by the "one" category. The following diagrams demonstrate
how this works.

Two categories, X and Y, with a one-to-many relationship from X to Y, will display like so in a Detail section.

User Guide

Tip: Category X has duplicates suppressed - this is similar to grouping on X.

One 1-to-Many
X ¥

oo e e e w2

Each X has 1 or more Y

If there is a third category, Z, with a one-to-many relationship from X to Z, there is not necessarily a relationship
between Y and Z. So there may be blank rows with only Y or only Z.

Twa 1-to-Many
G ¥ z
¥ z
z
z
¥
X z
¥ z
z
z
¥
X ¥
¥ z
¥

¥
Each X has 1 or more Y, and 1 or more Z

There are two potential solutions. If there is a relationship between Y and Z, then you can use Advanced Joins to
impose additional constraints so that only the rows with both Y and Z are shown. For more information, see Joins.

On the other hand, there may be no relationship between Y and Z, only between X and Y, X and Z. Or there may be a
relationship, but it does not matter for this data set. You can use repeating groups to ignore that relationship and
simply organize the data by X instead.

To do so, create two repeating groups for X, and put Y in the first, and Z in the second:

Repeat group for each: X

Detail 1 Y.Field1
Repeat group for each: X
Detail 2 Z.Field1

Organizing Y and Z into repeating groups for X
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Repeating Group
X ¥

LR R T T T o A o T o B o R o I

Each X repeats twice: once for Y, once for Z

Each repeating group section has its own group header, detail, and group footer. These follow the same principles as
their general purpose equivalents, but within the repeating groups. For example, to calculate aggregate data for Y for
each X, use an aggregate formula in the footer for the repeating group with the Y data.

Reprinting Group Headers

As of v2018.2+, you have the option to reprint Group Header rows at the top of the page if the detail section of any
given group spans multiple pages. This option is only available on Group and Repeating Group Header sections. To
reprint a Group Header row when its detail section continues onto another page, click the row number in the Report
Designer and select Repeat Row. If the Header has been set to repeat, two blue lines will display next to the row
number.

Repeat group for each
Header " £ ==
Detail £ ¥ Insert Rows Before
Footer £

+ Insert Rows After

X Delete Rows

Set Auto Height

Row Height_

Suppress Rows
Collapse Rows
Repeat Row

Page Break

Section Shading

Section shading allows you to specify alternating background colors for repeating elements in a section. Alternating
colors applies to Detail and Group sections; for other sections, only one color can be used.

To add section shading:
1. Click a section title to open a menu for that section. Select 7/ section Shading.
2. Click # New to add a new shading color.
3. For each shading color, select a color with the color picker, or enter a color code.
4. Use the up “* and down ™ arrow icons to rearrange the order of the colors.

5. Click Okay.
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Section
Detail 1 'Emplo:.'ee
o Add Section *

X Delete Section

Section Shading

Alternate Shading Color

#FFF1ED AWOX
#EOFFEO AW OX
+New

T I

Davelio
Fuller
Leverling
Peacock
Buchanan
Suyama
King
Callahan
Dodsworth

Adding two alternating background colors to a Detail section

User Guide

|Tip: Section shading is overridden by the cell background color and by conditional formatting.

Using the Toolbar
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The toolbar contains the buttons and menus used to modify the report. Modifications can include aesthetic formatting,
inserting formulas and images, linking reports, and much more.
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The toolbar begins with a dropdown menu. This menu controls changes, such as renaming and filtering, that affect the
entire report. All other buttons on the toolbar require that a cell (or cells) in the design grid be selected.

ﬁ\'

=] Rename

Description
= (Categories
+ Sorts

Y Filters
Template
Options 3

Advanced »

Saving Reports

The report can be saved by clicking the save R button. The report will also be saved anytime it is executed.

Undo/Redo

Any action on a report can be undone by clicking ¥ or pressing CTRL + Z. Undone actions can be redone by clicking ™
or pressing CTRL + Y.

Font & Alignment Options

The text of each cell can be formatted using dropdown menus and buttons in the toolbar. A cell or multiple cells must
be selected for these tools to be used.

3 ¢ | Anal A
B T U~-AS%|8

Font

e To change the font, use the searchable dropdown menu. The font names appear in the style that they represent.
e The buttons B, I and U make the font bold, italicized, and underlined, respectively.
e Text size can be controlled using the up and down arrows on font size menu.

Color

e To change the text color, click the foreground color £ button and then select a color or enter a hex value into
the foreground box. Click the clear ~ button to revert to the default color.

e To change the background color, click the background % color button and then select a color or enter a hex
value into the background box. Click the clear " button to revert to the default color.

5
A=

]
R T
T ]
O
EEEEEEEEEE

Alignment

e Text can be aligned to the top, center, or bottom of a cell using the vertical alignment buttons.
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e Text can be centered, justified, or aligned to the left or right of a cell using the horizontal alignment buttons.

e The wrap text =# button will begin a new line if the text is longer than the width of the cell.

Formatting Cells

Cells can be formatted in the Cell Format Window. To open the window, click the format cell [ button. The window
has three tabs: Number, Border, and Conditional.

Note: Cell formatting can be copied using the Format Paintbrush. Select the format you want to copy, click the
format paintbrush rd button, then click the cell you want to apply the formatting to.

Number
The Number tab allows you to set the format of numbers and dates.

o General:
o General formatting automatically applies formatting to cell values.
e Number:
o Using the arrows, you can specify how many decimals to display. You can also set the symbol to separate
decimals from whole numbers.
o Check the box ‘Use 1000 Separator’ to separate every 3 digits. You can set which symbol is used to
separate digits.
o Check ‘Use Currency Symbols’ to have the currency sign appear in front of the number.
o Check ‘Append Percent Sign’ to have the symbol ‘%’ appear after the number.
o Check ‘Blank When Zero’ to leave the cell(s) blank if the value is zero.
o Check ‘Show -’ Symbol’ to have a negative sign display in front of the number if it is negative.
o Check ‘Show Parenthesis’ to put ( ) around the number if it is negative.
o Selecting a color will make the number that color if it is negative.

Format Cells
Number Border Conditiona
Category
General Decimal Places |2 Symbol |
m #| Use 1000 Separator |,
Date
#| Use Currency Symbol §
Text

Append Percent Sign (%)

Blank When Zero

Negative Numbers

#| Show Negative Symbol
Show Parenthesis

Color

e Date:

o From the menu, select the time/date format. (Ex. MM-yy will display a date as ‘Jun-97’).
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Format Cells
NMumber Border Conditional
Category
General Date/Time Fermat
Number M/d/yyyy mm
MM/dd/yy
Text M/d/yy
M/d/yyyy
yyyy-Mi-dd
M/d
d-MMM
d-MMM-yy
d-MMM-yyyy
dd-MMM-yy
dddd, MMMM dd, yyyy
MMM-yy
o Text:
o Text format does not apply formatting to cell values.
Border
The Border Tab allows you to alter the width and color of the cell edges.
e Uncheck ‘Make Borders Uniform’ to modify specific edges.
e To widen the borders, either key in a value or use the arrows in the width box.
e To change the color, either select a color from the drop-down or enter a Hex value.
b4
Format Cells

Number Border Conditional

Select color and width for each side of the cell. Check ‘Make
Borders Uniform’ to apply color and width to all sides.

[l Make Borders Uniform

#rroooo [
6

#0000FF [ : #D499FF
6 6

#00FFo0 [N
6

Conditional Formatting/Suppression
The Conditional Formatting Tab allows you to set or modify the format of a cell based on formula you create.

e Click the Add button to create a new conditional format. Each format must have an Action and a Formula that
evaluates to True or False. Some Actions require an Attribute such as a color or a number.
e Select an Action from the dropdown. This action will occur if the formula evaluates to True. Actions include:
o Foreground Color - Sets the foreground color of the cell.
Attribute: Color
o Background Color - Sets the background color of the cell.
Attribute: Color
o Font Size - Sets the size of the text.
Attribute: Number

User Guide
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o Bold - Bolds the text of the cell.
No Attribute

o TItalic - Italicizes the text of the cell.
No Attribute

o Underline - Underlines the text of the cell.
No Attribute

o Horizontal Alignment -Aligns the text of the cell horizontally.
Attributes: Left, Center, Right, or Justify

o Vertical Alignment - Aligns the text of the cell vertically.
Attributes: Top, Bottom, or Middle

o Suppress Row - Suppresses the row the cell is in.
No Attribute

o Suppress Section - Suppresses the entire section that contains the cell.
No Attribute

o Page Break - Starts a new page.
No Attribute

e Click the Formula Editor /* button to set the condition for the formula.

Note: The formula must evaluate to True or False. For conditional formatting, the Formula Editor will have an add Cell
Value button. This button adds the function CellValue() to the formula. This function retumns the value of the cell
that conditional format is being applied to.

e Use the up “* and down * arrows to change the priority of the formats. If two formats share a common action
and are both True then the lower condition will be applied.
e To remove a format, click the delete * button.

Note: The formula is still calculated with respect to the section of the cell. For example, for a cell in a report footer,
the formula {Order.Profit} > 1000 will return True if the last Order of the detail section profited more than 1,000. To
make the condition see if the total profit was greater than 1,000 use the formula Sum({Order.Profit})>1000’.

Format Cells
Number Border Conditional
Action Attribute
Foreground Color % #FF0000 PiAvx
Font Size

Suppress Section

o= Add

ncel

a

m C‘

AutoSum

To quickly get a total on a Data Field, place the field in a Report or Group Footer and click the AutoSum # button.
Alternatively, a sum can be created with the aggSum or Sum functions. See Formulas for more information.

Note: Do not use AutoSum on a cell with an aggregate formula such as aggSum.
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An image from your computer can be added to a cell using the Insert Image I button. This opens the Insert Image
window. Select an image and click okay to add it to the report.

Functions

Complex calculations can be done using Formulas A formula can be added to a cell by keying it in manually or using
the Formula Editor. To open the Formula Editor click the Formula Editor fx putton.

Suppress Duplicates

You can suppress duplicate values of a Data Object from being displayed. Select the cell and click the Suppress

Duplicate == button.

For example, the two reports below are identical, except the second image has suppressed duplicates for the customer

column.

Products
ProductMame | UnitPrice Units on Crder Units in stock
Beverages
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang $15.20 40 17
2 Chang 515.00 40 17
2 Chang $15.00 40 17
2 Chana 519.00 40 17
Products
ProductName | UnitPrice Units on Crder Units in stock
Beverages
2 | Chang [s15.20 40 17
[ |519.00
Condiments
3 Aniseed Syrup 510.00 70 13
Chef Anton's Cajun
4 Se E 522.00 0 53

Design Grid

User Guide
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In the design grid, you can:

e Add and delete rows, columns, and sections.
e Enter data fields, text, and formulas.
e Drag and drop fields into different sections, rows, or columns.

4+ Add Section » Page Header

g| Sectiol
% Delete Section Report Header

A ifu Car
# Modify Section Detai

A Move Section Up Report Footer

v Move Section Down Page Footer
P Section Shading Group Header

Group Footer

om o0 WwhoomomoioPE

Repeating Group

Sections

Sections dictate how the data appears in a report. There are five types of sections: page, report, details, group, and
repeating group.

[0 Page Header & = Page Footer

The rows in the Page Header section appear at the top of every page of a report, and the rows in the Page Footer
section appears at the bottom of every page of a report. Typically, the Page Header section is used to designate
column headers for a report, and the Page Footer section is used to display the page number and/or confidentiality
notices for a report.

Page Headers and Page Footers are not intended to perform calculations or display data fields. For this reason, a Page
Header populated with a data field will only return the first line of data in that field; a Page Footer will return only the
last line of data.

Note: If you are printing a report, remember that Excel outputs do not have pages. Page Headers will appear only
once at the beginning of the report. Reports run via the Report Viewer will display Page Headers similarly unless
‘Simulate PDF’ is checked in the Options menu.

[ Report Header & =l Report Footer

The rows in the Report Header appear at the beginning of a report. Typically, these rows display the title of a report.
The rows in the Report Footer appear at the end of a report. Typically, the Report Footer displays grand totals and
summary information for the report.

E Detail

The Detail section is the main section of most reports. When the report is executed, the Details Section creates a row
for each element in the Data Categories. For example, if the Detail section contains the Data Field Orders.OrderId,
the report will display each Order Id on a separate row.

[ Group Header & [ Group Footer

Group Header/Footer sections require a sort on a Data Field. The rows in a Group Header section will appear above the
Detail section for each unique value of the sorted Data Field. Typically, Group Header sections are used to display data
as labels. For example, a report may contain a Group Header on Orders.OrderDate and display Orders.OrderId in the
Detail section. The output would display each date with orders that occurred on that date below them.

The rows in a Group Footer section will appear below the Detail section for each unique value of the sorted Data Field.
Typically, Group Footer sections are used to calculate subtotals. For example, a report may contain a Group Footer on
Orders.OrderDate which displays the number of orders made on each date.

Note: Group Header/Footer sections can also be set to display rows for each value of a formula instead of a Data
Field. (Ex. The report may be sorted on the Data Field Orders.OrderDate, but the report should show subtotals for
each month. A Group Footer on the formula =Month({Orders.OrderDate}) will display rows containing subtotals for
each month.)

E Repeating Groups
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Repeating Groups require a sort on a Data Field. Repeating Groups have their own header, detail, and footer
subsections. Repeating Groups should only be used when the data has multiple one-to-many relationships and each
should be rendered completely before the other.

For example, each Professor can teach multiple classes and advise multiple students. For each professor you want to
see all the classes they teach and then all the students they advise.

Using Sections

Sections can be added, deleted, modified, moved, and assigned shading.

Adding Sections

1. Click anywhere in the Section Column.
2. Hover your mouse over Add Section, then select the type of section you would like to add.

Deleting Sections

1. In the Section Column, click on the section you want to delete.
2. Click ‘Delete Section’.

Modify Sections (Group Header/Footers and Repeating Groups only)

In the Section Column, click on the section you want to modify.

Click Modify Section. This will bring up a Modify Group Section Menu.
Select from the dropdown the desired Data Field for the group to use.
Click OK.

PN

Section Shading

In the Section Column, click on the section that you want to Shade.
Click Section Shading. This will bring up a menu.

Click New to add a color to the shading.

Click the color box to select a color or enter a hex value.

Click OK.

uihwnNe

Section Shading

Alternate Shading Color

#FFFFFF AV XK
#EZE2EZ AV K
+ New

Columns and Rows

Columns and rows of cells can be added, modified, or removed as described below.

Columns

e To select a group of columns, hold the SHIFT key and then click the beginning and ending column.
e Non-contiguous columns can be selected by holding the CTRL key and clicking the desired columns.
e A column can be resized by dragging its right edge horizontally.
Clicking on a column (or selected group) will display a menu where you can:

o Insert a new column.

o Delete the selected column.
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o Set its width to be identical with the other selected columns.
o Hide the selected column.
o Set Column Info to make the label the column and/or make it sortable within the Report Viewer.

F

+ Insert Columns Before
+| Insert Columns After

¥ Delete Columns

Set Widths Identical

Column Width...

Hide Column

Colurmn Info...

Sorting by Columns within the Report Viewer

While viewing reports in the Report Viewer, a user can click the bar at the top of the report to sort by a column. For
Express Reports, this is handled automatically but must be enabled for Advanced and Crosstab Reports.

To make a column sortable:

e Click on the column and select 'Column Info...'
e Provide the column with a label that will appear in the Interactive Report Viewer Dock.
e From the Sort dropdown select the Data Field to be used for sorting, or provide a formula by clicking the formula

button (/*).

Note: Column Sorts are applied after any sorts defined in the Sorts Menu.

Column Information

Label:

Sort:
Mone v f

m Caﬂce"

e Click on the column again to set a default sort direction.

+ Insert Columns Before
+| Insert Columns After

X Delete Columns

Set Widths Identical

Column Width...
Hide Column
+ Column Sort 3 None
Column Info... Ascending
Descending

Rows

e To select a group of rows, hold the SHIFT key, then click the top and bottom rows of the area you wish to
select.
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e Non-contiguous rows can be selected by holding the CTRL key and clicking the desired rows.
e A row can be resized by dragging its bottom edge vertically.
e Clicking on a row (or selected group) will display a menu where you can:

o Insert a new row.

o Delete the selected row.

o Set the row's height to be automatically controlled.

o Suppress the row from appearing on the report.

o Insert a page break.

+ Insert Rows Befare
+ Insert Rows After

X Delete Rows

Set Auto Height

Row Height___

Suppress Rows

Page Break

Cells

Cells are the containers for all the information in a report. Cells may contain text, images, charts, or links to other
reports.

e To enter text into a cell, double-click the cell, and a text field will appear.

e To select cells, either click or use the arrow keys.

e Groups of cells can be selected by holding the SHIFT key and clicking on another cell. All the cells in-between
the two will be selected.

e Non-contiguous cells can be selected by holding the CTRL key and clicking the desired cells.

e A cell can be copied by holding the CTRL key, then dragging and dropping it into a new cell.

e Adjacent cells can be merged and unmerged using the Merge/Split Cell I puttons in the Toolbar.

Using Page Breaks
For a Page Break to occur at the beginning of each element of a Data Field, place a page break on the top row of

Group Header Section for that Data Field. See Sections for more detail on Group Header Sections.

Insert Rows Before
+ Insert Rows After

X Delete Rows

Set Auto Height

Row Height...

Suppress Rows

Collapse Rows

<]

Repeat Row

<]

Page Break

Creating Collapsible Rows

A Group Section can be set to display as collapsed by default on HTML export. This causes the contents of the section
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to be suppressed and individually expandable for each change in Header. Collapsible rows are supported in the standard
or Interactive HTML viewer. Non-HTML export formats will ignore Collapsible Rows.

Order #: 10248
Order #: 10249
Order #: 10250
Order #: 10251
Order #: 10252
Order #: 10253
Order #: 10254
Order #: 10255
Order #: 10256
Order #: 10257
Order #: 10258
Order #: 10259
Order #: 10260

TYYTYVYYVTYYVTYYyryYYY

Left-click on an arrow next to a Collapsible Row to expand or collapse the group.

» Order 2: 10248
» Order 3: 10249
» Order & 10250
¥ Order # 10251
Product Mame Unit Price
Gustaf's Knackebrod 316.80
Louisiana Fiery Hot Pepper Sauce 316.80
Ravicli Angelo 515.60
Number of Products on Order: 3
¥ Order #: 10252
Product Mame Unit Price
Camembert Pierrot $27.20
Geitost 52.00
Sir Rodney's Marmalade 364 80
Number of Products on Order: 3

Order #: 10253
Order #: 10254
Order #: 10255
Order #: 10256
Order #: 10257
Order #: 10258
Order #: 10259
Order #: 10260

TYVYVYVYVYTrY

Right-click on an arrow next to a Collapsible Row to see additional display options:

o Expand will expand the selected top-level group. This elicits the same behavior as left-clicking an arrow.

Quantity
(]
20
15
Total Revenue:
Quantity
40
25
40
Total Revenue:

Revenue

5100.80
5336.00
5234.00

367080

Revenue

51.088.00
550.00
52 582 .00

$3.730.00

e Collapse will collapse the selected top-level group. The state of the sub-groups is preserved.
o Expand Group will expand the selected top-level group and all sub-groups within that group.
e Collapse Group will collapse the selected top-level group and all sub-groups within that group.
o Expand All will expand every group and sub-group on the page.
e Collapse All will collapse every group and sub-group on the page.

To create a collapsible row, click on the desired row number in a Group Header Section and select Collapse Rows in

the dropdown menu.

Expand

Collapse

Expand Group

Collapse Group

Expand Al

Collapse All

Properties of a Collapsible Row

Collapsible Rows have the following properties when exported to HTML:

User Guide
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e Collapsible Rows display as collapsed whenever the Report is exported or altered using Interactive HTML.

Note: Collapsed or expanded states cannot be saved to the Interactive HTML User Report preferences.

e Page Breaks below a collapsed row are ignored. Expanding a collapsed group will not alter the Report pagination.
e The contents of a collapsed group are searchable by the HTML search tool.

See Interacting with the Report Viewer for more information on the Interactive Report Viewer.

Drilldowns

Linked reports allow you to add custom drilldowns to cells or charts. Drilldowns are a means of exploring data points by
"drilling down" into their background data.

‘Note: Drilldowns work in the Report Viewer and Dashboard Viewer, but the data is not shown in exported reports.

% British Isl %

ARCUT z“ya”‘a AROUT
ESEEV Dggswo i BSEEV
CONEH CONSH
EASTC | EASTC
HUNGO w HUNGO
ISLAT Fjl‘l";"’ ISLAT

NORTS NORTS

Leverling SEVES

Drilling down into a cell and a chart

Drilldowns require you to have a child report, which is an Advanced or Express report that contains the background
data for the parent report. You can create a drilldown on a Dynamic Cell or a chart by linking the child report to the
parent report cell. Each data value, or each chart series, when clicked, filters the child report by its respective value
before opening the resulting report in a window at the cursor.

Note: Currently, the prompt window will not appear when drilling down into a child report that contains prompting
parameters. However, this can be partially bypassed by adding the prompting parameter in a hidden cell on the parent
report so that the user will be prompted at runtime for the parameter value.

Since drilldowns are themselves reports, they can have interactive sorts and filters, dynamic visualizations, they can be
exported, and they can even have their own drilldowns.

Default linking

By default, the data category that corresponds to the linking cell filters the closest joined category on the linked
report. See Joins for more information. If there is no join path, then you must set the linked fields manually in the
Fields page.

For example, a parent report links an Employees data field to a child report with an Orders category. The two
categories are joined on Orders.EmployeeId >> Employees.Id. For each Employees row, its Employee.Id value
filters the linked report down to the Order rows with matching Orders.EmployeeId values.

Employees
Id Name
1 Mancy Davolj
X
Orders 2 Andrevs Ful Orders
EmFILGYEE Order Id 3 Janet Leverling Employee
c 10254 4 Margaret Peac |9 Order Id
9 10255 3 Steven Buchar q 10258
3 10256 3] Michael Suyam 4 10270
4 10257 7 Eobert King 1 10275
1 10253 i} Laura Callahar 4 10285
4 10258 g Anne Dodswor 1 10292
1 10283

Orders linked report filtered by Employee Id

Tip: Filters on the parent report or containing dashboard do not cascade down to linked reports. Linking filters do not
cascade down to grand-children, or child reports of the linked report.
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Adding linked reports
To add a linked report drilldown:
1. Make an Advanced or Express Report that contains the drilldown data. This will be the linked child report.

Linked reports typically open in a small window, so the child report should be simple and concise. Avoid large
fonts, too much static content, or making it too large in size. You should also set the General Option for No
Data Qualify Display Mode to Show Report in order to show an empty drilldown instead of a popup window for
links with no data.

2. In the parent report, select the cell to link, then click the Link Reports ™ icon. The cell can contain a data field,
formula, or a column-based or row-based chart.

3. Select the child report, then click Okay.

Caution: Because the linked report is a separate report from the parent, if you move the linked report to another
folder, or remove the linked category, the link will be lost. You will have to edit the parent report and add it again.

To remove a linked report drilldown:
1. Click the link [ icon, or select the cell and click the Link Reports ™' icon.
2. Click the Remove Link * icon.

3. Click Okay.

Caution: Adding a linked report to a cell may override or interfere with any linked Action Event on the cell. Adding a
linked report to a chart may override some aspects of the chart's basic interactivity.

Fields

You may want to link on different fields or categories than the default join. The Fields page allows you to specify
which categories and fields are used to determine the drilldown data.

The Fields page is suitable for the following situations, among others:

e The default join is not the link you want to use
Example: Linking on related fields other than the Id field, such as "Region"
Employees.Region >> Orders.ShipRegion

e No join exists between the From and To categories
Example: Categories have related fields but are not joined, such as Orders and Suppliers
Orders.ShipCity >> Suppliers.City

e The From and To categories are the same
Example: Fields are related to other fields in the category, such as Employee X supervises Employees Y and Z

Employees.Id >> Employees.ReportsTo

Tip: The From fields from the parent report filter the To fields on the child report.

To specify the linked fields:
1. Select the From Category and To Category from their respective lists.
2. Click ¥ Add for each set of linked fields to add.
Use multiple linked fields to show only the drilldown rows that satisfy all the link conditions.
3. For each set of linked fields, select the From Field and To Field.

4. When finished, click Okay.

Formula

The Formula tab allows you to specify a custom formula in order to further filter the data passed from the linked
report. The formula must return True or False. The formula is evaluated for each row in the parent report, and if the
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condition is not met, the data is excluded from the linked report. See Formulas for help with using conditional
formulas.

e Add a data field by dragging and dropping it into the Formula pane or double-clicking it. Or enter it manually
using the following format: {DataCategory.DataField}.

Caution: Linked report formulas support only one data field. If multiple data fields are used, all but the first will be
ignored.

e Add a Parameter by entering it manually using the following format: @ParameterNameQ.

e Add a function by dragging and dropping it into the Formula box or double-clicking it. Or enter it manually.

Dashboard Viewer

When you run a Dashboard, the output is shown in a new tab called the Dashboard Viewer. Reports and charts on the
dashboard are interactive, as are any embedded web pages. The dashboard refreshes periodically, or you can refresh it
manually. You can also filter the dashboard with the filter sidebar or with filters on the dashboard design itself.

Monthly Sales

c
c ) . “ 0:
. ———o oL
o / /
Busharan P Daesien “ Sales by Employee
T
#
|
:ld #
Count — ;
sl
Grder Date ®

Viewing an interactive dashboard
To run a dashboard:
e If you are in the Dashboard Designer, click Run Dashboard.

Tip: The Run Dashboard button also saves the dashboard.

e If you are in the folder tree, click the Run n icon, or click the Menu E icon and select ® Run Report.

The Dashboard Viewer opens in a new tab, indicated by the viewer # icon. This tab represents an instance of the
dashboard as you have just run it. If you go back and edit the dashboard, you need to run it again to see the changes.
This will open another viewer tab, so you can go back and close the old one.

Interacting with dashboards

There are a number of ways to interact with dashboards. Your available options depend on how the dashboard was
designed and the type of content in it.

Reports and visualizations

Hover over a report to show a navigation bar at the bottom of the tile. Enter text into the Find field, then click the up

“ or down * icons to search for the text in the report. Page through the report by using the navigation icons % <
> »

Use the il Show Chart and = Show Table icons to swap between chart or tabular view for an ExpressView
visualization.

Click the menu icon in the top right comer for some additional view options for reports:

e Select Expand to show a report in the full screen. Select Collapse to return to the dashboard.
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e Select Refresh Report to reload the data in the report.

Click the refresh C' icon to refresh all of the reports on the dashboard.
Filtering data

Use dashboard filters to narrow down the data for multiple reports at once. Filter tiles can appear as scales, menus, or
check boxes on the dashboard. Select one or more data values, or a range of data, to apply the filter to all its
connected reports. This will automatically refresh the reports.

If there is a filters ' icon then there are more filters available. Click the icon to open the filters pane and choose
values for the filters.

If there is a parameters ® icon then there are parameters available, which are a special type of filter. Click the icon
to open the parameters pane and choose values for the parameters.

Dashboard Designer

Dashboards are a way to combine a several related reports into one unified viewing space. You can add preexisting
reports to a Dashboard, but you can also create new ExpressViews and visualizations directly on the Dashboard
itself. You can also add images, text, embed other web sites side by side with your data, add interactive filters which
can work on multiple reports all at once, and export the Dashboard as a Chained Report from the Dashboard
Designer.

CEEEDY (rwroswas | 2 A C TS
Dashboard Style
Dashboard S

v Backgrounds and Borders

IlI | ‘ \ ’ | -
I — a ry Prod B

The Dashboard Designer

Double-click a Dashboard to open it in the Dashboard Designer, or click the Menu E icon and select /Edit.

For more information about the types of content that can be added to a Dashboard, see the following links:

Adding Reports ® ExpressView Visualizations e Interactive Filters

e Exporting Dashboards

Grid and tiles

Each element on a Dashboard is a rectangular tile that can be resized and dragged to the proper location. Tiles are
arranged onto a grid, and they will snap into place next to each other.

Adding tiles
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To add a new tile to the Dashboard, drag the =+ New Tile icon onto the dashboard grid. You can drag to an empty
location to fill the space, to the side of an empty location to take up a portion of the space, or over another tile to
place it adjacent and resize the other tile to fit. You can then drag the resizing handles for fine grained control over the
tile size.

A new tile placeholder will be added.

|.| New Visualization
Gy urL 8] image
Aa Text Y Fitter

D Existing Report

Select what type of content should be on the tile:

New Visualization

Create a new ExpressView visualization in the tile. Choose between a chart or a tabular ExpressView. See
ExpressView Visualizations for more information.

URL

Embed another web page inside the Dashboard. Enter the URL, or web address, to the textbox and click Finish.

Caution: Some web pages may not be embeddable.

Image

Upload an image from your computer. Drag the image onto the tile or click browse your files and locate the image.
Text

Enter text into a field that can be formatted and styled.

Filter

Add several styles of interactive filters, which can affect multiple reports on the Dashboard. Filter tiles will not display
in Dashboard exports. See Interactive Filters and Exporting Dashboards for more information.

Existing Report

Drag an existing report onto the tile. See Adding Reports for more information.

Screen fit and scaling

Tiles can resize and adjust their positions automatically to fit different screen sizes. A Dashboard will automatically
resize to fit on a large television or a smartphone screen, so there is no need to make multiple Dashboards for
different screen sizes.

o

You can customize how Dashboards will scale to fit different screen sizes. Click the style
Dashboard Style pane. The following Canvas Fit options are available:

icon to open the

o Y = o o
Dashboard Style

w» Canvas Fit

All e Width None
0 All dashboard tiles wi
of the display automati
Height
868
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L Y = o o
Dashboard Style

w» Canvas Fit

All & Widih None

0 All dashboard tiles will
of the display automa

Height

868

Automatically Repaosition Tiles

All
Tiles will resize to fit the height and width of the screen (default).
Width

Tiles will resize to fit the width of the screen. Specify the Height of the Dashboard and whether or not to
Automatically Reposition Tiles, which dynamically derives an optimal new layout for the Dashboard tiles using the
screen size as input.

None

Tiles will not resize. Specify the Height and Width of the Dashboard.

Use the Snap to Grid @ icon to choose if tiles should snap to the grid lines.

User Guide

Note: Legacy Dashboards default to Canvas Fit: None and snapping off.

You can also use the Dashboard Style o pane to set the default options for the Dashboard background color, tile
and tile header background colors, and tile border colors and widths. These settings can be overridden for individual
tiles.

Managing tiles

Every tile has a formatted header, background color, and border. Some types of tiles can be set to resize differently
than the dashboard canvas. Tiles have a menu with some additional options.

Tile menu

Select a tile, then click the tile menu " icon to access some additional options for managing tiles.

You can Delete a tile from the Dashboard. You can Copy a tile then Paste it next to another. You can Expand a tile

to temporarily fill the screen, then Collapse it back into place. And you can Refresh the data in reports and
visualizations.

ExpressView visualizations can be saved as new ExpressViews by clicking Save as ExpressView. You will be asked

to name the report, and will be taken into the ExpressView Designer.
Tile style

Select a tile, then click the Style tab to access the options for changing its appearance.

Click Tile Fit to choose how the tile scales fit to he screen. This option is not available for filters or ExpressView
visualizations.

Click Tile Header to add header text to the tile. Then choose the text font and formatting.

Click Background and Border to change the background color of the tile and tile header, and the border color and
style.

More information

See Adding Reports, ExpressView Visualizations, Interactive Filters, and Exporting Dashboards for more
information about their unique features and options.
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Dashboard Designer: Adding Reports

Any Advanced Report, Express Report, ExpressView, and Crosstab Report can be added to a Dashboard.
Existing filters and prompting parameters can be accessed and modified from the Dashboard Designer. Reports have
most of the same interactability as in the Report Viewer, with the exception of the interactive sidebar. See
Interacting with reports for more information.

To add a report to a Dashboard, simply drag it from the report tree onto the Dashboard.
For information about managing report filters and parameters, see Filters and Parameters.

For information about what report settings are available, see Report Settings.

Filters and Parameters

When you add a report with prompting filters or parameters to a Dashboard, you have several choices for how these
filters can be accessed on the Dashboard, as well as which reports they can apply to. Select the report tile, then
click the Filters or Parameters tabs to edit the filter settings.

For each filter or parameter you can do the following:
Apply to

Choose whether this filter or parameter applies to the Report, or to all reports on the Dashboard. If you select
Dashboard, then the filter or parameter must be edited in the Dashboard Filters or Parameters panes. Deselect the

report, then click the Y Filters or EParameters tab.

Prompt for value

Select this option to prompt users to enter a value when running the Dashboard.

Interactive

Interactive filters and parameters can be edited in the Dashboard Viewer filters and parameters panes.
Operator

Change the filter operator. Click the lock # icon to toggle whether other users are allowed to select an operator when
running the Dashboard.

Value

Set the value or values for the filter or parameter. If the filter or parameter is interactive or prompting, then other
users can select different values when running the Dashboard.

Report Settings
You can edit some additional settings for reports on a Dashboard. The following settings are available:
Reload Interval

Select how often, in seconds, the report will automatically refresh in the dashboard viewer. The default '0' seconds
disables automatic refresh.

Allow Searching

Show a search and paging bar to allow users to browse the report.
Allow Scrolling

Show horizontal and vertical scroll bars if the report cannot fit in its tile.
Only run report in design screen when report is manually refreshed

Do not run the report immediately in the Dashboard Designer. Choose this option for large reports which may take a
while to load.

Dashboard Designer: ExpressView Visualizations

You can create tabular reports and visualizations directly on the dashboard with ExpressView visualizations. To do so,
either:
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e Drag the = New Tile icon onto the Dashboard and select Visualization.
e Drag a field from the Data Pane directly onto the Dashboard.

A KPI chart is the default visualization for a single data field. To add data fields, drag fields from the Data Pane onto
the visualization. To swap to a tabular report, click the Show Table = icon. To swap back to a chart, click the Show

Chart il icon.

For details on building a tabular ExpressView visualization, see ExpressView.
For details on building a chart ExpressView visualization, see Visualizations.
For information about what report settings are available, see Report Settings.

To save the visualization as a new ExpressView, click the menu : icon and select Save as ExpressView. The
visualization will open in the ExpressView Designer.

Suppress Detail Rows (v2017.3+)

To remove all data rows from the visualization and only show summary data, from the Settings pane, select Suppress
Tabular Detail Rows. This may improve the performance for visualizations that do not depend on the detail values.

Dashboard Designer: Interactive Filters

Interactive filters are filters that appear as tiles directly on the Dashboard itself. Filter tiles have several different
styles to choose between, and can resize and scale just like any other tile. Filters can apply to as many or as few
reports as needed.

Type

You can choose between four styles of filters and two orientations:
¢ Single Choice - A drop down menu with all possible filter values. Users can choose one value.
e Multiple Choice - A check list with all possible filter values. Users can choose multiple values.
¢ Single Slider - Users can choose one value by sliding a point along a scale.
e Range Slider - Users can choose multiple values between two points on a scale.

You may also select whether the filter values are oriented horizontally or vertically.

Reports

Select which reports the filter applies to. Only reports that include the filter data field are valid.

Data

Select which data field the filter applies to. The filter is automatically populated with values from the data field. You
can select which value or values are selected by default when the Dashboard is executed. Select Prompt for value
to prompt users to enter a value when running the Dashboard.

Text and Format
Choose how the filter value labels are styled and formatted.
Exports (v2018.2+)

Interactive filter tiles will not display in exported Dashboards, which are exported in the form of Chained Reports.
Though the tiles themselves will not display, the default values set for the filters will apply to their corresponding
reports and visualizations in the exported file. Learn more about exporting Dashboards here.

Express Reports

The Express Report Wizard is an interactive tool which allows you to quickly create and edit Express Reports.
To navigate the wizard, either click the desired tab or use the buttons at the bottom.

To Save an Express Report, click the save [ putton.
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Mew Express Report Getting Started O
-
Name Categories Sorts Filters Layout Options IE D @

Enter a description for the report

X Cancel Previous Mext > B Save and Close

The Express Report Wizard has six sub tabs. The Name, Categories, and Layout tabs must be completed while the
other tabs are optional.

Name Tab
In the Name Tab, enter a report name and click on the Folder where the report will be saved.
The report name can be up to 255 characters. Avoid special characters suchas ? : / \ * " <>,

A report’s description appears at the bottom of the Main Menu when it is selected. The description text is also used
when searching for a report.

User Guide

NOTE. You cannot create a report inside a folder that is read-only ().

New Express Report ol 7]
-
Mame Categories Sorts Filters Layout Options B I-J O

Enter the report name

Mew Express Report

Select folder for the report

> Customer Reports
| > order Details 2016

» Report Examples

» Sales Reports

Enter a description for the report

¥ Cancel Previous Next & [¥] save and Close

Categories Tab

In the Categories Tab, select the Data Categories that you would like to have access to on the report. It is important
to understand two terms: Data Category and Data Field.

Data Category

A Data Category is a data object that has several attributes. E.g., Orders is a category; each order has an ID, a date,
a customer etc.

Data Field
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A Data Field is a single attribute within a category. E.g., Orders.OrderID is numeric value that identifies a specific
order.

Mew Express Report ‘1\1: Q
-
Name Categories Sorts Filters Layout Options B I-J G)
Select categories to include on report
Suppress
Search... Duplicates e
(] Categories X
» Adventureworks - (] Products b 4

» Exago University
OrderDetails

&= add i ]

X Cancel £ Previous Mext > B Save and Close

e To add a Data Category, either drag and drop it to the 'Category Name' Column, use the + Add button, or
double-click it.

e To search for a specific Data Category or folder, type its name into the Search box.
e To see what Data Fields are in a Data Category, click the information button (ﬂ').

e Check the 'Suppress Duplicates' box to suppress any repeated records from that category.
e To remove a Data Category, click the delete button ().

Sorts Tab

In the Sorts Tab, specify which Data Fields will be used to determine the order of data on the report.

Mew Express Report »o

»
Name Categories Sorts Filters Layout Options IE D @
Select sort fields

Sort By Sort Order
v oA WX

Categories ¢ Categories.CategorylName Ascending

Ascending

CategorylD

CategoryName

Description

= Add

X Cancel £ Previous Mext > B Save and Close

e To sort by a Data Field, either drag and drop it to the 'Sort By' Column, use the + Add button, or double-click
the field.

e You can sort each Data Field in ascending (A- Z) or descending (Z-A) order.
e Use the up (”*) and down () arrows to indicate the sort priority.
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e To remove a sort, click the delete button ().

Filters Tab

In the Filters Tab, create statements that will be used to filter the data when you execute the report.

New Express Report 47}

>
Name Categories Sorts Filters Layout Options B I-J @

Select fiter fields to include on report

Filter By
Products % Products ProductM ame A v X

CategorylD
Discontinued
ProductlD
QuantityPerUnit
ReorderLevel Is One Of v ‘%
SupplierlD AND With Next Fitter | Alice Mutton
UnitPrice Aniseed Syrup
UnitsinStock e Group With Next Filter Boston Crab Meat
+ Add Prompt For Value Camembert Pierrot
Carnarven Tigers
Chai
Chang
Chartreuse verte
Chef Anton's Cajun Seasoning
< Preyviopus Chef Anten's Gumbo Mix 7

SUMMARY
Products Preductiame s One Of ()

¥ Cancel

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or
alphanumeric.

e To filter a Data Field, either drag and drop it to the 'Filter By' column, use the + Add button, or double-click it.

e Use the up (”*) and down (™) arrows to indicate the filter priority.

e To remove a filter click the delete button ().

e Set the operator (equal to, less than, one of, etc.) by selecting it from the operator drop-down.

e Set the filter value by either entering it manually or selecting a value from the drop-down. If the Data Field is a
date, the calendar and function buttons can be used to select a value.

e Check 'Prompt for Value' to allow the filter to be modified at the time the report is executed.

e Select 'AND With Next Filter' to require that the selected filter and the one below it are both true. Choose 'OR
With Next Filter' to require that either be true.

e Check 'Group With Next Filter' to specify the precedence of the filters. Filters can be nested indefinitely by using
the following keyboard shortcuts while a filter is selected:

o Ctrl + [ adds an open-parenthesis before the selected filter.

o Ctrl + ] adds a close-parenthesis after the selected filter.

o Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
o Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.

Layout Tab

In the Layout Tab, select which Data Fields that will appear on the report. For each Data Field chosen, the report will
automatically create a column header and the Data Field. Additionally, sub-totals, grand totals, and page
header/footers can be created.

User Guide
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New Express Report

Name Categories

Select fields to include on report

Sorts Filters Layout

Products “ % Products Productiame
CategorylD 4 % Products. ProductiD
Discontinued % Products.UnitPrice
ProductiD 4 Products. QuantityPerUnit
ProductName

ReorderLevel Summarize By
SupplierlD

UnitPrice Categories
UnitsinStock

UnitsOnOrder -

& Add < Add Blank # Page Header Page Footer

v | = Arial

* Cancel

Display Data

e To place a Data Field on the report, either drag and drop it to the 'Data Field' column, use the

or double-click it.

e To add blank columns that can be typed in click the

column.

e Use the up (“*) and down (™) arrows to indicate the order the Data Fields should appear on the report. The

~“s #$ BT U A% @ =

New Express Report

Options

Data Field

Grand Total

ProductName ProductlD UnitPrice
ProductMame 1 ProductlD 1 UnitPrice 1
Producthlame 2 ProductlD 2 UnitPrice 2
Producthlame 3 ProductlD 3 UnitPrice 3
FroductMame 4 FroductlD 4 LinitPrice 4

< Previous MNext >

== Add Blank

QuantityPerUnit

CuantityPerlUnit 1
CuantityPerlnit 2
CuantityPerlnit 3
CuantityPerlnit 4

Data Field at the top will appear on as the leftmost column of the report.
e The Summary Function column is used to make subtotals and grand totals.
e To remove a Data Field, click the delete button (*).

For each Data Field added in the Sorts tab, a checkbox will appear in the Summarize By box. Using the ‘Summarize By’
box, you can display subtotals, grand totals, or headers for each unique value of a Data Field.

Subtotals and Grand Totals

Theme: Custom

fr
fr
fr
fr

Summary Function

Mone
Mone
Mone
Mone

= Add

~

~
~
~

button. You can enter text into a blank

> 2> >
<< <L

User Guide

X0
gc)

button,

KA AN

[/ save and Close

e To display subtotals, check the box of the category you want sub-totals for. Then, for each Data Field you want
totaled, select a Summary Function (see below).

e To display grand totals check the Grand Total box. Then for each Data Field you want totaled, select a Summary

Function (see below).
e Summary Functions:

o Sum: Totals the

all of the data in the Data Field.

o Count: Returns the number of rows in the Data Field.
o Average: Takes the mean of the data in the Data Field.
o Minimum: Displays the lowest value in the Data Field.

o

Preducts. Productl ame
Preducts. Product!D
Preducts. UnitPrice
Products. CuantityPerUnit

L3 4% €3 4>

Summarize By

¥ Page Header

Data Field

Page Footer Grand Total

Maximum: Displays the highest value in the Data Field.

fe
fe
fe
fe

Summary Function

Maone
Count
Mazximum
Mene

> 222
<L
MoK A XK
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Data Headers

To display a header for each value of a Data Field, click on the associated Data Category in the Summarize By box.
Click the Data Category name next to the checkbox, and the Header Menu will appear.

e To include a blank row before each unique value of the selected Data Field, check the box 'Add space before
each unique item'.

e To include a Header, check the box ‘Include Header at the beginning’. In order to select the text that will appear

as the header value, use the Header Text dropdown to select a Data Field or use the Formula Editor Button (Jﬁr
) to create a formula.

e Use the 'Summarize by each unique' dropdown to specify if the header should repeat based on a specific Data
Field or if it should repeat for all of the keys of a Category.
e Check the box 'Include Total at the end' to have a sub-total created for this Category.

Summarize By

Summarize by each unigue:
Categories hd

Space

¥ Add space before each unigue item

Header
¥ Include Header at the beginning

Header Text:
Categories. CategorylD  ~ fu

Total

# Include Total at the end

Page Header

To display information on the top of each page, click 'Page Header' below the 'Summarize By' box. A Page Header Menu
will appear.

Summarize By

¥ Page Header Page Footer Grand Total

e Check the box 'Include Title at the top of every page' to display the name of the report on each page. If an
image is also included, use the position dropdown to set where the title should appear and the number of columns
it should span.

e Use the 'Change Image' button to upload an image to display at the top of each page. If a title is also included,
use the position dropdown to set where the image should appear and the number of columns it should span.

Title

#| Include title at the top of every page
Paosition: Number of columns to span:

Left ~ 4

Image

Include image at the top of every page |

Paositien: Number of celumns to span:
Rightv| |4 /

ki change Image
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Footers

To display information on the bottom of each page, click 'Page Footer' below the 'Summarize By' box. Click 'Page Footer'
next to the checkbox, and the Page Footer Menu will appear.

Summarize By

Page Header ¥ Page Footer Grand Total

e Check the box 'Include page number at the bottom of every page' to display the page number on each page. If
an image is also included, use the position dropdown to set where the page number should appear and the
number of columns it should span.

e Use the 'Change Image' button to upload an image to display at the bottom of each page. If the page number is
also included, use the position dropdown to set where the image should appear and the number of columns it
should span.

Page Number
#| Include page number at the bottom of every page

i Position: Mumber of columns to span:

P Left w 4

Image

Include image at the bottom of every page

Position: Mumber of columns to span:
Rightv| |1 /

Ed Change Image

Preview

At the bottom of the Layout Tab, a preview will display how the report will appear based on the fields that have been
added. You can increase/decrease the size of the preview or hide it altogether by dragging the top of the Express
Report Designer box.

— 1

ProductMame ProductlD UnitPrice QuantityPerlInit
ProductMame 1 ProductlD 1 UnitPrice 1 CuantityPerUnit 1
ProductMame 2 ProductiD 2 UnitPrice 2 CQuantityPerUnit 2
ProductMame 3 ProductiD 3 UnitPrice 3 CQuantityPerUnit 3
ProductMame 4 ProductiD 4 UnitPrice 4 CQuantityPerUnit 4

Page Number

¥ Cancel £ Previous Next f# Finish

Styling Express Reports

Above the preview is a toolbar. This toolbar can be used to stylize the Express Report. To utilize this toolbar, select the
cell(s) you want to modify from the preview.

=  Theme: Custom w

w | [E | Aral ~8 =B I U A& A

The following icons are available in the toolbar:
Undo/Redo - can undo or redo the last change made. You can also use Ctrl+Z /Ctrl+Y respectively. ¥ ™

Layout Options - see Layout Options for more information. =)
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L1

. . Arial 3
Font - see Font for more information. v

Foreground & Background Color - see Color for more information.
Number/Date Format - see Formatting Cells for more information. =

Border Color - see Formatting Cells for more information. =

Alignment - see Alignment for more information.

i i Theme: Custom ~
Theme - see Theme for more information.

Layout Options

In Layout Options, you can hide the detail information and set row shading.

e Check 'Suppress Detail Rows' to only display Sub-Totals, Grand Totals, Data Headers & Page Headers/Footers.
e To add row shading click the 'New' button and select a color from the color drop down or enter a hex value.

User Guide

NOTE. Row Shading is only applied to the detail rows that contain Data Fields.

Layout Options

General

Suppress Detail Rows

Row Shading
Alternate Shading Color
#FFBF00 P~ v x
#9400FF WA~ v x
+ New
oK X Cancel

Express Report Themes

The Theme dropdown can be used to quickly style the report using one of the pre-defined themes. After selecting a
Theme, styling can still be modified. See Styling Express Reports for more information.

Options Tab

The Options Tab allows you to control various report option settings.

General Options

e From the 'Include Setup' menu select Top or Bottom to display the data categories, sorts, and filters at either the

beginning or end of the report.

e Select which type of Filter menu to display when executing a report that has prompt-for-value filters.

o Default — Display the default type of filter execution window.
o Standard - Display the standard filter execution window.

o Simple with Operator - Display a simplified filter execution window that only allows the operator and value
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to be changed.
o Simple without Operator — Display a simplified filter window that only allows the filter value to be
changed.
e Check 'Always Show Filter on Execution' to show the filter menu and allow changes to be made each time the
report is executed.

New Express Report ‘51: Q
»
Name Categories Sorts Filters Layout Options B I-J O
General Information
Export Include Setup Info Mo~
Advanced
Filter Execution Window Default v ] Alvays Show Filters in Report Viewer

Mo Data Qualify Display Mede | Show Message v

¥ Cancel < Previous Next [¥ save and Close

Export Options
General Export Options

e Use the Default Export Type drop-down to specify the default format for the report.
e Output types may be disabled by unchecking the boxes for 'Allowed Export Types'.

HTML Options

e Uncheck 'Show Grid' to disable grid lines.
e Uncheck 'Simulate PDF' to have the report appear as though it is not on a page.

Excel Options
e Check 'Suppress Formatting' to prevent the report formatting from exporting to Excel.
Page Options

e Specify the size of the report in the 'Page Size' drop-down. Default is Letter.
e Set the orientation for the report in the 'Orientation' menu. Default is Portrait.
e Check 'Fit to Page Width' to scale all columns to fit the width of the page.

New Express Report NO
>
Name Categories Sorts Filters Layout Options B LI @
General General Options
I Ef.|:|3|‘t Default Export Type Defaults
Advanced o
Allow Execution in Viewer True v
Allowed Export Types: # Excel ¥ POF ¥ RTF ¥ csv
Report Viewer Options
¥ Show Grid 1#/ Simulate PDF
Excel Options
) Suppress Formatting
Page Options
Page Size Letterw Page Crientation | Portrait =«
| Fit to Page Width
X Cancel £ Previous Next B Save and Close
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Advanced Options

In the Advanced Options, an Express Report can be converted to an Advanced Report.

|IMPORTANT. This CANNOT be undone.

e Click the 'Convert simple report to an advanced report' button to convert an Express Report to an Advanced

Report.
Mew Express Report "}{: 9
o
Name Categories Sorts Filters Layout Options B D G)
General Convert Options
Export Convert Express Report to a standard report (this cannot be undone) |=*
Advanced
X Cancel £ Previous Mext |:| Save and Close

Advanced Reports

The New Advanced Report Wizard is an interactive tool which will walk through the process of creating a new report. All
of the selections made in the New Advanced Report Wizard can be modified in the Report Designer after the report is
created.

To navigate the wizard, either click the desired tab or use the buttons at the bottom.

New Standard Report N0

Complete the steps in the wizard below to create a new report
Name Categories Sorts Filters Layout

Enter a description for the report

¥ cancel Previous Next > [ Finish

The New Report Wizard has five sub-tabs. The Name and Categories tabs must be completed while the other tabs are
optional.

Name Tab
In the Name Tab, enter a report name and click on the Folder where the report will be saved.
The report name can be up to 255 characters. Avoid special characters suchas ? : / \ * " <>,

The report’s description appears at the bottom of the Main Menu when it is selected. The description text is also used
when searching for a report.

Note: You cannot create a report inside a folder that is read-only ().

116 of 168



Advanced Reports User Guide

Mew Standard Report »0

Complete the steps in the wizard below to create a new report

MName Categories Sorts Filters Layout

Enter the report name

[New Report]

Select folder for the report

> Customer Reports
» Order Details 2016

» Report Examples

» Sales Reports

Enter a description for the report

¥ Cancel Previous Mext > f# Finish

Categories Tab

In the Categories Tab, select the Data Categories that you would like to have access to on the report. It is important
to understand two terms: Data Category and Data Field.

Data Category

A Data Category is a data object that has several attributes. E.g, Students is a category; each student has an ID, a
major, an adviser etc.

Data Field

A Data Field is a single attribute within a category. E.g., Students.ID is the numeric value that identifies a specific
student.

New Standard Report X0

Complete the steps in the wizard below to create a new report

Name Categories Sorts Filters Layout

Select categories to include on report

Suppress
Search. .. Duplicates
J Categories %
(] Products %

Category Name

» Adventureworks

» Exago University
OrderDetails

Suppliers

+ g @

X Cancel < Previous Next > f# Finish

e To add a Data Category, either drag and drop it to the ‘Category Name’ Column, use the button, or double-click
the field.
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e To search for a specific Data Category or folder, type its name into the Search box.
e To see what Data Fields are in a Data Category click the information button ('ﬂ).

User Guide

e Check the ‘Suppress Duplicates’ box to prevent duplicate information from appearing on the report.

e To remove a Data Category click the delete button ().

Sorts Tab

In the Sorts Tab, specify which Data Fields will be used to determine the order of data on the report.

New Standard Report

Complete the steps in the wizard below to create a new report
Name Categories Sorts Filters Layout
Select sort fields

Sort By
Categories v % Categories. CategoryName

CategorylD
CategoryName

Description

== Add

X Cancel < Previous Next >

e To sort by a Data Field, either drag and drop it to the ‘Sort By’ Column, use the button,
e You can sort each Data Field in ascending (A- Z, 0-9) or descending (Z-A, 9-0) order.

e Use the up (“*) and down (™) arrows to indicate the sort priority.
e To remove a sort click the delete button (*).

Filters Tab

In the Filters Tab, create statements that will be used to filter the data when you execute the report.

MNew Standard Report

Complete the steps in the wizard below to create a new report

Name Categories Sorts Filters Layout
Select fitter fields to include on report
Filter By
Categorles M % Categories. CategoryMame
CategorylD
CategoryName
Description
Picture
Equal Te -
AND With Next Fiter ~ | Beverages
Condiments
] Group With Next Fitter Confections
== Add ] Prompt For Value Dairy Products
Grains/Cereals
SUMMARY Meat/Poultry
Categories. CategoryMame =" Produce
Seafood
X Cancel < Previous Next >

4 ?)

Sort Order

Ascending v A v X

% Finish

or double-click the field.

NO

F# Finish
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There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimal places) or
alphanumeric.

To filter a Data Field, either drag and drop it to the ‘Filter By’ column, use thebutton, or double-click the field.
Use the up (“*) and down (™) arrows to indicate the filter priority.

To remove a filter, click the delete button ().

Set the operator (equal to, less than, one of, etc.) by selecting it from the operator drop-down.

Set the filter value by either entering it manually or selecting a value from the drop-down. If the Data Field is a
date, the calendar and function buttons can be used to select a value.

Select ‘AND With Next Filter’ to require that the selected filter and the one below both evaluate to true. Choose
'OR With Next Filter’ to require that either be true.

Check ‘Group With Next Filter’ to specify the precedence of the filters. Filters can be nested indefinitely by using
the following keyboard shortcuts while a filter is selected:

o Ctrl + [ adds an open-parenthesis before the selected filter.
o Ctrl + ] adds a close-parenthesis after the selected filter.
o Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
o Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.
Check ‘Prompt for Value’ to allow the filter to be modified at the time the report is executed.

Layout Tab

In the Layout Tab, select the Data Fields that will appear on the report. For each Data Field chosen, the report will

auto
total

matically create a column header and place the Data Field in the detail section. Additionally, subtotals, grand
s, and a page header/footer can be created.

*

New Standard Report Getting Started .4 7]

Complete the steps in the wizard below to create a new report

Dis

Name Categories Sorts Filters Layout

Select fields to include on report

Data Field Summary Function
Categories ¥ ¢ Products Productiame fx Mene v A X
CategorylD ¢ Products ProductiD fx None v A X
CategoryName ¢ Products. UnitPrice fx Mene v A X
Description % Products QuantityPerUnit fx None v X
Picture -
Summarize By
Categories
& Add ¥ Page Header Page Footer Grand Total
Standard
ProductMame ProductlD UnitPrice QuantityPerlInit
ProductMame 1 ProductlD 1 UnitPrice 1 CuantityPerUnit 1
ProductMame 2 ProductlDl 2 UnitPrice 2 CQuantityPerUnit 2
ProductMame 3 ProductiD 3 UnitPrice 3 CQuantityPerUnit 3
ProductMame 4 ProductlD 4 UnitPrice 4 CuantityPerUnit 4
¥ Cancel £ Previous Next % Finish
play Data
. . ) . - = Add
To place a Data Field on the report, either drag and drop it to the ‘Data Field’ column, use the button, or

double-click the field.

Use the up (“*) and down () arrows to indicate the order the Data Fields should appear on the report. The
Data Field at the top will appear on the report as the leftmost column.

The Summary Function column is used to make subtotals and grand totals.

To remove a Data Field, click the delete button ().

User Guide
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Using the ‘Summarize By’ box, you can display subtotals, grand totals, or headers for each unique value of a Data Field.

Sub-Totals and Grand Totals

e To display subtotals, check the box of the category you want subtotals for in the Summarize By box. Then for
each Data Field you want totaled, select a Summary Function (see below).

e To display grand totals, check the Grand Total box. Then for each Data Field you want totaled select a Summary
Function (see below).

Summary Functions:

o Sum: Totals the all of the data in the Data Field.

o Count: Returns the number of rows in the Data Field.

o Average: Takes the mean of the data in the Data Field.
o Minimum: Displays the lowest value in the Data Field.
o Maximum: Displays the highest value in the Data Field.

Data Headers

A check box will appear in the Summarize By box for each Data Category in the Sorts Tab. To display a header for each
value of a Data Field, click on the associated Data Category in the Summarize By box. Click the Data Category name
next to the checkbox, and the Header Menu will appear.

e To include a Header, check the box ‘Include Header at the beginning’. In order to select the text that will appear

as the header value, use the Header drop-down to select a Data Field or use the Formula Editor Button (f‘) to
create a formula.

e Use the ‘Summarize by each unique’ dropdown to specify if the header should repeat based on a specific field or
fields within a Category.

e Check the box ‘Include Total at the end’ to have a subtotal created for this Category.

Summarize By

Summarize by each unigue:
Categories hd

Space

¥ Add space before each unigue item

Header
¥ Include Header at the beginning

Header Text:
Categories. CategorylD  ~ fu

Total

# Include Total at the end

Page Header

To display information on the top of each page, click ‘Page Header’ below the ‘Summarize By’ box. A Page Header Menu
will appear.

Summarize By

¥ Page Header Page Footer Grand Total

e Check the box ‘Include Title at the top of every page’ to display the name of the report on each page. If an
image is also included, use the position dropdown to set where the title should appear and the number of columns
it should span.

e Use the ‘Change Image’ button to upload an image to display at the top of each page. If a title is also included,
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use the position drop-down to set where the image should appear and the number of columns it should span.

Title

#| Include title at the top of every page
Paosition: Number of columns to span:

Left ~ 4

Image

Include image at the top of every page |

Paosition: Number of columns to span:
Rightv| |1 /

k] change Image

Footers

To display information on the bottom of each page, check the ‘Page Footer’ box below the ‘Summarize By’ box. Click on
'Page Footer' next to the box, and the Page Footer Menu will appear.

Summarize By

Page Header ¥ Page Footer Grand Total

e Check the box ‘Include page number at the bottom of every page’ to display the page number on each page. If
an image is also included, use the position dropdown to set where the page number should appear and the
number of columns it should span.

e Use the Change Image button to upload an image to display at the bottom of each page. If the page number is
also included, use the position dropdown to set where the image should appear and the number of columns it
should span.

Page Number
¥ Include page number at the bottom of every page

1 Position: Mumber of celumns to span:

Left 4

i —Image

Include image at the bottom of every page

Position: Mumber of celumns to span:
Right~| |1 /

kd Change Image

Preview

At the bottom of the Layout Tab, a preview will display how the report will appear based on the fields that have been
added. You can increase the size of the preview or hide it all together by dragging or clicking the re-size button (

.- ).

User Guide
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— 1

ProductMame ProductlD UnitPrice QuantityPerlInit
ProductMame 1 ProductlD 1 UnitPrice 1 CuantityPerUnit 1
ProductMame 2 ProductiD 2 UnitPrice 2 CQuantityPerUnit 2
ProductMame 3 ProductiD 3 UnitPrice 3 CQuantityPerUnit 3
ProductMame 4 ProductiD 4 UnitPrice 4 CQuantityPerUnit 4

Page Number

¥ Cancel < Previous Mext f# Finish

CrossTab Reports

The CrossTab Report wizard is an interactive tool which will walk through the process of creating a new CrossTab
Report. All of the settings in the CrossTab Report wizard can be modified in the report designer after the report is
created.

To navigate the wizard, either click the desired tab or use the buttons at the bottom.

The CrossTab Report wizard has four subsections: Name, Categories, Filters, and Layout. The Name,
Categories, and Layout sections must be completed in order to create a CrossTab Report.

Name Section
In the Name section, enter a report name and click on the Folder where the report will be saved.
The report name can be up to 255 characters long. The following special characters may not be used: ? : /\ * " <>

A report’s description appears at the bottom of the Main Menu when it is selected. The description text may also be
used to search for a report.

Note: You cannot create a report inside of a folder that is read-only ().

Complete the steps in the wizard below to create a new report

Name Categories Filters Layout
Enter the report name
Products Ordered per Month

Select folder for the report
> & Products

> = Reporting

> = Test

Enter a description for the report
CrossTab Report displaying the amount of times a product was ordered per month.

Next Cancel

Categories Section

In the Categories section, select the Data Categories that you would like to have access to on the report. It is
important to understand the difference between Data Categories and Data Fields.

Data Category:

A Data Category is a data object that has several attributes. For example, Students is a category; each student has
an ID, a major, an advisor, etc.

Data Field:

A Data Field is a single attribute within a category. For example, Students.ID is the numeric value that identifies a
specific student.
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Complete the steps in the wizard below to create a new report

Name Categories Filters Layout
Select categories to include on report
Suppress
Search... Duplicates Category Name
Categories x
Products
OrderDetails x
N
+ A + ()
Previous Next Cancel

The following actions may be preformed within the Categories section:

To add a Data Category, either drag and drop it to the Category Name Column, use the +Add button, or
double-click the field.

To search for a specific Data Category or folder, type its name into the Search box.

To see what Data Fields are in a Data Category, click the information O button.

Check the Suppress Duplicates box to suppress duplicate information from appearing on the report.

To remove a Data Category, click the delete button ().

Filters Section
In the Filters section, create statements to filter the data at runtime.

Complete the steps in the wizard below to create a new report

Name Categories Filters Layout
Select filter fields to include on report
Filter By Title

Orders ¥ % =Vear({Orders OrderDate)) fe nov X
CustomeriD
EmployeelD
Freight
OrderlD
RequiredDate
ShipAddress

ShipCity

Is Between v 2015

AND With Next Filter v

ShipCountry 2016

o Add
SUMMARY
=Year({Orders OrderDate}) Is Between 2015 And 2018

Group With Next Filter

== Add Formula Prompt For Value

Previous Next Cancel

A date filter applied to output data from the years 2015 to 2016

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or
alphanumeric.

The following actions may be performed within the Filters section:

To filter a Data Field, either drag and drop it to the Filter By column, use the +Add button, or double-click it.

To filter a Data Field using a custom or built-in Exago formula, click the +Add Formula button (v2018.2+). For
more information, see the Filter by Formula article.

Use the up (“*) and down () arrows to indicate the filter priority.

To remove a filter, click the delete button ().

Set the operator by selecting it from the operator drop-down.

Set the filter value by either entering it manually or selecting a value from the dropdown. If the Data Field is a
date, the calendar and function buttons can be used to select a value.

Check Prompt for Value to allow the filter to be modified at the time the report is executed.

Select AND With Next Filter to require that the selected filter and the one below it both evaluate to true. Choose
OR With Next Filter to require that either be true.

Check Group With Next Filter to specify the precedence of the filters. Filters can be nested indefinitely by using

User Guide
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the following keyboard shortcuts while a filter is selected:

o Ctrl + [ adds an open-parenthesis before the selected filter.

Ctrl + ] adds a close-parenthesis after the selected filter.

o Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
o Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.

o

Layout Section

In the Layout section, design the CrossTab by moving Data Fields into the Row Header, Column Header, and
Tabulation Data panels.

Complete the steps in the wizard below to create a new report
Name Categories Filters Layout

Row Header Source

Orders Categories CategoryName fo s

CustomerlD Products ProductMame fr #F

<<

EmployeelD
Freight

OrderDate Column Header Source

A4

RequiredDate =MonthName({Orders. OrderDate}) fx £ A
ShipAddress

ShipCity

ShipCountry Tabulation Data Source

ShipName Orders.OrderlD fr £ v X
ShippedDate

ShipPostalCode

ShipRegion

+= 4+l +H Theme: Peterbook v = Options

Orderdate | OrderDated [ Onderdaiez
CatogoryName ProduciName OrderDots (OrderData 1 OrderDate 2 OrderDate 1 OrdorDate 2

CategoryName 1 ProductName 1 2 86 0 96
ProductName 2 45 50 67 39
CategoryName 2 ProductName 1 T8 85 80 2
ProductName 2 47 92 72 98

Previous Cancel

Row Headers

Row Headers expand a CrossTab vertically. A CrossTab has a row for each unique value of a Row Header. For
example, if you were using sales data, you may have the Row Headers Category.CategoryName and
Products.ProductName to provide rows for each product grouped by category.

The following actions may be performed on Row Headers:

e To add a Row Header, either drag and drop it to the Row Header Source panel or use the Add Row Header + =
button .
e Click the Formula Editor f* button to insert a formula into the Row Header.

e Click the Edit Header /s button to open the Header Options menu. In the Header Options menu, you can:

o Set a label for the Row Header. This label will appear at the top of the CrossTab.
o Select a sorting method and direction:
= None: Does not sort the Row Headers.
m Header Value (Text): Sorts the Row Header by its values as though they are text.
m Header Value (Number): Sorts the Row Header by its values as though they were numbers.
m Tabular Totals: Sorts the Row Header by the totals of the Tabulation Data.

Note: If there is more than one Row Header, the Header Options menu for the topmost Row Header will have
Options for subtotals of Tabulation Data.
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o Select where to display subtotals by using the Placement dropdown:

= None: Does not display subtotals.

= Top: Displays subtotals above the Tabulation Data for each Row Header value.
m Bottom: Displays subtotals below the Tabulation Data for each Row Header value.

o Set a label for the subtotals.

e Use the up (”*) and down (™) arrows to rearrange the order of the Row Headers.

Header Options

General Options
Label
Category

Sort Options
Method Direction

MNone v Ascending

Total Options
Placemnent Label
MNone v Total

m Caﬂce"

e To remove a Row Header, click the delete button ().

Column Headers

L

User Guide

Column Headers expand a CrossTab horizontally. A CrossTab has a column for each unique value of a Column Header.

For example, if you were using sales data you may have the Column Headers Year({Order.OrderDate}) and
MonthName({Orders.OrderDate}) to provide columns for each month grouped by year.
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Name Categories Filters Layout
Row Header Source
Orders v
CustomeriD
EmployeelD
Freight
T
OrderlD =Year({Orders.OrderDate}) fi £ A X
RequiredDate =MonthName({Orders. OrderDate}) fi £ A v X
ShipAddress
ShipCity
ShipCountry Tabulation Data Source
ShipName
ShippedDate
ShipPostalCode
ShipRegion
+= +II +H Theme: Peterbook ] = Options
OncerDate  omedaez
OnderDate OrderDate 2 OrderDate 1 OrderDate 2
row 1 a1 a1 7 47
row 2 6 63 32 71

e To add a Column Header, either drag and drop it to the Column Header Source panel or use the Add Column
Header + Il button.

e Click the Formula Editor f* button f* to insert a formula into the Column Header.
o Click the Edit Header #" button to open the Header Options menu. In the Header Options menu, you can:

o Set a label for the Column Header to appear at the top of the CrossTab.
o Select a sorting method and direction:
= None: Does not sort the Column Headers.
m Header Value (Text): Sorts the Column Header by its values as though they were text.
m Header Value (Number): Sorts the Column Header by its values as though they are numbers.
m Tabular Totals: Sorts the Column Header by the totals of the Tabulation Data.

User Guide

Note: If there is more than one Column Header the Header Options Menu for the topmost Column Header will have
Options for subtotals of Tabulation Data.

o Select where to display subtotals by using the Placement dropdown:
= None: Does not display subtotals.
= [eft: Displays subtotals to the left of the Tabulation Data for each Column Header value.
= Right: Displays subtotals to the right of the Tabulation Data for each Column Header value.
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e Set a label for the subtotals.

User Guide

Header Options

General Options
Label
Year

Sort Options
Method Direction
MNone v Ascending

Total Options
Placemnent Label
MNone v Total

m Caﬂce"

L

e Use the up (”*) and down (™) arrows to rearrange the order of the Column Headers.
e To remove a Column Header, click the delete button ().

Tabulation Data

Tabulation Data provides information when data exists for both the Column Header and Row Header values. For
example, if you have a Row Header on products and a Column Header on the month, then Tabulation Data of
Orders.OrderID may use the Count function to display how many orders contained each product each month.

e To add a Tabulation Data, either drag and drop it to the Tabulation Data panel or use the Add Tabulation Data

-+ H button.

o Click the Formula Editor f* button to insert a formula into the Tabulation Data.

e Click the Edit Tabulation ’” button to open the Tabulation Options menu. In the Tabulation Options menu,

you can:

o Sum: Totals the Tabulation Data.

o Count: Counts the Tabulation Data.

o Average: Takes the mean of the Tabulation Data.

o Minimum: Displays the lowest value in the Tabulation Data.
o Maximum: Displays the highest value in the Tabulation Data.
o None: Displays the value of the Tabulation Data without applying any formula.
o Aggregate: Display the result of the selected method.
o Percent of Row: Display the result of the selected method as a percentage of the row total.

o Percent of Column: Display the result of the selected method as a percentage of the column total.

o Set a label for the Tabulation Row to appear at the beginning of each row.

Tabulation Options

General Options
Label

Tabulation Options
Method Value
Count v Aggregate v

m Caﬂce"

o Use the method dropdown to select the summary function to be applied to the Tabulation Data:
o Use the Value dropdown to select how the Tabulation Data should be displayed:

e Use the up (“*) and down (™) arrows to rearrange the order of the Tabulation Data.
e To remove a Tabulation Data source, click the delete button (*).

CrossTab Themes
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The Theme dropdown can be used to quickly style the CrossTab using a predefined theme. Further styling can be
done in the Report Designer.

CrossTab Options

Settings that affect the entire CrossTab are controlled in the CrossTab Options Menu. Open the CrossTab Options
Menu by clicking the &= Options button. Using this menu, you can adjust the following settings:

General

e Use the Row Headers Placement dropdown to determine how the Row Headers are displayed:
o Columns: Display the Row Headers in columns from left to right in the order they appear in the Row Header
Source panel.
o Hierarchical: Display Row Headers in a hierarchical structure using indentation to display their order.
e Check Repeat CrossTab Header every new page to repeat Row Header labels and Column Headers on each new
page.

Grand Total Row

e To get a total for each column, select Top or Bottom from the Placement dropdown in the Grand Total Row
section and provide a label in the Label text box.

Grand Total Column

e To get a total for each row, select Top or Bottom from the Placement dropdown in the Grand Total Column
section and provide a label in the Label text box.

Options

General
Row Headers Placement
Columns v

|#| Repeat CrossTab Header every new page

Grand Total Row
Placement Label
MNone v Total

Grand Total Column

Placement Label
None v Total

m Ca ﬂCEI‘

Preview

At the bottom of the Layout section, a preview will display how the CrossTab will appear based on the fields that
have been added.

+= <+l +HA Theme: Peterbook v = Options

Catogory Product Month Month 1 Menth 2 Month 1, Month2,

Category 1 Product 1 1 1 1 1
Product 2 1 1 1 1
Category 2 Product 1 1 1 1 1
Product 2 1 1 1 1
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A preview layout of the steps applied above

Finally, clicking the Finish button will create the report and open the CrossTab Report designer.

CrossTab Report Designer

Upon entering the CrossTab Report designer, the CrossTab Report that was created will appear in the Report Footer
of report:

5. AE @/ v IFAE =8 fEo

b . — —_

v x| B J U- A & 8 Els FEOQ Export PDF | ¥
Section A B c D

Products Ordered per Month

Page Header

W R -

Year

Category Product Mnnth-

Categories.Cat
eqgoryMame

w

Report Footer

o

Products. ProductMName Orders.OrderlD

To edit the CrossTab Report after its creation, right-click the report and click Edit CrossTab or double-click
anywhere within the report. This will open the CrossTab Data Designer window.

The CrossTab Report designer offers all of the functionality as the Advanced Report designer, including:

e Cell and report formatting and design
e Visualizations

Filtering and sorting

e Data aggregation and formula building

However, some of these features, namely visualizations and formulas, may not be added to the CrossTab Report
itself, and must be added to another section of the report. If one of these items is added to the CrossTab Report, the
following message will appear:

Toolbar item not applicable for a CrossTab related cell

CrossTab Report Formatting

CrossTab Reports often contain a large amount of information, and, as such, may appear cluttered if they are not
properly formatted. The following list contains formatting recommendations to help avoid overwhelming reports:

e Set predefined widths of rows containing long strings of characters or integers.

e Use a theme or apply color to cells via cell formatting to help differentiate between certain sections.

e Add borders via cell formatting to detail and header sections.

e Abbreviating longer strings using the built-in Exago String functions. For example,
Left(MonthName({Orders.OrderDate}), 3) will output the first three letters of each month.

e In Options > Report Viewer, deselect Simulate PDF. This will allow larger data sets to span further than the
simulated margins set by this option.

e Add filters to limit the size of the data set.

Chained Reports

Chained Reports combine multiple reports into a single multi-page document. They are a convenient way to bundle
related reports into a format suitable for printing or sending to a mailing list.
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For example, you could combine a report on total monthly sales over time, product sales for the month, and a report
highlighting this month's top selling employee. And you could schedule it to be emailed regularly at the end of every
month.

A benefit of Chained Reports is that, unless you want to use collation, they do not need to have anything in common.
You could chain entirely disparate reports together without a problem.

Dashboards are also exported in the form of Chained Reports in which each report or visualization tile is displayed on
a single page in the report. See Exporting Dashboards for directions on how to export a Dashboard as a Chained
Report.

Making a Chained Report
A Chained Report is basically a list of reports, and making a Chained Report is as simple as making a list.
To make a Chained Report:

1. Click the New Report % icon and select Chained Report. Enter a name for the Chained Report and select a
folder where it should live. It does not have to be in the same folder as the reports that it contains.

Caution: A report name cannot contain the following characters:
\/:*¥?2"<>|

2. On the Reports panel, add the reports to include in the Chained Report. Supported report types are Advanced
Reports, Express Reports, Crosstab Reports, and ExpressViews.

The order of the reports in the list is the order they will appear in the output. Click the Up “* or Down * arrows
to move a report up or down in the list. Click the Delete * icon to remove a report from the list.

3. Click the Save 2 icon to save the Chained Report.
Note about export types

If one of the reports cannot export to a certain file type, then the Chained Report cannot export to that type. All of
the reports must share at least one export type, or else the Chained Report will have no compatible type to run as.
Supported types are PDF, RTF (Word), CSV, and XLS (Excel).

Reports with templates

Template reports can be added to a Chained Report. The Chained Report must be exported to the same file type as
the template. Multiple templates of the same file type can be chained together, with the exception of Microsoft Word
based templates.

Prompting filters and parameters

If one or more reports has prompting filters or parameters, then you can set rules for what should happen when the
Chained Report is run or scheduled.

To edit a report's prompting options:
1. On the Reports panel, click the Report Options [4 icon.
2. For each prompting filter and parameter, the following options are available:
Common Prompt

All reports which contain this filter field or parameter will use the specified value. In the Data (Prompt Text or
Value) field, enter the text to prompt the user for a value.

Report Prompt

Only this report will use the specified value. In the Data (Prompt Text or Value) field, enter the text to prompt
the user for a value.

Assign Value

The Chained Report will not prompt for a value for this filter or parameter. In the Data (Prompt Text or Value)
field, enter the value to use.

Chained Report options
The Options page contains the following options:

Default Export Type
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Select the file type to which the Chained Report will export by default. Available types are limited by report export
restrictions, and by the Allowed Export Types option. HTML is not supported.

Default

User Guide

Uses the environment's default export type.

Allowed Export Types

Select which file types the Chained Report is allowed to export to. You must select at least one type.
No Data Qualified Action

If a report has no data, choose what to display:

Show Placeholder

Show the report without any data in it.

Skip Report

Show nothing, and move on to the next report.

Collate Reports on

Select whether to collate the Chained Report, and which data field to use. This option is disabled if the reports have
no common data fields. See Collating reports.

Page break after each report

Select whether to start a new page after every report. This only affects PDF and RTF files.

Collating reports

Collation breaks up the reports in the Chained Report by a specified sort field, and then groups together the reports
by each instance of the sort. Essentially, this turns a sort field into a common grouping for the reports, working in much
the same way a group section would. This can allow you to use individual reports as pieces in a composite report.

Order of reports in a collated Chained Report

Report 1, filtered by group 1

Report 2, filtered by group 1

Report 1, filtered by group 2

Report 2, filtered by group 2
and so on.

Some common uses for Chained Report collation include:
e Grouping disparate reports by order number, or employee number, or something else in common
e Combining mostly identical reports, only with different filters or joins, into a composite report

e Making a composite report with multiples of a feature which normal reports can only have one of, such as a detail
section

‘Caution: Collation is recommended for advanced users only. Dashboards do not have a collate option.

Google Maps

‘Important: For licensing and installation information, please refer to the Installing Optional Features guide.

The Google Maps wizard allows you to insert interactive maps with highlighted data into your reports. To add a map,
select a cell and press the ¥ (Google Maps Wizard) button. Geographical areas can be pinpointed or highlighted
dynamically depending on your report data.

Note: If you don't see this option, you may not have access. Please contact your administrator.
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Note: Google Maps requires an Internet connection.

The Google Maps Wizard has four tabs: Locations, Data, Appearance, and Size and Preview. You can navigate
between the tabs by clicking on the tab, or using the Previous and Next buttons.

Locations

In the Locations tab, select one or more types of locations to highlight on the map.

Map Wizard

Locations Data Appearance Size and Preview

Select location types and cell values to be used in the map.

Location Type Report Cell Value
earch lypes street address Customers_Address v X
city Customers_City v X
zipcode Customers PostalCode v
state Customers_Region v X
country Customers_ Country v X

county

Previous Next Cancel

Drag-and-drop a location type to the selection pane, double-click it, or select it and press .

Certain location types may require other types to be added or may prevent other types from being added. Press * to
remove a Location Type. For each Location Type, use the dropdown menu to select the report cell that contains the
data for that type.

Note: County and zip code are only available in the United States.

Data

In the Data tab, determine what metrics to see when hovering over a highlighted region.
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Map Wizard
Locations Data Appearance Size and Preview

Define the metrics to be displayed upon hovering over regions on the map. The primary metric will determine how the regions are shaded.

. Primary MNumber
Metric Agg. Type Labels Metric  Format
={0rderDetails. Quantity} * {OrderDetails Unithe Sum L J Revenue > H

o= Add Metric

Previous Next Cancel Finish

The Primary Metric amount is used to shade each region. Press =FAdd Metric to add additional metrics. Press X to
remove a metric.

For each Metric:

e Use the Metric dropdown menu to select the report cell that contains the data for that metric.
e Select how to aggregate the data using the Agg. Type dropdown:

Sum: Totals the all of the data in the Data Field.
Minimum: Displays the lowest value in the Data Field.

Maximum: Displays the highest value in the Data Field.
None: Displays the raw cell value of the Data Field (v2018.2+).

o
o Count: Returns the number of rows in the Data Field.
Summary o Distinct Count: Returns the number of unique rows.
) o Average: Takes the mean of the data in the Data Field.
Functions o
o
o

e Enter a label in the Labels field.
e Select whether it is the Primary Metric.
e Format the data type using the Number Format dialog.

User Guide

Note: Use the summary function "None" when you want to display a cell value within the drop pin tooltip.

Note: You cannot select "None" as the primary metric.

Hyperlinks (v2018.2+)

Using the "None" Agg. Type, hyperlinks can now be added at the drop pin level.
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Google Maps

Midval
[Back] ¥ ! A
&E‘j LdJd
@B Ethete Riverton
Fort Washakie
137
132 Arapahoe (129
789
PO. Box 555, Lander City x [0
Revenue: 512,489.70
Company: Split Rail Beer & Ale
LJM
Lizard
| Peak L
787" @9
Sand Drav
e
GO gle Map data 2018 Google Terms of Ua;—f‘Repan a map error
To do this, a hyperlink must be available for reference within the report.
Section A (Company) B (ContactMame) C (Country) D (Region) E (City) F (Address) G
1 Google Maps

Page Header

|:H},rperl'|nk("ht‘tgs:#www.googIe.Com;‘search?q:"&4Cu910mers_ComgangNameHCustomers.Comgan!Name}-}&[

Footer:
Customers.CompanyName

In this case, a Hyperlink formula referencing a Google search for the company name has been added to a suppressed
footer that has been grouped on Customers.CompanyName.

Note: Hyperlinks used for drop pins can be referenced from any section within the report; however, for dynamic
linking, hyperlink information should be referenced from the detail section or a grouped section.

The hyperlink must then be added as a Metric with the Agg. Type set to "None."

Map Wizard
Locations Data Appearance Size and Preview

Define the metrics to be displayed upon hovering over regions on the map. The primary metric will determine how the regions are shaded.

Primary Number

Metric Agg. Type Labels Metric? Format
=aggSum({{OrderDetails Quartity}*{OrderDetw Sum v Revenue . m %
=Hyperlink{"https://www.google.com/searchw Hone v Company H W

o= Add Metric

Finally, add a Label for the hyperlink and click Finish.

Appearance

In the Appearance tab, determine the appearance of the metrics on the map.
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Map Wizard

Locations Data Appearance Size and Preview

Primary Metric Colors

Linear Range Coral
Election
Forest
Show Legend
Grayscale
Lilac
Metric Levels
Calewlate Metrics Per: ©  Display Drop Pins?
[w# All Levels Yes v+ ©
[#* Country Level I I
Conditional Drop Pin Colors...
|w* State Level m P

|#| County Level
|#* Zipcode Level

Previous Next Cancel

Primary Metric Colors: Set the color range for region shading by either selecting a Theme or by setting a Linear
Range of colors.

Show Legend: Adds a legend in the bottom left corner of the map that displays a color scale for reference and the
minimum and maximum values of the currently visible regions.

Metric Levels: Select which levels to calculate metrics. Select whether to display drop pins, which will appear on city,
street address, or latitude/longitude locations.

Note: The summary function "None" requires a drop pin.

Conditional Drop Pin Colors: Dynamically modify a drop pin color based on its value (v2018.2+). This action is similar
to conditionally formatting cells in a report.

To begin, select the Conditional Drop Pin Colors option.

Metric Levels

Calculate Metrics Per ©  Displsy Drop Pins?
[ Al Levels Yes vy @
|##| Country Level

W@ State Level m Conditional Drop Pin Colors..
¥ State Level

|+ County Level
|#*| Zipcode Level

The following dialog box will open.
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Conditional Drop Pin Formatting

Color Input

Click ¥ Addto insert a new conditional statement. Select a color that the drop pin will become when a certain
condition is met.

Conditional Drop Pin Formatting

Caolor Input
#FFO000 [ | fi . mov X
#00FFOO [ ] fi A v X
o add

In this case, let's add two conditional statements using the colors red and green in order to differentiate between
companies by their revenue.

Now let's add the conditions which, if true, will cause the colors to be applied to the drop pins. Click the [fx] button to
open the Formula Editor:

User Guide

Conditional Drop Pin Formula Editor

. . Search for Functions
Conditional Drop Pin Parameters
» Logical

Street Address Value
» Date

City Value > Database and Data Type
State Value > Arithmetic and Geometric
Zipcode Value » String
Country Value » Formatting
Metric Value 2 » Financial
> Operators
o Add == Add

Revenue: Sum:
=AggSum{{OrderDetails.Quantity} *
{OrderDetails.UnitPrice})

®metric_value_ 1@ < 1868080

The left side contains a list of the Conditional Drop Pin Parameters, which include the metric values (listed in order of
their creation), and anything defined in the location tab. The right side contains all of Exago's built-in formulas. You can
drag a data field or a formula to the Formula box, or type it in by hand. The editor also supports using parameters in
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the form @ParameterName@.

In this case, we are concerned with the revenue of each company, which are represented as individual metric levels. If
we want to show green pins for high performing companies and red pins for companies at risk, we could input the
respective formulas into the editor.

Conditional Drop Pin Formatting

Color Input
#FFO000 B -armetic_valu=_1@ < 100000 fo AW X
#00FF98 =@metric_value_1(@ == 100000 fr A v %
o= Add

m Caﬂcgl‘

Note that the parameters @metric_value_1@ has been selected for conditional formatting. This is the data metric that
displays the revenue of each company, while @metric_value_2@ is the data metric displaying the hyperlink.

Since this is a Conditional Formula, we need to ensure that the formula we write will resolve to either True or False. So
the formula must contain at least one logical operator. The supported logical operators are as follows:

Operator Symbol
Greater Than >

Less Than <

Equal To =

Not Equal To 1=
Greater Than Or Equal To >=

Less Than Or Equal To <=

You can also use parentheses to indicate the precedence of the parts of your statement.

|Note: If a metric returns a null value, the metric and label are not displayed on the drop pin tooltip.

Size and Preview

In the Size and Preview tab, determine the size, initial view, and type of map to display.
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Map Wizard
Locations Data Appearance Size and Preview
Zoom and/or pan on the preview map below to specify theinitialview. .
: By i
' Double Click a Region to Drill Down £ % ra b
: ' La
' Greenland
Iceland ; Sweden
Finland
Norway, ra
i Labrador Sea ;_{ :
E L.lnited Denmark ’.. ;,.ﬂ . i
< Kingdom " Belarus .
Ireland y . Poland ! = i
 Germany | P T o
o e P Ukraine : :
Y < Romania”. P |
ltaly . r 'n,.f o S + b-
G;eeoe. ot
Portuy Turkey Y m.
North i o) =R :
& & ; i
: Atlantic ) Tunisia } :fl‘ -I 5 = fg
i G : Ocean Morocco e ARl b e :
e L Avmmdoneen e Map deta 82018 Gongle, INESI | Terms of Usa]
® Fit map to cell Set specific size Base Map Road Map¥
Previous Cancel Finish

Note: The preview uses placeholder data values. It does not reflect the actual region shading. ‘

Set the initial view of the map by panning and zooming to a location. Drag-and-drop on the map to pan. Press the
zoom buttons (#=) to zoom in or out.

To set the size, either drag-and-drop on the lower-right handle (-I:i) of the map view, or check Set specific size and
enter Height and Width values. To automatically fit the map to the report cell, check Fit map to cell.

Choose the type of map by selecting the desired type from the Base Map dropdown menu.

Press the Finish button to see the completed map on the report design grid.

Charts

Charts are a way of illustrating data in order to make it easy to spot trends and patterns. Most types of charts are
simply a collection of points on a grid, with interstitial designs and labels that make them easier to read.

By default, charts are generated dynamically, based on data points that come from Data Fields. Each data field can be
thought of as a "series" of data, which have a common association and are connected in some way. When we put one

data field on a chart, we have a single-series chart, which is useful for comparing values to each other. When we put
multiple data fields on a chart, we have a multi-series chart, which is useful for comparing trends.

Before creating a chart, make sure that your data exists in cells on the report. These cells don't have to be visible, so
you can suppress them if desired. Charts are interactive in the Report Viewer, but will appear as static images in PDF,
RTF, and Excel formats (CSV is incompatible).

To insert a chart into a report, select a Group Footer or Report Footer cell and press the il Chart Wizard button. The
Chart Wizard dialog will open.

The Chart Wizard has four tabs: Type, Data, Appearance, and Size and Preview. You can navigate between the tabs
by clicking on the tab, or using the < Previous and > Next buttons.

Chart Types

The Type Tab lays out all the available types of charts you can create. There are 20 types, sorted into five general
categories. Click on a category header to see more information about that type.
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Click on a chart for more information about each type.

Line

ANMNAY | ol adk] |
Bar and Column

—all =0 I T = LT

100 100
ol —lB- =100 NAR | B n || ILA
Pie and Other Single-Series Scatter and Bubble
w .
@ O A < || ®

Zoom Charts

Combination Charts (v2016.3+)

po

Line
Line charts display series of data points on a grid, connected by straight lines. They are often used to display a trend
over time.

Each series on a line chart is represented as a colored line. Line charts can have up to three Y-axes.

Variations:

e Spline chart - Data points are connected by interpolated curves instead of straight lines.

e Area chart - The area under each line is filled in by a color. Overlapping areas have mixed colors.
e Spline-Area chart - A combination of a spline chart and an area chart.

e Spark Line chart - Has no grid or axes. Use point labels and benchmark lines for reference.

Bar and Column

Bar charts use rectangular bars which extend horizontally left to right to show comparisons between categories.
Column charts use vertical bars which extend upward. The length of a bar represents the quantity of the data value.

Each series on a bar or column chart is represented by a colored set of bars.

Variations:

e Stacked bar/column chart - Series are stacked on top of each other, additively.
e 100% Stacked bar/column chart - Series are converted to a % of the max, then stacked on top of each other,

additively to 100%.

e Spark column chart - Has no grid or axes. Use point labels and benchmark lines for reference.

e Pareto chart - Combines a descending column chart, where each column is the next highest data value, and an
overlapping line chart, where each point is the cumulative sum to that point. Often used to highlight the most

important field in a series. Single-series only.

Pie and Other Single-Series

Pie charts are used to show the relationship of data values in a series as portions of the total. The area of each slice is
proportional to the quantity.
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Each data value on a pie chart is represented by a colored "slice". Pie charts are single-series only.
Variations:

e Doughnut chart - Pie charts with a hole in the center.

e Pyramid chart - Used to show data hierarchy in addition to value. Data values are represented by vertically
stacked slices, the height (not width) proportional to the quantity. The vertical order of the slices is determined
by the sort order.

e Funnel chart - Inverted pyramid chart. Often used to show retention amount, or stages in a process. Shape is
inverted, not data order. To change the order, swap the sort direction.

Scatter and Bubble

Scatter charts use pairs of data fields with a common relation to generate coordinates as points on a grid. They are
often used to find relationships between two variables in a set of data. Unlike most other report types, scatter charts
often map data from detail rows, instead of group rows.

Each series on a scatter chart is represented by a different shape and color combination.
Variations:

e Bubble chart - The points become circular "bubbles", with a third coordinate field as the radius of the bubble.

Zoom Charts

Zoom charts provide the ability to view data at various levels of granularity, especially when the data set under
observation is large and can be organized into layers for easier interpretation. The ability to zoom-in and zoom-out
makes it easy to view data at various macroscopic and microscopic levels.

Variations:

e Zoom Line chart - A variation of a standard Line chart with zooming as an added capability.
e Zoom Scatter chart - A variation of a standard Scatter chart with zooming as an added capability.

Combination Charts
(v2016.3+)

Combination charts are several different charts layered on top of one another. They comprise of a combination of
Column, Line, Area, and/or Stacked Column charts. (Column and Stacked Column charts are not compatible with each
other). Combination charts can have up to two Y-axes.

Data

The Data Tab is used to specify which cells to use as chart data. You can change how data is translated into points
by changing the data layout. You can also choose a sort order, as well as upper and lower boundaries for the data and
axes.

Setup the data to show in the chart
Data for Chart

¥-Axis Labels

Categories. CategoryMName v

Series Values Series Name
=aggSumi{OrderDetails. Quantity}) = | Total Quantity Sold 4
=gggSum({OrderDetails. UnitPrice}) ~  Total Sales x
+ Add Series Data Layout...

Add series to the chart by selecting a Data Field containing numeric values from the Series Values dropdown menu.
Some charts may require you to select a data field to label the X-Axis. Some charts may ask for two or three data
fields per series. The data axis is drawn automatically.

NOTE. Data is on the Y-Axis; this may not always be the vertical axis. Labels are on the X-Axis; this may not always
be the horizontal axis. Scatter charts have no labels axis, but have X- and Y- data axes.
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Add additional series by pressing the = Add Series button (disabled for single-series charts). Give a Name to each
series. Press * to remove a series.

Change the data layout by pressing the + Data Layout... button. This will open the Data Layout dialog. If you change
the data layout, this section will change for you to add either individual points, or groups of series, instead of adding
individual series. See Data Layout for details.

Other Options
Sort data by

Data Labels w | Ascending +

Exclude values less than  Exclude values greater than

- SO0on =
- SRR —

Data Axis Minimum “alue Maximum ‘alue
2400 % =
#| rlign Data Labels Across Series
Use the Sort data by dropdown to determine how series data should be ordered:

e Report Order — Use the sort order specified by the report.
e Data Labels — Sort by the label axis value, alphabetically or numerically.
e Data Values — Sort by the value of the data.

You can sort data in Ascending (A- Z, 0-9) or Descending (Z-A, 9-0) order.

Use the Exclude values fields to ignore values that are too large and/or too small.

(Grid charts) Use the Data Axis Value fields to set upper and/or lower bounds for the data axis.

(Grid charts) Check Align Data Labels Across Series if you have multiple series with data points at common intervals.

(Pie charts) Use the Other Category Percent field to group data fields with small quantities into an "Other" category.

Data Layout

Your data may not fit neatly into series. This dialog accommodates different data layouts by allowing you to select from
a couple of different ways to build a chart.

Column Based Chart is the default. This layout builds charts by taking data fields, and mapping selected values as Y-
coordinates on the data axis. Determine which values are selected by specifying a data field with a common relation as
the X-axis. This layout is useful if you want to plot one or more unrelated series in a group (e.g. Budget and Sales and
Expenditures per Store).

Use Column Based Chart if... Your report contains a group with one or more elements. For example:

Section A B C

Page Header 1 Item Total Quantity Sold Total Sales
r

Footer: Categories 2 Categories Categoryhame =aggSum({OrderDetails Quantity})  =aggSumi{OrderDetails UnitPrice})

Row Based Chart is a little more complex. This layout still uses fields as series, but all your series are a group, nested
within another group which determines the X-axis values. Data values are mapped per series per group. This layout is
useful if you want to plot two or more related series in a group (e.g. Sales per Employee per Store).

Use Row Based Chart if... Your report contains a group within a group. For example:

Section A B
Page Header 1 Item Sales per Year
Header: =Year{{Orders.OrderDate}) 2 =Year|{Orders OrderDate})
r
Footer: Categories 3 Categories Categoryhlame =aggSumi{Order Details. UnitPrice})

If you select this layout, the data selector will change to allow you to add all your series as a group, nested within an
outer group for the data labels:
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Setup the data to show in the chart

Data for Chart

Data Values

=agg3um({Order Details. UnitPrice} ) ~
Data Labels

=Year({Orders OrderDate}) -

Series Labels
Categories. CategoryMame ~

Data Layout...

Cell Based Chart is the simplest option. This layout builds charts by taking pairs of static report values, and using
them as (X,Y) or (label, value) coordinate pairs.

In order for the chart wizard to recognize report cells, they must be in Formula form, with a preceding = sign, text
surrounded by quotes, and data fields surrounded by braces { }. Examples:

e Number: =42

e Text: ="February 24th"

e Data field: ={Employees.EmployeeName}
e Formula: =Month{Orders.OrderDate}

e Math: ={Orders.UnitPrice} * 2.43

Use Cell Based Chart if... You want to build a chart point by point, and only have one data series. For example:

Section A B
1 Total Sales Item
=agg3umlif{{Categories. Categoryhame}="Beverages”, _. -
Report Footer 2 torderDetails UnitPrice), 0)) ="Beverages
3 =agg3umif{{Categories. CategoryName}="Seafood™, —Condiments"

{CrderDetails. UnitPrice}, 0}

If you select this layout, the data selector will change to allow you to add points. This layout only supports one series
of data (duplicating data labels will create duplicate axis labels):

Setup the data to show in the chart

Data for Chart

Point Value Point Label
=agg3um(if({Categories.CategoryMame}="t~  ="Beverages” .4
=agg3um{if{{Categories. CategoryMame}="t~  ="Condiments” .4
+ Add Point Data Layout...

Appearance

The Appearance Tab contains options for customizing how the chart will look.

Colors
Colors Colors
Burnt Orange ~ Linear Range v Begin #Fsacas . End #DoDCC1C D
Use 3D Style Use 30 Style

Use the Colors dropdown to select a color theme to apply to the chart. Specify a custom range of colors by selecting
the Linear Range option.

Check Use 3D Style to give your chart a three-dimensional look.

Labels
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Labels
Chart Title

Awesome Chart

Paint Labels
Series Values

Label Font

Arial

X-huis Title
Category

Legend Position

~ | Right

(3 Mumber Format... {;l Benchmark Lines...

User Guide

- s Title
Price

Chart Title - Enter the text you want to appear in at the top of the chart.

(Grid charts) X-Axis Title — Enter the text you want to appear on the X-Axis (horizontal axis).

(Grid charts) Y-Axis Title — Enter the text you want to appear on the Y-Axis (vertical axis).

Use the Point Labels dropdown to label the points on the chart:

e Series Values
e Percent of Series Values

e Data Labels

e Data Labels with Data Values

Use the Legend Position dropdown to choose where to display the legend relative to the chart.

Use the Label Font dropdown to specify the font for the labels.

Use the [ Number Format... dialog to specify how data and axis labels should be formatted:

Number Format

Format
Decimal Places Symbel

5 -
= -

#| Use 1000 Separator |,

#| Use Currency Symbol 3

Append Percent Sign

oK X Cancel

X

(Line & combo charts) (v2016.3) Use the [ chart Axes button to add and format axes:

X-Axis
Title | Item

Y-Axis Formatting

A Title
- Ais 1 alue
-AXisI Cumulative Value
== Add ¥ Axis

Y-Axis Assignment
Series Mame  Y-Axis

Series 1 T

Series 2 Yo hiE 2 e

Chart Axes

Decimal Places Symbol

5 e
= -

oK X Cancel

Use 1000 Separator |,
Use Currency Symbol 3
Append Percent Sign X

Use 1000 Separator |,
Use Currency Symbol 3
Append Percent Sign X

o Press ¥ Add Y Axis to add an additional axis. Give it a title, and use the formatting options to format the axis
labels and data labels for associated series. Press * to remove an axis.

e Y-Axis Assignment - Use the dropdown menu for each series to associate the series with an axis. Each series
will have the same format as the axis, and hiding an axis will hide associated series.
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e Press + OK when done.
Use the [ Benchmark Lines... dialog to add horizontal lines at specific sections of the chart:

Benchmark Lines

Label Value Color Line Style
Maximum Profit 250000 + #FFO000D B oasnes v
+ MNew

oK X Cancel

e Press " New to add a benchmark line:
o Label - Enter the text you want to label the line.
o Value - Set the value for where the line will display.
o Color -Specify the color of the line.
o Line Style - Solid or Dashed.
e Press * to remove a benchmark line. Press +* OK when done.

Other Features

Other Features

Font color T | X
Legend title List of Products
Font size v == Add Attribute

This section allows you to customize a variety of attributes. The following attributes are supported:

e Font color

e Font size

e Background opacity
e Background color
e Title alignment

e Title font size

e Title on top

e Legend title

e Title font size

e Show border

e Show tooltip

e Subtitle

e Subtitle font size

To add a customization, select an attribute from the dropdown menu and press =+ Add Attribute. Then enter a custom

property into the attribute field or select from the attribute dropdown menu.

Press * to remove a customization.

Size and Preview

The Size and Preview Tab allows you to change the size of the chart and preview any customizations.

‘NOTE. Chart previews in the Wizard and on the Design Grid use placeholder data.

User Guide
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Awesome Chart

13,500

B.843 ~
| List of Products !
' & ltem 1 |
| & Item 2 !
E ltem 3 i
E ltemn 4 i
47Ty 11,525
LW e NN e ee e ee e e e W e ;'E!

Resizing handle
Fitto Cell @ Setspecific size Height 263 % Width 801 =

You can change the size of the chart in one of three ways:

e Drag-and-drop the handle .0 at the bottom-right corner.
e Check Fit to Cell and resize the chart cell on the Design Grid.
e Check Set specific size and enter a custom Height and Width (in px).

Chart Data Layout Types

Charts illustrate our data to us so that we can spot patterns and trends easily, but it's important to remember that a
chart is simply a collection of points on a grid. Each point has its label (typically along the x axis) and its value
(typically along the y axis).

There are several ways to represent this collection of points on a report, and the application must be able to transform
them into a chart regardless of the design you've chosen. For this reason, the Chart Wizard comes with three Data
Layout Types. Understanding the way you've designed your report and data will help you select the right Layout Type,
which will in turn tell the application how to transform your data into a chart.

Note: Chart Data Layout Types were introduced in v2016.1 and are named Layout One, Layout Two, and Layout
Three until v2016.3, when they are renamed Cell-Based Chart, Column-Based Chart, and Row-Based Chart,
respectively.

Layout One: Cell-Based Chart

Layout One is for building a specific type of single-series chart using a collection of static points on your report. This
layout type is cell-based because each point's labels and values come from a specific cell in the report output.

How do I know this is the right Layout for me?

Take a look at your report design and determine whether the points you're interested in charting are static or dynamic.
In the application, a dynamic data point is one that comes from a field. Fields are denoted by a little triangle in the
upper left-hand corner of the cell.

Footer:
Employees.Full.. 4 Employees.FullName

In the example above, any data points coming from this cell will be dynamic because the cell contains a dynamic field
(see the triangle in the blue box). The Employees.FullName field is a placeholder for all the employee names that will
appear on the report. These names will be added to the report dynamically after you're done designing it and have
clicked the "run" button.

Static data points, by contrast, are defined explicitly in the report design and do not contain dynamic fields.
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Data Layout 1
Minimum Delivery Average Delivery Time Maximum Delivery
Time (days) (days) Time (days)
Label Value Label Value Label Value
First Point Second Point Third Point

In the above example, every cell contains a static value. The first, third, and fifth cells each contain a string formula
that will return the text inside the quote marks. No matter what section these formulas are in, they will only ever return
their respective strings of text. The second, fourth, and sixth cells contain calculation formulas returning a static value,
in this case the minimum, average, and maximum number of days it takes to ship an order, respectively. When we chart
this data, we'll need to use Layout One in order to pinpoint each of these cells and define them as either data labels or
data values. In this case, the string formulas will serve as the labels, and the calculations will be the values. Together,
they make up three sets of coordinates on the chart.

How would that look in the Chart Wizard?

Type Data Appearance  Size and Preview

Setup the data to show in the chart

Data for Chart
Point Yalue Point Label
=aggmin(datediff{'d,{Orders.OrderDate}{Ord~  =Minimum Delivery Time (days)’ -
=aggavg(datediffi'd’ {Orders.OrderDate} {Ord~  =Average Delivery Time (days)’ -
=aggmax(datediff{'d {Orders.OrderDate} {Ore~  =Maximum Delivery Time (days)’ -
o= Add Point
Data Layout...
What would the final report design look like?
Section A B (OrderDate) C D E F
Page Header 1 Data Layout 1
- : =aggmin{datedifi(d’, . —aggavg{datedifi(d’, ='Maximum =aggmax(datediff("d"
P —'Minimum Delivery| {Orders.OrderDate},| ='Average Delivery = {Orders.OrderDate}, Delivery Time {Orders.OrderDate},

Time (days)' {Orders. .S}I;;ppednate Time (days)' {Orders. .S}I;:ppedﬂate ( y {Orders.Shi iDate}))

Aggregates of Shipping Times
Number of Days from Qrder to Shipped!

Report Footer

Number of Days

Item 1 Item 2 Item 3

How would the output look?
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Data Layout 1

Minimum Delivery Average Delivery Time Maximum Delivery

Time (days) (days) Time (days)

Aggregates of Shipping Times
Number of Days from Order to Shipped!

Number of Days

Maximum Delvery Time (days)

Mininnum Delivery Time [days) Average Delivery Time (days)

Layout Two: Column-Based Chart

Both Layout Two and Layout Three are for creating single and multi-series charts, but there are some important
differences in the report designs they work with. Layout Two is great if you want to show two or more unrelated values
for a single label. Values may be considered "unrelated" if they come from separate fields or columns. This layout is
column-based because each column will add a new series of data to the chart.

How do I know this is the right Layout for me?

First, make sure you're working with dynamic data points. Second, make sure you're interested in calculations for
just one group. If you have two columns representing values you'd like to plot against a column representing your
labels, you're in the right place!

Data Layout 2

Employee Name: Years Employed: Sales Made: Revenue Generated:
Buchanan, Steven §$7557 .
Callahan, Laura $13330
Davolio, Nancy $202.14
Dodswaorth, Anne $82.96 Static
Fuller, Andrew $177.75 Series
King, Robert $141.30 Labels

$213.05
$250.19
7820

Leverling, Janet
Peacock, Margaret
Suyama, Michael

Label First Value Series Second Value Series Third Value Series

In the example above, each column becomes a new series charted against the label column. Since all the labels come
from a single column, we know to use Data Layout 2. Another indication that Layout Two is correct to use in this case
is that the series labels are static values rather than dynamic values that are part of the data fields.

How would that look in the Chart Wizard?
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Type Data Appearance  Size and Preview

Setup the data to show in the chart

Data for Chart

X-Axis Labels

Employess FullMame ~

Series Values Series Mame

=DateDiff(yyyy {Employees HireDate} Mow()~ | Years Employed x
=aggdistinctcount({{Orders.OrderlD}) ~  Orders Made x

=aggsum({OrderDetails Revenue})/ 1000 ~  Revenue Generated (intl

o= Add Series
Data Layout...

The Chart Wizard makes it easy to see the how this Layout is all about adding values to a given label.

It helps a lot if your calculations are also in the same numeric range. For example, charting tree height (0 - 50 feet) on
the same y axis as tree species population in a forest (0 - 50,000 trees) will make it hard to read smaller values. If your
values aren't in the same numeric range, you can add one or more y axes in different numeric ranges on the
appearance tab. Note: this feature is only available as of v2016.3; see Charts for more information.

What would the final report design look like?

Section A (FullName) B

Page ol | | Data Layout 2

2 Employee Mame: Years Employed: Sales Made: Revenue Generated:
Footer: g

=DateDifi(yyyy’, =aggdistinctcount{{Orders.Order] =aggsum({{OrderDetails. Revenu
3
Employees.FullN.. Employees.FullName Employees HireDate} Now eH1000

Employee Sales

||. “Years Employed

||. Crders Made

Report Footer 4

Ith Revenue Genersted (in thousands)

Itarm 1 Itern 2 Itern 3

Itarm 4

In this example, the label field is in cell A3, and the three value fields are in cells B3, C3, and D3, respectively.

How would the output look?

User Guide
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Data Layout 2

Employee Name: Years Employed: Sales Made: Revenue Generated:
Buchanan, Steven $7557
Callahan, Laura $13330
Davolio, Nancy $202.14
Dodsworth, Anne 582 96
Fuller, Andrew $177.75
King, Robert $141.30

$213.05
$250.19
7820

Leverling, Janet
Peacock, Margaret
Suyama, Michael

Employee Sales

|I. “fears Employed
|I. Orders Made

il Revenue Generated (in thousands)

Buchana Callahan, Davolio, Dodswort  Fuller, King, Levering, Peacock, Suyama,
n, Stewen Laura Mancy h, Anne  Andrew Robert Janet Margaret Michael

Layout Three: Row-Based Chart

Layout Three is also for building single and multi-series charts, but when used to create a multi-series chart, it requires
a bit more prep on the design end because it compares two or more related values for a given label. Values can be
considered "related" when they come from the selfsame column or field. This layout is row-based because all series are

coming from the rows of one column of data.

Data Layout 3

Lables Series Lables Values
Buchanan, Steven Year: Revenue:

«+—35eries 1: all red rows

Callahan, Laura Year: Revenue:

=%— Series 2: all orange rows

Davolio, Nancy Year: Revenue:

-+— Series 3: all gold rows

In the above example, the series labels all come from the same column and are dynamic values coming from a data
field. Each unique value coming from that field, in this case Year, will become a new series.

How do I know this is the right Layout for me?

First, make sure you're working with dynamic data points. Second, make sure you have one group nested inside
another. (See Understanding Sorting and Grouping for more information.) If you want to create a multi-series chart and
you want to show a calculation per a group per another group, Layout Three is the setting you want.
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Still unsure? Here's a simple verbal test to show whether you're looking for Layout Two or Layout Three when you build
your multi-series chart. Which group of statements sounds truest to your case?

Group A

e [ want to show income per employee per year.
e [ want to show number of ad sales per sales rep per publication.
e I want to show amount donated per donor per month.

Group B

e I want to show the number of staff and students for each school.
e I want to show the sales and expenditures and remaining budget for each store.
e I want to show the average number of sales and the average number of calls for each sales rep.

If your case is more like Group A, you're looking at Layout Three. If your case is more like Group B, you'll want to go
with Layout Two.

How would that look in the Chart Wizard?

Type Data Appearanc:

Setup the data to show in the chart

Data for Chart

Data Values

=aggsum({OrderDetails Revenue}) ~
Data Labels

Employess FullName ~

Series Labels
=year({Orders.OrderDate}) -

Data Layout...

What would the final report design look like?

In this example, I want the report to show revenue per category per year. I've made this possible by nesting a Year
group inside a Category group. (CategoryName is the primary sort, and Year is the secondary sort.)
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Section A (FullName) B c D E
Page Header L Data Layﬂut 3
2
Header: 3 'E . R
Employees. FullN. mployees FullName Year: Revenue:
([ || L

=aggsum({Orde
rDetails.Reven

Footer:

yeariionms0. *  Employees FullName =/eanioraersor

derDate}) ue})
5
Employee Sales
$50.00
540,00 -
$30.00 - ;
Report Footer thy Series 1
||. Seres 2
$20.00 - il Series 3

510,00 -

50.00
ltern 1 ltem 2 ltem 3 ltarm 4

How would the output look?

Data Layout 3

Employee Sales

5140,000.00
%112,000.00
584,000.00 th 2012
th 2015
556,000.00 il 2018
52£,000.00
50.00
Buchana Csllahan, Dawvolio, Dodswort Fuller King, Levering, Peacock, Suyama,
n, Steven  Laura Mancy  h, Anne  Andrew  Rober Janet  Margaret  Michas!

GeoCharts

|Important: For licensing and installation information, please refer to the Installing Optional Features guide. ‘

A GeoChart can be displayed in a report to give a visual representation of geographic data. To insert a GeoChart, select
a cell and click the GeoChart Wizard button (@'). The GeoChart Wizard has three tabs: Type, Locations, and Data.

|Note: GeoCharts should only be placed into a Group Header, Group Footer, Report Header or Report Footer section. ‘

Type
In the Type Tab, select the initial view, size, colors, and where to display the legend.

e Use the Initial View dropdown to select the location that initially displays on the map. You may either select the
world, a continent, or a country.
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e There are three ways to set the size of the map.
o Enter the height and width in the dimension boxes.
o Resize the chart by dragging the lower right corner in the preview.
o Check the box ‘Fit to Cell'.

e In the Color dropdown, either select a color theme or specify a linear range of colors.
e Check the 'Show Legend’ box to display the legend.

Type Locations Data
Initial View
United States w

Dimensions
Height Width
400 = 600 = Fit o Cel

Colors

Peterbook s

¥ Show Legend

Locations
In the Locations Tab, specify which geographic locations should display on the map.

e Use the Location Values dropdowns to select the cells that contain the geographic information for the Map. To
utilize Region information, such as states/provinces, Country information must be provided. Similarly, City
information requires Region and Country information.

e The ‘Show last Location type as’ dropdown specifies how to display the lowest level of information. You can
either select circular markers (see image in Data tab) or shaded geographic regions (see image below).

Map Wizard X
Type Locations Data
Add data fields to specify which lecations to map
Location Type Location Values
Country Customers. Country v
Regicn Customers.Region »
City Customers. City v
Show last location type as
Markers ~
Data

In the Data Tab, specify which data determines the color of each country/region/city and the size of each marker.

For each Data Value:

e Use the Data Values dropdown to specify which cells on the report should be used to determine the color and the
size of each marker. Setting a cell for the size of marker is optional.

e Enter a label in the Data Labels column. Labels will appear in the hover effects of Dynamic Maps.

e Use the Aggregation dropdown to select a method to perform on the data.

o Sum: Totals the Data Value for each location.
o Count: Counts all instances of the Data Value for each location.
o Distinct Count: Counts all unique instances of the Data Value for each location.
o Average: Takes the arithmetic mean of the Data Value for each location.
o Minimum: Displays the lowest value in the Data Value for each location.
o Maximum: Displays the highest value in the Data Value for each location.
e Use the Display Format dropdown to specify how to display the data.
o Default: Displays the values without any formatting.
o Currency: Prepends the currency symbol on the values.

User Guide

152 of 168



GeoCharts

o Percent: Multiplies the Data Value by 100 and appends a percent symbol (%) to the values

o Scientific Notation: Displays the values in scientific notation.

e For each Data Decimal Places: the number of decimal places to display.

ype

= Ex. If Decimal Places are set to 2 then 123.45 would appear as 1.23 E2.

Locations Data

Add data fields to specify which data to display with each location, and how it aggregates

Color of Locations

Size of Markers

Example

Data Values
Customers. CompanyMame
Crders.OrderlD

Take the following report as an example.

Section

Page Header

Dietail

A

A B

Company Name Region
'Cusiomers.CompanyN ame 'Custc-mers.Reg ion

~ MNumber Of Customers
~ MNumber of Orders

C

Map Example

Country
'Customers.t:ountry

Data Labels

Aggregate Type Display Format

Distinct Count  ~ Default ~ 0

Distinct Count  ~ Default ~ 0
D E
City Order ID
'Customers.t:ity TOrders.OrderlD

Decimal
Places

User Guide

The subsequent steps show how to create a GeoChart in this report. The map will be colored based on the number of
customers in each location and the markers will be sized based on how many orders have been placed in each location:

e Add a Report Footer section to the report, select all the cells in the Report Footer and click the |:|merge cells
button.

e Select the merged cell and click the ) GeoChart Wizard button.
e In the Type tab:

o Set the initial view, size, and color.

e In the Locations Tab, set the field Customers.Country for Country information, Customers.State for Region,

Type Locations Data
Initial Wiew
United States ~
Dimensions
Height Width

400 % 600 =

Colors

Peterbock h

¥ Show Legend

Fit to Cell

and Customers.City for City information. Set the ‘Show last location type as’ dropdown to Markers.

Type

Locations Data

Add data fields to specify which locations to map

Location Type

Country
Regicn
City

Customers. Country
Customers. Region
Customers. City

Show last location type as

Markers +

Map Wizard

Location Values

£
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e In the Data Tab:
o Set the field Customers.CompanyName for Color of Locations. Provide a label such as ‘Num. of
Customers’ and set the Aggregate Type to Distinct Count.
o Set the field Orders.OrderId for the Size of Markers. Provide a label such as ‘Num. of Orders’ and set the
Aggregate Type to Count.
Map Wizard X

ype Locations Data

Add data fields to specify which data to display with each location, and how it aggregates

Data Values Data Labels Aggregate Type  Display Format D;;’g::l
Color of Locations  Customers.CompanyMame ~ Customers Distinct Count  ~ Default ~ 0 ~
Size of Markers Crders. OrderlD ~ Orders Count w Default ~ 0 ~

e Click Finish and run the report.

Report Designer:

Note: In the report designer, the GeoChart is always represented by the same image regardless

of the size, color, or
world view of the map that will be generated on the report.

Section A B C D E
1 Map Example
Page Header 2
3 Company Name Region Country City Order ID
Detail 4 'Customers.tompanyrdame 'Cusdomersﬂe-gion 'Customers.tountry 'Customers.t'rty orders. OrderlD

Report Footer 5

Report Viewer:
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Gauges
WY
Customers: 1
Orders: 38
s
17—
Gauges

A Gauge can be displayed in a report to give a visual representation of the scale of a value. To insert a Gauge, select a
cell and click the Insert Gauge button (m). The Gauge Wizard will appear. The Gauge Wizard has two tabs: Appearance
and Data.

‘NOTE. Gauges can be placed in any section of the report.

Appearance
In the Appearance Tab, select the Type and Dimension of the Gauge.

Type - Select the icon representing the type of gauge. Available types include: Angular, Linear, Bulb, and
Thermometer.

There are three ways to set the size of the Gauge.

e Enter the height and width in the dimension boxes.
e Resize the gauge by dragging the lower right corner in the preview.
e Check the box ‘Fit to Cell'.

Note: Angular gauges have a minimum width of 120px.
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Gauge Wizard X

Appearance Data

Type -

fA 'l eo |§

Dimensions

Height Width

150 = 794 = || Fitto Cell

-
¥ Cancel Previous Next > f# Finish
! 2,875.84 !
3,150
Data

In the Data Tab, select the Data Values and Color Ranges for the Gauge.

e Use the Data Values dropdown to select the cell that contains the numeric value for the Gauge.

e Use the 'Provide range as’ buttons to specify if the Min and Max values for the Gauge should be static numbers or
come from cells on the report.

e In Color Ranges, use the ‘Color By’ buttons to specify if color ranges should be percentages of the Max value,
static numbers, or come from cells on the report.

|NOTE. Percent Color Ranges must be in ascending numeric order. ‘

Add ¥ R
e Use the Add ( + ) and Remove ( smove ) buttons to create additional colors.

|NOTE. Thermometer Gauges can only have one color. ‘

To change a color either use the drop-down (. =) or enter a Hex value.
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Gauge Wizard x

Appearance Data

Value and Range "
=Agg3um({OrderDetails Quantity}*{ OrderDetails UnitPrice})

Provide range as (® Static Value ) Cell Value
Min Maz
0 = 420 =

Color Ranges
Color by ® Percentage () Static Value ) Cell Value

#es1919 A O #

L1

#gosogy [ 24

#19e4e5 [ (es

#19e519 [ -

L1

¥ Cancel < Previous Next f# Finish

2,875.84

Conditionally Format Data in a Chart

Version 2017.1 allows you to use formulas to conditionally alter the colors of data on the chart. This is similar to
conditionally formatting cells. The color of a data element depends on its value.

For example, you could specify that if any bar on a bar chart exceeds a certain value, then it will be colored red.

To conditionally format elements in a chart:

1.

2.

Double-click a chart to open the chart wizard. Click the Appearance tab.

Click Conditional Colors.

Click ¥+ Add to add a condition. Choose a color by entering a hex value, or using the color picker.
Click the formula f* icon to set the conditional formula.

Enter a formula which evaluates to True or False.

In order to get the data element value, there are several special parameters that you can use in the formula.
These parameters correspond with the fields on the Data page, which you use to select data for the chart.

The exact parameters depend on the type of chart and the data layout:

@data_label@: Corresponds with the Data Label field, or X-Axis field for scatter and bubble charts. Corresponds
with the Point Label field for charts using the Cell Based data layout.

@data_value@: Corresponds with the Data Value field, or Y-Axis field for scatter and bubble charts.
Corresponds with the Point Value field for charts using the Cell Based data layout.

@series_label@: Corresponds with the Series Label field. Available for charts using the Row Based data layout.

@bubble_label@: Corresponds with the Bubble Label field for bubble charts.
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@bubble_size@: Corresponds with the Bubble Size field for bubble charts.

Note. If you change the type of chart, some parameters may become unavailable. You may have to go back and
edit the conditional formulas.

6. Click OK. To add more conditions, repeat steps 3-6.

If there are multiple conditions, they evaluate in order from the lowest row to the highest. To change the order,
reorder the rows using the up and down arrows.

Note. You cannot use cell references, data field references, or parameter references in a chart conditional formula.

Formula Editor

Starting in version 2017.2, the Formula Editor has a suite of features to help guide you when using formulas.

You can use the Search field to search through the functions by name. Or start typing in the Formula field to get a
list of functions that match the text.

If

A If() If{condition, consequent, alternative) Function

A DateDiff()} Summary
A IsNoDataQualified() If the condition is True, returns the consequent. Otherwise refurns the

alternative.

List of functions that match the text

Tip
You can search for data fields, report cells, and parameters in the same manner.

Using functions

Formulas work by applying some calculations to a few values that you give them. A basic example of a formula is 1 + 2.
In this example, the formula comprises one function, the addition function (+), and two arguments, the numbers 1 and
2. When the report runs, the formula calculates and returns a value of 3.

Not every function takes two arguments, so functions cannot always be written as (argument1 function argument2).
In most cases functions instead use the following format:

Function (argumentl, argument?, ...)

The addition example could also be written as Add(1, 2). This is the style that most formulas in the application use.
Most functions are more abstract than simple arithmetic. Each function has a description which tells you exactly what

it does and how to use it.

Arguments

An argument is a value that a function uses to do a calculation. Functions have different amounts and types of
arguments. When a function is first entered into the Formula field, there are placeholder values for each required
argument. Click on a placeholder to see the description of the argument.

QL condicion ) . )

If{condition, consequent, alti tive)
Ti

If the condition is e consequent. Otherwise retumns the afternative.

condition: Logical expression, the value determines which argument to return

Description of the condition argument of the If function

Some arguments are optional. Those are surrounded by brackets [ ]. Some arguments are a list of values. Those are
followed by an ellipsis (...).

Today([useCultureFormat]) And(listOfStatements...)

The Today function takes an optional argument. The And function takes a list of arguments.

Tip
Some functions take no arguments. These are formatted with empty parentheses:

Function ()

You need to supply values for all of the function's required arguments. Type a value into the argument space, or drag a
data field or function over the placeholder.
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If( : W alternative )

Dragging a data field to an argument

Click OK when you are finished.

Formulas are used in several areas besides the report design: custom sorts and groups, drilldowns, conditional
formatting for cells and charts, and custom crosstab fields, to name a few. In every area where you can use a formula
you can click on a formula icon to open a Formula Editor window. These areas may require a specific type of data to be
returned from the formula. Some built-in functions, such as aggregates, may be unavailable. Consult the relevant topic
for the specifics.

Note about sections

Formulas which reference data fields or cells, with the exception of aggregate functions, should be in the same report
section as the reference data. Detail sections repeat for every data field, group sections repeat for every group, and
page sections repeat for every page. Since most formulas expect only one reference value, and not repeated values,
referencing a repeated field or cell from outside of its section can return irregular data. Formulas need to repeat
alongside their reference values. Aggregate functions are the exception since they are designed to evaluate once for a
group of data. For more information, see Sections.

Manually typing formulas

You have the option of typing in your functions, data fields, parameters, and cell references manually. Use the following
formatting guidelines.

Text

Surround text with double or single quotation marks:

"Hello, World!"

'I am on fire'

If you want to use a quotation mark in the text, then surround the text with the opposite mark:
"You're on fire"

'He says "like" too often’

Do not use quotation marks around numbers.

Data fields

{DataCategory.DataField}

where DataCategory is the name of the data category

and DataField is the name of the data field

Cell references

To use the value from another cell in a formula, use the following format:
[C#]

where C is the letter of the cell column

and # is the number of the cell row

Caution
Rearranging cells can cause cell references to break.

Parameters
Parameters return special values depending on some condition. The built-in parameters are:

o @pageNumber@ gives the current page of the report
o @reportName@ gives the name of the report
o @reportFullName@ gives the name and path to the report

To find out if you have more parameters available in your environment, contact your administrator.
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Syntax checking

If there are any typos in the function, the Formula Editor will underline the relevant section in red, and show a brief
description of the problem. You need to fix the problem before running the report or the result of the formula will be an
error.

|' Syntax Error: Operator expected, not found |

"Hello " {[Employees. FirstName}|

This formula will not work without a concatenation operator "&"

General Options

Renaming Reports

To change the name of a report click ‘Rename’ in the Toolbar drop-down menu. Enter a new name and select the folder
you want to save the report. Click ‘OK'.

Report Name %

Enter the report name

Select folder for the report
E’" = L2 [

= - @ Financial Holdings Reports
cb Rename » 1 Retail Customers Reports
— T . [ Sales Reports

pl » [1 Seasonal Reports

= Categories University Student Reports
4| Sorts » 71 Wholesale Customer Reports
=7 Filters
3 Options 3
g Template

oo Advanced +" OK 3 cancel

Changing Description

The report description appears at the bottom of the Main Menu. Report descriptions are optional but they can be
searched. To change a report description click ‘Description’ in the Toolbar drop-down menu. Write the description and
click *OK.”

Report Description X

Enter a description for the report

EIEII:I (B

b Rename

Description

Categories
Sorts
Filters

Options 3

m & <] NE

Template
weo Advanced » o 0K X Cancel

Changing Data Categories

Before explaining how to make Data Categories accessible it is important to clarify two terms: Data Category and Data
Field.

User Guide
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Data Category - A Data Category is an object that has a group of attributes.

User Guide

IEX. Orders is a category; each order has an ID, a date, a customer etc.

Data Field — A Data Field is a single attribute within a Data Category.

|Ex. Orders.OrderID is numeric value that identifies a specific order.

To modify the Data Categories click ‘Categories’ in the Toolbar drop-down menu.

e To add a Data Category to a report either drag and drop it to the ‘Category Name’ panel, use the ‘Add’ button or

double-click it.

e To search for a specific Data Category type its name into the search box.
e To see what Data Fields are in a Category click the information button (ﬂ').

e Check the ‘Suppress Duplicates’ box to prevent duplicate information from appearing on the report.
e To remove a selected Category click the delete button (X).

Select categories to include on report

x| Suppress
Dupicates
O Categories
[ CustomerCustoemerDemo

= =T

Report Cateqories

Customers
Employess
OrtlerDetails
Ortlers
Proucts:

Category Name

xX X

EmployeeTerritories

ch Rename

= Description
Shippers

DDDDDDDDDDOD

| = Categories

2 Sors

57 Filters

3 Options 3
B Template

oo Advanced »

Changing Sorts

oK 3 Cancel

To modify the sort criteria of a report click ‘Sorts’ in the Toolbar drop-down menu.

e To sort by a Data Field either drag and drop it to the ‘Sort by’ panel, use the ‘Add’ button or double-click it.

e You can sort each field in ascending (A- Z) or descending (Z-A) order.
e Use the up and down arrows to indicate the sort priority.

To remove a sort click the delete button (X)_

Report Sorts
Select sort fields
Categories L SortBy Sort Crder
1 Categories.CategoryName Ascending Y 4 $ X
CategorylD
CategoryName
— = L Description
1O L - Picture
ch Rename
= Description :
= Categories 4
A
2 Sors
7 Filters
3 Options 3
g Template < Add
coo Advanced » oK ¢ cancel

Changing Filters

To modify the filter criteria of a report click ‘Filters’ in the Toolbar drop-down menu. There are three types of filters:
Standard, Interactive and Group. Standard filters are based on values you specify. Interactive filters can be applied
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after executing the report to HTML. Group filters are based on the minimum or maximum value in the Data Field.

Standard Filters

There is no limit to the number of filters that you can define. Filters can be numeric (up to eight decimals) or
alphanumeric.

To filter a Data Field either drag and drop it to the ‘Filter By’ panel, use the ‘Add’ button or double-click it.
Use the up and down arrows to indicate the filter priority.\
To remove a filter click the delete button (X).
Set the operator (equal to, less than, one of, etc.) by selecting from the operator drop-down.
To set the value on which to filter either enter it manually or select from the drop-down. If the Data Field is a
date you may use the calendar or function buttons to select a value.
To allow the filter to be modified at the time the report is executed check ‘Prompt for Value.’
Use the And/Or drop-down to specify the relationship between filters. Choose AND to require that the selected
filter and the one below it are both true. Choose OR to require that either be true.
Check ‘Group With Next Filter’ to specify the precedence of the filters. Filters can be nested indefinitely by using
the following keyboard shortcuts while a filter is selected:
o Ctrl + [ adds an open-parenthesis before the selected filter.
o Ctrl + ] adds a close-parenthesis after the selected filter.
o Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
o Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.

Interactive Filters

Interactive Filters can be created in the Interactive HTML Options Menu. These filters can be enabled, disabled or
modified after executing the report to HTML. For more information see Interactive HTML Options.

Group (Min/Max) Filters

Group filters are based on the minimum or maximum value in the Data Field. To modify group filters click ‘Switch to
Group(MIN/MAX) filters. There is no limit to the number of group filters you may define.

To filter a Data Field’s minimum or maximum value either drag and drop it to the ‘Filter By’ panel, use the ‘Add’
button or double-click it.

Specify Minimum or Maximum from the operator drop-down.

Use the up and down arrows to indicate the filter priority.

To remove a filter click the delete button ().

Report Filters x
Select fiter fields to include on report Switch to GROUP (MI/MAX) Fiters
Orders v Fiter By
Orders. ShipCouny
= == | customenn e ety CICIES
e - . EmployeelD
Freight
b Rename OrdeDate
OrderlD
v RequiredDate
= Description ShipAddress
ShipCity a
. ShipCountry L)
= Categories Shiphame 1
ShippedDate
ShipPastalCode
% SO”S ShipRegion
ShipVia Equal Te v | Brazi v
kvs Filters AND Vith Next Fiter v
Group With Next Filter
{3 Op‘tlor‘ls » & Add Prompt For Value
SUMMARY
B Temp|ate Orders.ShipCountry = Brazl
soo Advanced » T

General Options

Hover over ‘Options’ in the Toolbar drop-down and then click on ‘General’ menu to open the Report Options Window.
This window allows you to control various settings including default export type and page orientation.

General Options

Use the Default Export Type drop-down to specify the default format for the report.
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e From the ‘Include Setup’ menu select Top or Bottom to display the data categories, sorts and filters at either the
beginning or end of the report.

e Output types may be disabled by unchecking the boxes for ‘Allowed Export Types'.

e Use the ‘Filter Execution Window’ drop-down to select which type of Filter menu displays when executing a report

that have prompt for value filters.
o Default - Display the default type of filter execution window.
o Standard - Display the standard filter execution window.

o Simple with Operator - Display a simplified filter execution window that only allows the operator and value

to be changed.

o Simple without Operator - Display a simplified filter window that only allows the filter value to be

changed.

e Check ‘Always Show Filter Execution’ to show the filter menu and allow changes to be made each time the report

is executed.

e Use the ‘No Data Qualify Display Mode’ to select what to display if no data qualifies for the report.
o Show Message - Display the standard no data qualified message.

o Show Report - Display the Page Header, Page Footer, Report Header and Report Footer sections of the

report. Any cells containing Data Fields will not be displayed.

Excel Options

e Check ‘Suppress Formatting’ to prevent the report formatting from exporting to Excel.

Page Options

e Specify the size for the report in the ‘Page Size’ menu. Default is letter.
e Set the orientation for the report in the ‘Orientation” menu.
e Default is Portrait.Check ‘Fit to Page Width’ to scale all columns to fit the width of the page.

Specify the size for the report in the ‘Page Size’ menu. Default is letter.Set the orientation for the report in the

‘Orientation’ menu. Default is Portrait.Check ‘Fit to Page Width’ to scale all columns to fit the width of the page.

B ) | A

- -~ J u A 8

th Rename UAD
A (Pt
= Description i
- 1

= Categories
A 2 Proi
&) Sors . =

: 3 | Preducts
=7 Filters
3 Options » ¢ General
E Template <> Html

son Advanced rl
Advanced Options

Report Options

—General Options
Default Export Type | Defaut ¥ Include Setup Info | Top ¥
Aliowed Export Types: & HTML @ Excel ¥ PDF ¥ RTF ¥ CSv

Filter Execution Window | Default v

Abways Show Filters on Execition

Mo Data Qualify Display Mode | Show Report v

—Excel Options

Suppress Formatting

—Page Options
Page Sze | Letter ¥
Fit to Page Whdth

Page Crientation | Portrait v

S oK ¥ Cancel

The Advanced Options menu is available in Advanced Reports and CrossTab Reports.

x

User Guide
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=] Rename

Description
Categories
+ Sorts

Y Filters
Template
Options >

* s
Advanced Joins

B Events

® Show Generated SQL

Note: If you do not have access to the Advanced Option menu or certain options within it, you may not have
permission to do so. Please contact your administrator regarding permissions.

From the Advanced Options menu, the following items may be accessed:

e The Joins window, allowing advanced users to specify additional information about how the data categories
within a report relate to each other.

e The Events window, allowing advanced users to apply event handlers for the report.

e The Show Generated SQL option, allowing advanced users to generate and view the constructed SQL that will
be sent to the databases prior to execution.

Joins

If a report has two or more data categories, then information will only appear if the categories match. Using the Joins
window, however, you may specify information you want to display regardless of whether or not it only exists in one of
the data categories.

For example, if a report has two data categories, Orders and Customers, then only customers who have made orders
will appear. By selecting the appropriate checkbox you can include information on customers that have not made
orders.

Joins

Select options below
Advanced Options

In addition to Customers data that has matching Orders data, include:
#| Customers data that does not have Orders data Fah
Orders data that does not have Customers data

o= Add From: Customers v To: Orders ¥ | (*Recreate

m Cancs"‘

The following options are also available within the Joins window:

e To add a new join click the Add button.

e To edit a join click the Edit ’ button.
e Restore the default joins by clicking the Recreate button.

e To remove a join click the Delete X button.

Editing and Adding Joins
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When either editing an existing join or adding a new join between two data categories that are not currently joined, the
Report Join menu will appear.

Report Join

Column = Column
Customers.CustomeriD w = Orders.CustomeriD v X

SUMMARY wf= Add Condition

{Customers.CustomerlD = Orders.Customer|D}

m Ca ﬂCPI‘

In this menu you can modify the information of a join or create a new join for the report.

e A join condition—e.g., Customers.CustomerID = Orders.CustomerID—may be deleted from a join using the
Delete ¥ button.

e A join condition may be added to a join using the Add Condition button.

e Join conditions may be adjusted using their respective Column dropdowns. Within each dropdown is a list of
available fields that may be joined.

User Guide

Caution: There is no restriction on what fields may be joined. Please use careful consideration when joining fields, as
improper joins may result in unexpected data output.

Events

Event handlers may be applied to the report by advanced users for additional functionality.

Events
Event Action
OnReportExecuteStart ¥ Loadimage v X
o= Add

m Call-llce"

The following options are available within the Events window:

e An event can be removed from a report using the Delete * button.
e An event can be added to a report using the Add button.

e The event type can be selected using the Event dropdown.

e The event action can be selected using the Action dropdown.

Upon triggering the event—e.g., OnReportExecuteStart will be triggered at the start of the report's execution—the
associated action will take place.

Note: For more information, please see the Server Events article.
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Show Generated SQL

As of v2019. 1+, advanced users may access the Execution SQL window via the Show Generated SQL option. This
window displays the SQL statement that will be sent to the appropriate databases in order to execute the report.

Execution SQL

Northwind

1 SELECT

2 dbo. [Customers].[ContactMame] as c@,
3 dbo. [Customers].[CustomerID] as c1,

4 dbo.[Customers].[City] as c2,

5 dbo. [Customers].[Fax] as ¢3,

6 dbo.[Orders].[OrderID] as c4,

7 dbo. [OrderDetails].[OrderID] as c¢5,

8 dbo. [OrderDetails].[ProductID] as c6,

9 dbo.[Orders].[CustomerID] as ¢7

18 FROM

11 dbo. [Customers]

12 inner join dbo.[Orders] on (

13 dbo. [Customers].[CustomerID] = dbo.[Orders].[CustomerID]
14 )

15 inner join dbo.[OrderDetails] on (

16 dbo.[Orders].[OrderID] = dbo.[OrderDetails].[OrderID]

17 )

The SQL statement shown in the Execution SQL window is the exact statement that will be sent to the databases. It
is generated after applying sorts, filters, parameters, and other items that affect the constructed SQL.

User Preferences and Context Sensitive Help

If given permission by your administrator the User Preferences button will appear in the top right corner. Click the User

Preferences button to open the User Preferences menu.

@) A Ci

Ir-': n — '} .
il Q <> 1/ W (] = Change User Preferences

Buchanan
Callahan
Davolic
Dodswerth
Fuller

King
Leverling
Peacock

Suyama

0 100 200 300 400 500

Startup Reports

In the User Preferences menu set your preferences such as which reports should run at startup and/or what User
Reports should be applied.

e To execute a report on startup either drag and drop it to the ‘Report Name’ panel, use the ‘Add’ button or double-
click it.

o To disable a user report click the delete button (*).
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User Preferences

Tutorials Startup Reports  User Reports

Reports assigned as a startup report are run whenever the application is entered.

v @ Dashboards

Ii Revenue by Date Dashboard

Dashboards\Revenue by Date Dashboard

Context Sensitive Help

Context sensitive help is available at any point in the application. Click the help button Q and documentation will
appear in a new tab. The guide will automatically open to the section discussing the feature you are using.

@ A CE Q <> 1/23 | 6 | S Y | o
© Buchanan
© EmployeelD © OrderiD © OrderDate © Revenue
5 10248 $98.00
5 10248 $168.00
5 10248 $174.00
5 10254 11-07-2014 $54.00
5 10254 11-07-2014 $168.00
Tutorials

Disable or enable ExpressView Tutorials and Hints in the User Preferences menu (2018.2+).

User Preferences

Tutorials Startup Reports  User Reports
Enable or disable report designer tutorials.
ExpressView Tutorial
ExpressView Hints
Reset All Hints

e The tutorial guides you through the creation process for ExpressViews through a series of popup windows. You
are given the option to skip the tutorial when it begins, as well as the option to disable the tutorial in the future
when it is complete.

ExpressView Designer

*

Drag and drop to explore your data and make quick
reports called Express\iews.

Learn How

skip tutorial
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Settings

Use the Settings menu to customize
export settings.

You can also rename your
ExpressView, move or copy it, or
export it to an Advanced Report.

Would you like to see this tuiorial the
next time you open ExpressView?

e When hints are enabled, a hint will display after you take certain actions. Once you have seen a hint it will not
display again unless hints are reset.

e Reset All Hints within the User Preferences menu to view all hints again.
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